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Preface

The Tivoli Workload Scheduler User’s Guide provides information
on how to install, configure, and use the Tivoli Workload Scheduler
(TWS).

Who Should Read This Guide
This manual is provided primarily for administrators and job
schedulers. TWS users are divided into these categories:

¶ Administrator - designs the TWS network, and administers
security for the network.

¶ Installer - installs the products necessary to use TWS, including
Tivoli Framework, Job Scheduling Console, and any extended
agent software.

¶ Job Scheduler - creates the job streams, jobs, and dependency
objects used to automate job scheduling.

Related Documents
¶ Tivoli Workload Scheduler Planning and Installation Guide

provides information about planning and installing TWS to your
network.

¶ Tivoli Workload Scheduler Reference Guide provides information
about the command line interface for TWS.

What This Guide Contains
The Tivoli Workload Scheduler User’s Guide contains the following
sections:

¶ Chapter 1, “Introduction”

Provides an overview of TWS.

¶ Chapter 2, “New Features in TWS 7.0”

Provides information about new features in this version of TWS.

¶ Chapter 3, “Global and Local Options”
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Provides information about how to configure the TWS options
files.

¶ Chapter 4, “TWS Security”

Provides information about configuring security.

¶ Chapter 5, “The Production Cycle”

Provides information about the production cycle.

¶ Chapter 6, “Report Commands”

Provides information on generating TWS reports.

¶ Chapter 7, “TWS Database Tasks”

Provides information about working with objects in the database.

¶ Chapter 8, “TWS Plan Tasks”

Provides information about working with objects in the plan.

¶ Appendix A, “Status Description and Mapping”

Provides information about the status of jobs and job streams in
TWS.

¶ A Glossary provides information about the terminology used in
TWS.

Conventions Used in This Guide
The guide uses several typeface conventions for special terms and
actions. These conventions have the following meaning:

Bold Commands, keywords, file names, authorization
roles, URLs, or other information that you must use
literally appear in bold. Names of windows, dialogs,
and other controls also appear in bold.

Italics Variables and values that you must provide appear in
italics. Words and phrases that are emphasized also
appear in italics.

Monospace Code examples, output, and system messages appear
in a monospacefont.
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Platform-specific Information
The following table identifies the supported platform versions known
at the time of publication. For more detailed and up-to-date
information, please see the release notes.

Platform TWS Engine TWS
Connector

JS Console

AIX 4.2 X X X

AIX 4.3 X X X

HP-UX 10.2 X X X

HP-UX 11.0 X X X

Solaris 2.6 X X X

Solaris 2.7 X X X

Windows NT 4.0 w/
SP 4 or higher

X X X

Windows 2000 X

Digital UNIX 4.0 X

Intel ABI compliant X

MIPS ABI compliant X

Contacting Customer Support
For support inside the United States, for this or any Tivoli product,
contact Tivoli Customer Support in one of the following ways:

¶ Send e-mail to support@tivoli.com

¶ Call 1-800-TIVOLI8

¶ Navigate our Web site at http://www.support.tivoli.com

For support outside the United States, refer to your Customer
Support Handbook for phone numbers in your country. The
Customer Support Handbook is available online at
http://www.support.tivoli.com.
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When you contact Tivoli Customer Support, be prepared to provide
identification information for your company so that support
personnel can assist you more readily.

We are very interested in hearing from you about your experience
with Tivoli products and documentation. We welcome your
suggestions for improvements. If you have comments or suggestions
about this documentation, please send e-mail to pubs@tivoli.com.
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Introduction

Tivoli Workload Scheduler (TWS) is a fully automated batch job
scheduling system that improves job throughput and greatly reduces
operations costs. This chapter introduces you to TWS and its
interfaces and programs. Initial TWS set up and the Job Scheduling
Console are also discussed.

General Description
TWS helps you plan and organize every phase of batch job
execution. During the processing day, TWS’ production control
programs manage the production environment and automate most
operator activities. It prepares your jobs for execution, resolves
inter-dependencies, and launches and tracks each job. Because your
jobs begin as soon as their dependencies are satisfied, idle time is
minimized and throughput improves significantly. Jobs never run out
of sequence, and, if a job fails, TWS handles the recovery process
with little or no operator intervention.

Job Scheduling Console
The Job Scheduling Console is a java-based multi-platform interface
for configuring, viewing, and modifying all aspects of job scheduling
at your site. From the Job Scheduling Console you can do the
following:

¶ Create database objects, such as, workstations, workstation
classes, jobs, job streams, calendars, parameters, resources,
prompts, domains, and users. These are the building blocks used
to create and organize your job scheduling.

1
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¶ Schedule your jobs and job streams to create a plan for job
execution, using the many different TWS job dependency types.

¶ Monitor the execution of all your jobs and job streams.

¶ Modify the execution of your jobs and job streams, by adding,
modifying, or deleting jobs or job streams in the plan.

Database and Plan
There are two basic aspects to job scheduling in TWS: the database
and the plan.

Database
The database contains all the definitions you have created for
scheduling objects, for example, jobs, job streams, resources,
workstations, etc. It also holds statistics of job and job
stream execution, as well as information on the user ID who
created an object and when an object was last modified.

Plan The plan contains all job scheduling activity planned for a
period of one day. In TWS the plan is created every 24
hours and consists of all the jobs, job streams, and
dependency objects that are scheduled to execute for that
day. All job streams for which you have created a run cycle
are automatically scheduled and included in the plan. As the
day goes by, the jobs and job stream that do not execute
successfully can be rolled over into the next day’s plan.

Job Streams and Calendars
Central to TWS’s ability to manage batch job execution are the job
streams you create using the Job Scheduling Console. Each job
stream is scheduled to run on a specific set of dates and times, and
consists of a list of jobs that execute as a unit (such as the weekly
backup application), along with times, priorities, and other
dependencies that determine the exact order of execution.

Job Streams are dated using actual dates, days of the week, or
calendars. A calendar is a set of specific dates. You can create as
many calendars as required to meet your scheduling needs. For
example, you can define a calendar named PAYDAYS containing a
list of pay dates, a calendar named MONTHEND containing a list

General Description
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of each last business day of the month for the current year, and a
calendar named HOLIDAYS containing a list of your company’s
holidays. At the start of each processing day, TWS automatically
selects all the job streams that run on that day, and carries forward
uncompleted job streams from the previous day.

Workstations
A workstation is usually an individual computer on which jobs and
job streams are executed. A workstation definition is required for
every computer that executes jobs in the TWS network.

Primarily workstation definitions refer to physical workstations.
However, in the case of extended agents and network agents, the
workstations are logical definitions that must be hosted by a physical
TWS workstation.

There are several types of workstations in a TWS Network:

Job Scheduling Console Client
Any workstation running the Job Scheduling Console GUI
can manage the TWS plan and database objects. The Job
Scheduling Console works like a remote console, and can be
installed on a machine that does not have the TWS engine
installed.

Master Domain Manager
The domain manager in the topmost domain of a TWS
network. It contains the centralized database files used to
document scheduling objects. It creates the production plan
at the start of each day, and performs all logging and
reporting for the network.

Domain Manager
The management hub in a domain. All communications to
and from the agents in a domain are routed through the
domain manager.

Backup Domain Manager
A fault-tolerant agent capable of assuming the
responsibilities of its domain manager.

General Description
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Fault-tolerant Agent
A workstation capable of resolving local dependencies and
launching its jobs in the absence of a domain manager.

Standard Agent
A workstation that launches jobs only under the direction of
its domain manager.

Extended Agent
A logical workstation definition that enables you to launch
and control jobs on other systems and applications, such as
Baan, Peoplesoft, Oracle Applications, SAP, and MVS JES2
and JES3.

Network Agent
A logical workstation definition for creating dependencies
between jobs and job streams in separate TWS networks.

For more detailed information on workstations, refer to the Tivoli
Workload Scheduler Planning and Installation Guide.

Times and Priorities
Time constraints can be specified for both jobs and job streams. You
can specify the time that execution will begin, or the time after
which execution will not be attempted. By specifying both, you can
define a window within which a job or job stream will execute. For
jobs, you can also specify a repetition rate; for example, you can
have TWS launch the same job every 30 minutes between the hours
of 8:30 a.m. and 1:30 p.m.

TWS has its own queuing system with 102 priority levels. Assigning
priorities to your jobs and job streams gives you added control over
their precedence and order of execution.

Job Fence and Job Limits
TWS’s job fence provides a type of master control over job
execution. It can be set on each workstation to a priority level that a
job’s priority must exceed before it will be allowed to execute.
Setting the fence to 40, for example, will prevent jobs with priorities
of 40 or less from being launched.

General Description
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Job limits provide a means of allocating a specific number of job
slots into which TWS is allowed to launch jobs. A job limit can be
set for each job stream, and for each workstation on which TWS is
running. Setting the workstation job limit to 25, for example, permits
TWS to have no more than 25 jobs executing concurrently.

Dependencies
Dependencies are prerequisites that must be satisfied before
execution of a job or job stream can proceed. They can be specified
for both job streams and jobs to ensure the correct order of
execution. The five types of dependencies are:

¶ Follows Dependency: You can specify that a job or job stream
must not begin execution until other jobs and job streams have
completed successfully.

¶ Resource Dependency: You can specify that a job or job stream
needs one or more system resources before it can begin
execution.

¶ File Dependency: You can specify that a job or job stream needs
to have access to one or more files before it can begin
execution.

¶ Prompt Dependency: You can specify that a job or job stream
needs to wait for an affirmative response to a prompt before it
can begin execution.

¶ Time restrictions: You can specify a window of time that a job
or job stream is allowed to begin execution using the start time
(AT keyword) and the deadline time (UNTIL keyword).

In a network, dependencies can cross workstation and domain
boundaries. For example, you can make JOB1, which runs on
workstation FINANCE1 in domain REGION1, dependent on the
successful completion of JOB2, which runs on workstation
FINANCE2 in domain REGION2.

Job Confirmation
There are instances when the completion status of a job cannot be
determined until you have performed some task. You may want to
check the results printed in a report, for example. In this case, you
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can flag the job as requiring confirmation, and TWS will wait for
your response before it marks the job as successful or abended
(returns an exit code other then zero).

Resources
TWS resources can be used to represent physical or logical resources
on your system. Each consists of a name and a number of available
units. If you have three tape units, for example, you can define a
resource named TAPES with three available units. A job that
acquires two units of the TAPES resource would then prevent other
jobs requiring more than the one remaining unit from being
launched.

Parameters
Parameters can be used as substitutes for repetitive values used when
defining jobs and job streams. Using parameters for user logon and
script file names in job definitions, and file and prompt dependencies
permits the use of variables that can be maintained centrally in the
database on the master. These parameters are evaluated at the start of
the production day, when submitted into the plan, or when using the
rerun;from option.

TWS parameters can also be used as scripting aids, permitting you
to insert runtime values into your job scripts at the time of
execution. The parms program enables you the ability to query,
update and create parameters on the local workstation in real time.
This can be useful for implementing job step recovery or restart
values.

Job Recovery
When you schedule a job, you can specify the type of recovery you
wish to have TWS perform if the job abends (returns an exit code
other then zero). The recovery options are:

¶ Continue with the next job.

¶ Stop and do not permit the next job to execute.

¶ Rerun the abended job.

General Description
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In addition, you can specify other actions to be taken in the form of
recovery jobs and recovery prompts. For example, if a job abends,
you can have TWS automatically run a recovery job, issue a
recovery prompt that requires an affirmative response, and then rerun
the abended job.

TWS Options Files
There are two options files, globalopts and localopts, that enable
you to specify how TWS executes on each system and on the entire
network. In a TWS network, the global options apply to all
workstations in the network and local options apply independently to
each workstation.

Security
Every TWS program and command checks the user’s capabilities
against the definitions contained in a Security file. The security
structure is comprehensive, permitting the system administrator to
control access to every TWS object (schedule, job, resource, etc.),
and to specify exactly what types of access will be permitted (add,
modify, use, etc.). TWS network communication includes IP address
validation to prevent access by foreign hosts.

Replicating Job Streams on Multiple Workstations
TWS makes duplicating a job stream across multiple workstations
easy. Any number of workstations can be placed in a workstation
class. A workstation class is a group of workstations. Any number of
workstations can be placed in a class.

Job streams and jobs can be assigned to execute on a workstation
class, making replication across many workstations easy. When you
run a job or job stream on a workstation class it is executed on each
workstation within the workstation class. You must make sure your
jobs are capable of running on every workstation in the class, as the
workstations in a workstation class can have different operating
systems.

General Description
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If a job stream is defined on a workstation class then each job added
to the job stream must be defined either on a single workstation or
on the exact same workstation class that the job stream was defined
on.

Managing the Plan
The Job Scheduling Console is used to manage the production plan.
Among other things, you can:

¶ Start and stop the TWS control processes.

¶ Display the status of job streams and jobs.

¶ Alter priorities and dependencies.

¶ Alter the job fence and job limits.

¶ Rerun jobs.

¶ Cancel jobs and job streams.

¶ Submit new jobs and job streams.

¶ Recall and reply to prompts.

¶ Link and unlink workstations in a network.

Networking
With TWS you can manage batch jobs across a network of linked
computers (workstations). By distributing the workload throughout a
network, you can take full advantage of widely separated resources,
and still maintain complete visibility of production activity.
Computers communicate using TCP/IP links. All production set up
tasks are performed on the master domain manager, and a copy of
the production plan is then distributed to the other workstations.
TWS’s control processes on each workstation work independently to
launch and track their own jobs, communicating with their domain
managers to resolve inter-workstation dependencies.

A TWS network is composed of one or more domains, each
consisting of a domain manager and agent workstations. In the
domain hierarchy, the master domain manager is the domain
manager of the topmost domain. There are three types of agents:

General Description
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¶ Standard Agent

¶ Fault-tolerant Agent (FTA)

¶ Extended Agent

Standard and FTA workstations can be UNIX, Windows NT, or MPE
(HP3000) computers. An Extended Agent is usually a logical
workstation that corresponds to an application (such as Peoplesoft,
Oracle Applications, or Baan) or an operating system (such as
MVS). The extended agent workstation definition must be hosted by
a TWS Master, Domain Manager, or FTA.

Command Line Interfaces
A combination of graphical and command line interface programs
are provided to run TWS. This guide emphasizes the Job Scheduling
Console. The command line interface (CLI), is used for certain
advanced features. Some of the capabilities of the CLI are not
available in the Job Scheduling Console.

The Job Scheduling Console and CLI are independent and can be
run simultaneously to manipulate TWS data. For more information
about the command line interface, refer to the Tivoli Workload
Scheduler Reference Manual.

Command Overview
There are many commands for working with and configuring TWS.
Refer to the Tivoli Workload Scheduler Reference Guide for more
information on TWS commands.

CLI Interfaces
The following programs can be used to work with both the database
and the plan in TWS:

composer
A legacy CLI program used to view and modify the
database.

conman
A legacy CLI program used to monitor and modify the plan.

General Description
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Security
User privileges and security are defined and maintained with the
following commands:

dumpsec
Create an editable copy of TWS’s Security file.

makesec
Compile and install TWS’s Security file.

Pre and Post Production Processing
The following commands are used to set up TWS’s processing day.
To automate the process, the commands are normally placed in a job
stream that runs at the start of each day.

compiler
Compile the Production Control file.

logman
Log job statistics.

schedulr
Select job streams for execution.

stageman
Carry forward uncompleted job streams, and install the
Production Control file.

wmaeutil
Used to stop the TWS connectors.

Reporting
Comprehensive reports are printed from TWS’s CLI. Report
commands are often included as part of the daily turnover process.

rep1 - rep8
Print definitions of scheduling objects in TWS’s database.

reptr Print pre and post production reports.

xref Print a report showing cross-references between scheduling
objects.

Command Overview
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Utilities
A set of utility commands provides a wide range of capabilities:

at | mat
UNIX only. Submit ad hoc jobs to be executed at a specific
time in TWS.

batch |mbatch
UNIX only. Submit ad hoc jobs to be executed as soon as
possible in TWS.

datecalc
Calculate date expressions.

dbexpand
TWS version 6.x and above only. Expand the databases to
accommodate long object names.

delete Remove job standard list files.

jobinfo
Return information about a job.

jobstdl
Return path names of job standard list files.

maestro
Return the home directory of the maestro user.

makecal
Create custom calendars.

morestdl
Display job standard list files.

rebuild
Clean and rebuild TWS’s master files.

release
Release scheduling resources.

rmstdlist
Remove job standard list files by age.

showexec
Display information about executing jobs.

Command Overview
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StartUp
Start TWS’s network process Netman.

Production Processes
The following are TWS’s production processes:

batchman
The Production Control process. Working from the
production plan (Symphony file), it executes job streams,
resolves dependencies, and directs jobman to launch jobs.

jobman
The Job Management process launches and tracks jobs under
the direction of batchman.

jobmon
The Job Monitor process monitors job execution on
Windows NT computers only.

The following are TWS’s network processes:

netman
The Network Management process establishes network
connections between remote mailman processes and local
writer processes.

mailman
The Mail Management process sends and receives
inter-workstation messages.

writer The Network Writer process passes incoming messages to
the local mailman.

The following are TWS’s connector processes. These are used to
communicate with the TWS engine.

maestro_engine
The process that connects the Job Scheduling Console to the
TWS engine and provides access to information about the
backend database and plan.

Command Overview
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maestro_plan
The process that connects the Job Scheduling Console to the
TWS production plan (Symphony file).

maestro_database
The process that connects the Job Scheduling Console to the
TWS database files.

Production Processes
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New Features in TWS 7.0

This chapter is an introduction to some of the new features and
changes to this version of the TWS. This chapter contains
information on the following:

¶ Terminology changes

¶ The Job Scheduling Console, a new graphical user interface for
TWS

¶ Time zones

¶ Auditing

Terminology Changes
The terminology used in the Job Scheduling Console differs from
that used in the command line and earlier versions of TWS. The
following table lists the old terms and their Job Scheduling Console
equivalents. Refer to the Glossary for more definitions.

Command Line Job Scheduling
Console

Definition

Schedule Job Stream A unit of work consisting of a set of
jobs and their dependencies.

Job Stream Instance The occurrence of a job stream in the
plan.

2

15Tivoli Workload Scheduler User’s Guide

2.
N

ew
F

eatu
res

in
T

W
S

7.0



Command Line Job Scheduling
Console

Definition

Job Job An executable file, task or command,
and its attributes. It is scheduled to run
as part of a job stream.

Job Instance The occurrence of a job in the plan.

Cpu Workstation A logical processor, typically a
computer, that runs jobs. Types of
workstations include Domain
Managers, Backup Domain Managers,
Fault-Tolerant Agents, Standard
Agents, and Extended Agents.

Mozart Database Files Database A collection of scheduling objects
including jobs, job streams,
workstations, workstation classes,
prompts, parameters, users, domains,
calendars, and resources. These files
were modified by gcomposer.

Symphony File Plan The scheduled activity for a period,
typically 24-hours. The plan is
continuously updated to show the
current status of all TWS activities.
This file was modified by gconman.

AT Time Start Time The earliest time a job or job stream
will begin.

UNTIL Time Deadline Time The latest time a job or job stream will
begin execution.

ON and EXCEPT Dates Run Cycles The dates on which a job stream runs
or is excluded from running.

Job Scheduling Console
The Job Scheduling Console is the new graphical user interface for
TWS. It provides the following features:

¶ The Job Scheduling Console is a multi-platform java-based
application and is integrated with the Tivoli Framework.

Terminology Changes
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¶ The Job Scheduling Console can be used to manage both TWS
and Operations Planning and Control (OPC) networks
simultaneously and on the same interface. OPC is a Tivoli batch
job scheduler for the OS-390 operating system.

¶ The Job Scheduling Console is available in multiple languages,
and supports worldwide time zones and localization.

Overview of the New Job Scheduling Console
From the Job Scheduling Console you are able to access scheduling
functions for TWS and OPC from a common interface.

The left side of the console displays the job scheduling tree. In this
view are the servers (TWS or OPC), and under these servers are
groups of default lists for the database and the plan.

There are two sets of default lists, Default Database Lists and
Default Plan Lists.

Figure 1. Default Database Lists

Job Scheduling Console
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From the left panel you select a list icon and click the Load List
button (a green arrow) to display the list. The right side of the
window displays the results of a list. You can also select to detach
the list into a separate window, using the Detach list command
available in the pop up menu of commands on a list icon. When you
first start TWS there are a number of default lists for you to use.
You can modify these lists or create your own groups and lists.

From the Job Scheduling Console you can view both the
configuration of objects in the database, and the status of objects in
the plan.

Database and Plan
There are two types of lists:

Database lists
A database list displays objects that have been defined in the
TWS database. These can be jobs, job streams, workstations,
workstation classes, parameters, prompts, resources, domains,

Figure 2. Default Plan Lists

Job Scheduling Console
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and users. These correspond in legacy Maestro to objects in
the mozart database files that are modified using the
composer.

Plan lists
A plan list displays objects that have been scheduled and are
included in today’s plan file. These correspond in legacy
Maestro to objects in the Symphony file that are modified
using conman.

Usage Notes
Below are some tips in using the new Job Scheduling Console:

¶ There are three types of properties windows:

v Properties of a database object. These screens edit an object
in the database, and affect all future uses of this object in the
plan, starting with the next production day.

v Properties of a plan object. These screens edit an object in
the plan, and affect only today’s production plan. Changes to
an object in the plan are not saved in the database, and do
not affect future runs of an object.

v Properties of a list. These screens do not edit objects, they
edit a list of what objects are displayed. The properties
chosen in a list window are similar to a filter on the
showschedules or showjobs command in legacy Maestro.

¶ The order of columns in a display list can be modified. You can
rearrange the columns to your personal preference by clicking
and dragging the column heads. This new column order is only
maintained for your current login.

¶ Open a list in a separate window by highlighting the list in the
tree view, and selecting the Detach View command from the
pop-up menu. This enables you to open multiple lists
simultaneously. For example, you can view both job instances
and job stream instances. You can have up to seven detached
windows at a time.

¶ Set the global refresh rate for your lists. This enables you to
view plan lists and get updated information at a rate that you

Job Scheduling Console
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specify. You can set a long refresh rate to save processing time
or a short refresh rate to always view updated information. Note:
If you work with many detached views at the same time, avoid
refreshing lists frequently in order to keep your system from
slowing down.

¶ You can create and save customized lists for both the plan and
the database. Define lists using wildcards and retrieve a specific
subset of objects in the database or the plan. For example, to
define a list that displays job streams called SAP1, and SAP2,
enter SAP* in the list properties window. This enables you to
quickly view only the database or plan objects that are important
to you.

¶ On text entry fields, a blue dot next to a field means that this is
a required field, or there has been an input error and the current
input is not valid.

¶ Use the Create Another command to create a copy of any
database object. This command creates a clone of the database
object, opens the properties editor, and changes the name to
Copyofobject. You can then modify the name and save the
object.

¶ Note that the character restrictions listed in this manual are for
double byte character languages. In some languages, the
encoding of special characters will lead to more than 2 bytes and
create a restriction on the maximum character length for any
given field. So normally an 8 character field will allow 8
characters, however, if you use special characters or some
national characters that take up more bytes, the character
restrictions for that field may be as much as half of normal.

¶ The caret character (^) is reserved for any field that can have a
parameter.

Viewing TWS Properties
You can view the properties of your installation of TWS by
highlighting the TWS controller in the tree view, and selecting the
Properties command from the pop up menu. This displays the
Properties - Scheduler window. From the Scheduler Information tab
of this window you can view such information as:

Job Scheduling Console
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¶ whether time zones are enabled

¶ the database mode, expanded or non-expanded

¶ the workstation you are currently connected to

¶ Batchman status

¶ the connectors version level

¶ the auditing level for the database and the plan

Job Scheduling Console Connectors
Connectors only become active after the Job Scheduling Console is
started. There are connectors for the TWS engine, database, and
plan. After 30 minutes of inactivity the connectors will stop. They
will automatically restart when commands in GUI are entered. For
example, if you are doing work only on the database you will not
see the plan connector process start up unless you do some plan
queries or commands on plan.

You can check if the connectors are running for Windows NT by
opening task manager and looking for the following processes:

¶ maestro_engine

¶ maestro_plan

¶ maestro_database

You can check if the connectors are running for UNIX by executing
the following command at shell prompt:
ps -ef | grep "maestro_"

The process names listed above are displayed if they are active.

Time Zones
TWS now supports time zones. Enabling time zones provides you
with the ability to manage your workload on a global level.
Time-zone implementation also allows for easy scheduling across
multiple time zone and for jobs that need to run in the ″dead zone.″
The dead zone is the gap between the TWS start of day time on the
master and the time on the FTA in another time zone. For example,

Job Scheduling Console
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if an eastern master with a TWS start of day of 6 AM initializes a
western agent with a 3-hour time-zone difference, the dead zone for
this FTA is between the hours of 3 AM and 6 AM. Previously,
special handling was required to run jobs in this time period. Now
when specifying a time zone with the start time on a job or
jobstream, TWS runs them as expected. For example, consider the
following two job streams for a PST FTA with an EST master:

Schedule PST_SCHEDULE1 Schedule PST_SCHEDULE2
On SU, weekdays except FR on weekdays
CARRYFORWARD AT 0330 TZ PST
AT 0330 :
: joba
job1 jobb
job2 END
END

Jobstream PST_SCHEDULE1 is not time-zone enabled. To get this
job stream to run every weekday morning, you must schedule it to
run Sunday through Thursday, and you must specify ″carryforward.″
Without carryforward, the jobs would never run, since the FTA
would be initialized at 0300 every morning (assuming an EST
master with a TWS start of day of 0600). Jobstream
PST_SCHEDULE2 is time-zone enabled. When the EST master
initializes the PST FTA at 0300, it starts the jobstream the same day
at 0330.

Time-zone enabling also has an effect on eastern FTAs when
scheduling from western masters. For example, consider the
following two jobstreams for an EST FTA and a PST master with an
0600 start of day.

Time Zones
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Schedule EST_SCHEDULE1 Schedule EST_SCHEDULE2
On SU, weekdays except FR On SU, weekdays except FR
AT 0800 + 1 DAY AT 0800 TZ EST
CARRYFORWARD :
: joba
job1 jobb
job2 END
END

Jobstream EST_SCHEDULE1 is not time-zone enabled. For this
jobstream to run every weekday morning, you must schedule it to
run Sunday through Thursday. Specify carryforward and +1DAY for
the AT time. Carryforward is needed for the +1DAY specification.
Without the +1DAY specification, the job stream would launch
immediately after initialization from the western master at 0900.
Jobstream EST_SCHEDULE2 is time-zone enabled. When the
eastern FTA is initialized at 0900, it runs the jobstream at 0800 the
next day.

Once enabled, time zones can be specified in the JS Console or
composer for start and deadline times within jobs and jobstreams.
For conman, the following commands now accept time-zone
parameters where AT or UNTIL times are used:

¶ submit job

¶ submit docommand

¶ submit file

¶ submit schedule

¶ addep schedule

¶ addep job

¶ addep schedule

¶ addep job

¶ ″rurun job; from″ option

Time Zones
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Enabling the Time Zone Feature
The time-zone feature is enabled by an entry in the globalopts file
and by specifying a time zone in the master’s workstation definition,
as follows:
timezone enable = yes|no

Time zones are disabled by default on installation or update of the
product. If the timezone enable entry is missing from the globalopts
file, time zones are disabled.

Auditing
An auditing option has been implemented to track changes to the
database and the plan:

¶ For the database, all user modifications are logged. However, the
delta of the modifications, or before image and after image, will
not be logged. If an object is opened and saved, the action will
be logged even if no modification has been done.

¶ For the plan, all user modifications to the plan are logged.
Actions are logged whether they are successful or not.

The auditing logs are created in the following directories:
TWShome/audit/plan

TWShome/audit/database

Audit files are logged to a flat text file on individual machines in the
TWS network. This minimizes the risk of audit failure due to
network issues and enables a straightforward approach to writing the
log. The log formats are the same for both plan and database in a
general sense. The logs consist of a header portion which is the
same for all records, an action ID, and a section of data which will
vary according to the action type. All data is kept in clear text and
formatted to be readable and editable from a text editor such as vi or
notepad.

Time Zones
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Note: For modify commands, two entries are made in the log for
resources, calendars, parameters and prompts. The modify
command is displayed in the log as the delete and add
commands.

Enabling the Audit Feature
The auditing option is enabled by two entries in the globalopts file:
plan audit level = 0|1

database audit level = 0|1

A value of 1 enables auditing and a value of 0 disables auditing.
TWS currently defaults to 0, or auditing disabled. If these options
are not present in the globalopts file, auditing is disabled. Auditing
is disabled by default on installation of the product.

To initiate database auditing, you must shut down TWS completely
and use the wmaeutil command to stop the connector instance1.
When you restart TWS and the connector instance, the database
audit log is initiated. Plan auditing takes effect when Jnextday is run.

Auditing Log Format
The audit log formats are basically the same for the plan and
database. The log consists of a header portion, an action ID, and
data sections that vary with the action type. The data is in clear text
format and each data item is separated by a vertical bar ( | ).

The log file entries will be in the following format:
Log Type|GMT Date|GMT Time|Local Date|Local
Time|Object Type|Action Type|Workstation
Name|User ID|Framework User|Object Name|Action
Data fields

The log files contain the following information:

Log Type
This field displays an eight character value indicating the
source of the log record. The following log types are
supported:

1. If connector instances are stopped, they restart when the GUI is launched.

Auditing
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HEADER
The log file header

CONMAN
conman command text

FILEAID
Command that opens a file

PLAN Plan action

STAGEMAN
stageman run

RELEASE
release command text

DATABASE
Database action

PARMS
Parameter command text

MAKESEC
makesec run

DBEXPAND
dbexpand run

GMT Date
This field displays the GMT date the action was performed.
The format is yyyymmdd where yyyy is the year, mm is the
month, and dd is the day.

GMT Time
This field displays the GMT time the action was performed.
The format is hhmmss where hh is the hour, mm is the
minutes, and ss is the seconds.

Local Date
This field displays the local date the action was performed.
The local date is defined by the time zone option of the
workstation. The format is yyyymmdd where yyyy is the year,
mm is the month, and dd is the day.

Auditing
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Local Time
This field displays the local time the action was performed.
The local time is defined by the time zone option of the
workstation. The format is hhmmss where hh is the hour, mm
is the minutes, and ss is the seconds.

Object Type
This field displays the type of the object that was affected by
an action. The object type is one of the following:

DATABASE
Database definition

DBWKSTN
Database workstation definition

DBWKCLS
Database workstation class definition

DBDOMAIN
Database domain definition

DBUSER
Database user definition

DBJBSTRM
Database job stream definition

DBJOB
Database job definition

DBCAL
Database calendar definition

DBPROMPT
Database prompt definition

DBPARM
Database parameter definition

DBRES
Database resource definition

DBSEC
Database security

Auditing
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PLAN Plan

PLWKSTN
Plan workstation

PLDOMAIN
Plan domain

PLJBSTRM
Plan job stream

PLJOB
Plan job

PLPROMPT
Plan prompt

PLRES
Plan resource

PLFILE
Plan file

Action Type
This field displays what action was taken against the object.
The appropriate values for this field are dependent on the
action being taken.

For the database, the Action Type can be ADD, DELETE,
MODIFY, EXPAND, or INSTALL. TWS will record ADD,
DELETE and MODIFY actions for workstation, workstation
classes, domains, users, jobs, job streams, calendars,
prompts, resources and parameters in the database. The
Action Type field also records the installation of a new
security file. When makesec is run TWS will record it as
INSTALL action for a Security definition object. When
dbexpand is run it will be recorded as a EXPAND action
for DATABASE object. LIST and DISPLAY actions for
objects are not logged. For fileaid TWS will only log the
commands that result in the opening of a file. For
parameters, the command line with arguments is logged.

Auditing
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Workstation Name
This field displays the TWS workstation from which the user
is performing the action.

User ID
This field displays the logon user who performed the
particular action. On Win32 platforms it will be the fully
qualified domain name domain\user.

Framework User
This field displays the Tivoli Framework recognized user ID.
This is the login ID of the Job Scheduling Console user.

Object Name
This field displays the fully qualified name of the object.
The format of this field will depend on the object type as
shown here:

DATABASE
N/A

DBWKSTN
workstation

DBWKCLS
workstation_class

DBDOMAIN
domain

DBUSER
[workstation#]user

DBJBSTRM
workstation#jobstream

DBJOB
workstation#job

DBCAL
calendar

DBPROMPT
prompt

Auditing
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DBPARM
workstation#parameter

DBRES
workstation#resource

DBSEC
N/A

PLAN N/A

PLWKSTN
workstation

PLDOMAIN
domain

PLJBSTRM
workstation#jobstream_instance

PLJOB
workstation#jobstream_instance.job

PLPROMPT
[workstation#]prompt

PLRES
workstation#resource

PLFILE
workstation#path(qualifier)

Action Dependent Data
This field displays the action-specific data fields. The format
of this data is dependent on the Action Type field.

Audit Log Header
Each log file will start with a header record that contains information
about when the log was created and whether it is a plan or database
log.

The contents of the header file entry is as follows:

Log Type
HEADER

Auditing
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GMT Date
The GMT date that the log file was created.

GMT Time
The GMT time that the log file was created.

Local Date
The local date that the log file was created.

Local Time
The local time that the log file was created.

Workstation Name
The TWS workstation name for which this file was created.
Each workstation in the TWS network creates its own log.

User ID
The TWS user ID that created the log file.

Object Type
This field reads DATABASE for a database log file and
PLAN for a plan log file.

Object Name
N/A

Action Type
N/A

Action Dependent Data
This field displays the version of the file.

Sample Audit Log Entries
Below are some sample log file entries:
HEADER |19991202|201200|19991202|131200|DATABASE| |GANGES
|RIVERS\pyasa |||1.0

DATABASE|19991202|224504|19991202|154504|DBWKSTN |ADD
|GANGES |RIVERS\pyasa ||JAMUNA|

DATABASE|19991203|001400|19991202|171400|DBJOB |MODIFY |SINDHU
|RIVERS\tairak ||NARMADA#dubo|

Auditing
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Global and Local Options

This chapter describes Global and Local options of TWS. The
options define how TWS executes on your system.

Changes to the globalopts file take effect when Jnextday is run or a
new plan is created. Changes to the localoptions take effect when
the entire TWS production process tree is refreshed.

Global Options
The Global Options are defined on the master domain manager and
apply to all workstations in the TWS network.

Setting the Global Options
Global Options are entered in the globalopts file with a text editor.
You can make changes at any time, but they do not take effect until
TWS is stopped and restarted. The syntax is described in the
following table. Entries are not case-sensitive.

Global Option Syntax Default Value

# comment

automatically grant logon as batch =
yes|no

no

batchman schedule = yes|no no

carry job states = ([state[,...]]) null

carryforward = yes|no|all yes

company = companyname null

3
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Global Option Syntax Default Value

database audit level = 0|1 0

expanded version = yes|no null

history =days 10

ignore calendars = yes|no no

master =wkstation Set initially by customize
on UNIX and Setup on
Windows NT

plan audit level = 0|1 0

retain rerun job name = yes|no no

start =starttime 0600

timezone enable = yes|no no

# comment
Treat everything from the pound sign to the end of the line
as a comment.

automatically grant logon as batch job
This is for Windows NT jobs only. If set to yes, the logon
users for Windows NT jobs are automatically granted the
right to Logon as batch job. If set to no, or omitted, the
right must be granted manually to each user or group. Note
that the right cannot be granted automatically for users
running jobs on a Backup Domain Controller (BDC), so you
must grant those rights manually.

batchman schedule
This is a production option that affects the operation of
Batchman, which is the production control process of TWS.
The setting determines the priority assigned to the job
streams created for unscheduled jobs. Enter yes to have a
priority of 10 assigned to these job streams. Enter no to have
a priority of 0 assigned to these job streams.

carry job states
This is a pre-production option that affects the operation of
the stageman command. Its setting determines the jobs, by
state, to be included in job streams that are carried forward.

Global Options
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You must enclose the job states in parentheses, double
quotation marks, or single quotation marks. The commas can
be replaced by spaces. The valid internal job states are as
follows:

abend abenp add done exec fail
hold intro pend ready rjob sched
skel succ succp susp wait waitd

Some examples of the option are as follows:
carry job states=(abend,exec,hold,intro)
carry job states="abend exec hold intro"
carry job states='abend exec hold intro'

An empty list is entered as follows:
carry job states=()

See “Understanding the Carry Forward Options” on page 38
for more information.

carryforward
This is a pre-production option that affects the operation of
the stageman command. Its setting determines whether or
not job streams that did not complete are carried forward
from the old to the new production plan (Symphony). Enter
yes to have uncompleted job streams carried forward only if
the Carry Forward option is enabled in the job stream
definition. Enter all to have all uncompleted job streams
carried forward, regardless of the Carry Forward option.
Enter no to completely disable the carry forward function.
The stageman -carryforward command line option is
assigned the same values and serves the same function as the
carryforward Global Option. If it is used, it overrides the
Global Option. See “Understanding the Carry Forward
Options” on page 38 for more information.

company
This is your company’s name, up to 40 characters. If the
name contains spaces, enclose the entire name in quotation
marks (″).

Global Options
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database audit level
Select whether to enable or disable database auditing. Valid
values are 0 to disable database auditing, and 1 to activate
database auditing. Auditing information is logged to a flat
file in the TWShome/audit/database directory. Each TWS
workstation maintains its own log. For the database, only
actions are logged in the auditing file, not the delta of the
action. For more information on this feature, refer to
“Auditing” on page 24.

expanded version
This option is set during installation by customize on UNIX,
and Setup on Windows NT. If set to yes, expanded databases
are used. If set to no, expanded databases are not used.
Expanded databases permit the use of long object names. For
example, expanded job names can contain up to sixteen
characters. The option is also set to yes when you run the
dbexpand utility to convert from non-expanded to expanded
databases. If the option does not exist, as in the case of a
TWS version earlier than 6.0, it is interpreted as no.

history
Enter the number of days for which you want to save job
statistics. Statistics are discarded on a first-in, first-out basis.
This has no effect on job standard list files, which must be
removed with the rmstdlist command. See the Tivoli
Workload Scheduler Reference Manual for information about
the rmstdlist command.

ignore calendars
This is a pre-production option that affects the operation of
the compiler command (see page “The compiler Command”
on page 81). Its setting determines whether or not user

calendars are copied into the new Production Control file.
Enter yes to prevent user calendars from being copied into
the new production plan (Symphony file). This conserves
space in the file, but permits the use of calendar names in
date expressions. Enter no to have user calendars copied into
the new production plan. See “The compiler Command” on
page 81 for more information.
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master
The name of the master domain manager. This is set when
you install TWS with customize (UNIX) or Setup (Windows
NT).

plan audit level
Select whether to enable or disable plan auditing. Valid
values are 0 to disable plan auditing, and 1 to activate plan
auditing. Auditing information is logged to a flat file in the
TWShome/audit/plan directory. Each TWS workstation
maintains its own log. For the plan, only actions are logged
in the auditing file, not the success or failure of any action.
For more information on this feature, refer to “Auditing” on
page 24.

retain rerun job name
This is a production option that affects the operation of
Batchman, which is the production control process of TWS.
Its setting determines whether or not jobs that are rerun with
the Conman rerun command will retain their original job
names. Enter yes to have rerun jobs retain their original job
names. Enter no to permit the rerun from name to be
assigned to rerun jobs.

start Enter the start time of the TWS processing day in 24 hour
format: hhmm (0000-2359). The default start time is 6:00
A.M., and the default launch time of the final job stream is
5:59 A.M. If you change this option, you must also change
the launch time of the final job stream, which is usually set
to one minute before the start time.

timezone enable
Select whether to enable or disable the time zone option.
Valid values are yes to activate time zones in your network,
and no to disable time zones in the network. Time zones are
disabled by default on installation of TWS. If the timezone
enable entry is missing from the globalopts file, time zones
are disabled. For more information on this feature, refer to
“Time Zones” on page 21.
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Global Options File Example
A Global Options file template containing TWS’s default settings is
located in TWShome/config/globalopts.

During the installation process, a working copy of the Global
Options file is installed as TWShome/mozart/globalopts.

You can customize the working copy to your needs. The following is
a sample of a Global Options file:
# Globalopts file on the master domain manager defines
# attributes of the TWS network.
#--------------------------------------------------------
company="Tivoli Systems"
master=main
start=0600
history=10
carryforward=yes
ignore calendarsno
batchman schedule=no
retain rerun job name=no
#
#--------------------------------------------------------
# End of globalopts.

Understanding the Carry Forward Options
Job streams are carried forward by the stageman command during
end-of-day processing. The carry forward process is affected by the
following:

¶ The carryforward keyword in your job streams. Refer to the
Tivoli Workload Scheduler Reference Guide for more
information.

¶ The carryforward Global Option. See “carryforward” below
“Setting the Global Options” on page 33.

¶ The stageman -carryforward command line option. See “The
stageman Command” on page 83.

¶ The carry job states Global Option. See “carry job states”
below“Setting the Global Options” on page 33.

The following table shows how the various carry forward options
work together.
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Global Options Carry Forward Operation

carryforward=no No job streams are carried forward.

carryforward=yes carry
job states=(states)

Job streams are carried forward only if they
have both jobs in the specified states and the
Carryforward option enabled. Only the jobs
in the specified states are carried forward
with the job streams.

carryforward=yes carry
job states=()

Job streams are carried forward only if they
are both uncompleted and have the
Carryforward option enabled. All jobs are
carried forward with the job streams.

carryforward=all carry
job states=(states)

Job streams are carried forward only if they
have jobs in the specified states. Only jobs in
the specified states are carried forward with
the job streams.

carryforward=all carry
job states=()

Job streams are carried forward only if they
are uncompleted. All jobs are carried forward
with the job streams.

Below is information on the behavior of the carry forward options:

¶ Any job stream not in SUCC status are considered uncompleted,
and are carried forward.

¶ The stageman -carryforward command line option, if used,
always overrides the carryforward Global Option. The default,
if neither is specified, is carryforward=yes.

¶ The default entry is null for the carry job states Global Option.
That is, if the list is empty or the option is absent, carry forward
works as described for carry job states=().

¶ Jobs and job streams that were cancelled are never carried
forward.

¶ Jobs and job streams with expired until times are never carried
forward.

¶ The decision to carry forward a repetitive job (defined by the
Every option) is based on the state of its most recent run.
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¶ If a job is running when the Jnextday job begins execution, and
it is not specified to be carried forward, the job continues to run
and is placed in the userjobs job stream for the new production
day. Note that dependencies on such jobs are not carried
forward, and any resources that are held by the job are released.

Setting Global Options for MPE Agents
In a TWS network with a UNIX or NT system configured as domain
managers and HP3000 (MPE) systems configured as FTAs, you can
specify a set of Global Options on the UNIX/NT master domain
manager to control TWS’s operation on the MPE FTAs.

These options take the place of parameters that would otherwise be
set on the MPE systems using the Arranger program’s CTP1
transaction. To incorporate these options, add them to your
globalopts file using the syntax as described in the following table.
The entries are not case-sensitive.

Global Option Syntax Default Value

rules mode = yes|no no

batchman schedule = yes|no no

all userjobs in userjobs schedule = yes|no no

set mpe job pri to zero = yes|no no

rules mode
Replaces CTP1- parameter 4, which is Complete Control
Mode. If you set this option to yes, you must also set
batchman schedule to yes. The normal status of Batchman
is Lives when active, Down when inactive. This is displayed
in the Scheduler Properties window of the Job Scheduling
Console, or by running the conman status command in the
CLI. Enabling this option changes the Batchman active
status to display Rules.

batchman schedule
Replaces CTP1- parameter 7, which is Assign priority 10 to
Batchman-created job streams. Note that this option is also
valid on UNIX and Windows NT. See “Global Options” on
page 33.
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all userjobs in userjobs schedule
Replaces CTP1- parameter 8, which is Place all user jobs in
USERJOBS job stream. Set this option to no if rules mode
is set to yes.

set mpe job pri to zero
Replaces CTP1- parameter 9, which is Force MPE priority
to 0 for all userjobs. Set this option to no if the all
userjobs in userjobs schedule option is set to yes.

Local Options
Local Options are defined on each workstation, and apply only to
that workstation.

Setting Local Options
You enter Local Options in a file named localopts with a text editor.
Changes can be made at any time but do not take effect until TWS
is stopped and restarted. The syntax is described in the following
table. Entries are not case-sensitive.

Local Option Syntax Default Value

# comment

bm check file = seconds 120

bm check status = seconds 300

bm check until = seconds 300

bm look = seconds 30

bm read = seconds 15

bm stats = on|off off

bm verbose = on|off off

jm job table size = entries 160

jm look = seconds 300

jm nice = value 0

jm no root = yes|no no

jm read =seconds 10

merge stdlists = yes|no yes
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Local Option Syntax Default Value

mm read =seconds 15

mm response = seconds 600

mm retry link =seconds 600

mm sound off = yes|no no

mm unlink = seconds 960

nm ipvalidate = none|full none

nm mortal = yes|no no

nm port =tcpaddr 31111

nm read = seconds 60

nm retry =seconds 800

stdlist width = columns 80

syslog local = facility -1

thiscpu = wkstation thiscpu

wr read =seconds 600

wr unlink =seconds 600

mozart directory = mozart_share None

unison network directory = unison_share None

parameters directory =parms_share None

# comment
Treats everything from the pound sign to the end of the line
as a comment.

bm check file
Specify the minimum number of seconds Batchman will wait
before checking for the existence of a file that is used as a
dependency.

bm check status
Specify the number of seconds Batchman will wait between
checking the status of an internetwork dependency.

bm check until
Specify the maximum number of seconds Batchman will
wait before reporting the expiration of an Until time for job

Local Options

42 Version 7.0



or job stream. Specifying a value below the default setting
(300) may overload the system. If it is set below the value
of Local Option bm read, the value of bm read is used in
its place.

bm look
Specify the minimum number of seconds Batchman will wait
before scanning and updating its production control file.

bm read
Specify the maximum number of seconds Batchman will
wait for a message in its message file.

bm stats
Specify on to have Batchman send its startup and shutdown
statistics to its standard list file. Specify off to prevent
Batchman statistics from being sent to its standard list file.

bm verbose
Specify on to have Batchman send all job status messages to
its standard list file. Specify off to prevent the extended set
of job status messages from being sent to the standard list
file.

jm job table size
Specify the size, in number of entries, of the job table used
by Jobman.

jm look
Specify the minimum number of seconds Jobman will wait
before looking for completed jobs and performing general
job management tasks.

jm nice
For UNIX only, specify the nice value to be applied to jobs
launched by Jobman.

jm no root
For UNIX only, specify yes to prevent Jobman from
launching root jobs. Specify no to allow Jobman to launch
root jobs.
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jm read
Specify the maximum number of seconds Jobman will wait
for a message in its message file.

merge stdlists
Specify yes to have all of the TWS control processes, except
Netman, send their console messages to a single standard list
file. The file is given the name maestro. Specify no to have
the processes send messages to separate standard list files.

mm read
Specify the rate, in seconds, at which Mailman checks its
mailbox for messages. The default is 15 seconds. Specifying
a lower value will cause TWS to run faster but use more
processor time.

mm response
Specify the maximum number of seconds Mailman will wait
for a response before reporting that a workstation is not
responding. The response time should not be less than 90
seconds.

mm retry link
Specify the maximum number of seconds Mailman will wait,
after unlinking from a non-responding workstation, before it
attempts to link to the workstation again.

mm sound off
Specifies how Mailman responds to a conman tellop ?
command. Specify yes to have Mailman display information
about every task it is performing. Specify no to have
Mailman send only its own status.

mm unlink
Specify the maximum number of seconds Mailman will wait
before unlinking from a workstation that is not responding.
The wait time should not be less than the response time
specified for the Local Option nm response.

nm ipvalidate
Specify full to enable IP address validation. If IP validation
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fails, the connection is not allowed. Specify none to allow
connections when IP validation fails.

nm mortal
Specify yes to have Netman quit when all of its child
processes have stopped. Specify no to have Netman keep
running even after its child processes have stopped.

nm port
Specify the TCP port number that Netman responds to on the
local computer. This must match the TCP Address in the
computer’s workstation definition.

nm read
Specify the maximum number of seconds Netman will wait
for a connection request before checking its message queue
for stop and start commands.

nm retry
Specify the maximum number of seconds Netman will wait
before retrying a connection that failed.

stdlist width
Specify the maximum width of the TWS console messages.
You can Specify a column number in the range 1 to 255 and
lines are wrapped at or before the specified column,
depending on the presence of imbedded carriage control
characters. Specify a negative number or zero to ignore line
width. On UNIX, you should ignore line width if you enable
system logging with the syslog local option.

syslog local
Enables or disables TWS system logging for UNIX
computers only. Specify -1 to turn off system logging for
TWS. Specify a number from 0 to 7 to turn on system
logging and have TWS use the corresponding local facility
(LOCAL0 through LOCAL7) for its messages. Specify any
other number to turn on system logging and have TWS use
the USER facility for its messages. For more information,
see “TWS Console Messages and Prompts” on page 48.
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thiscpu
Specify the TWS name of this workstation.

wr read
Specify the number of seconds the Writer process will wait
for an incoming message before checking for a termination
request from Netman.

wr unlink
Specify the number of seconds the Writer process will wait
before exiting if no incoming messages are received. The
lower limit is 120 and the default is 600.

Local Options File Example
A template file containing TWS’s default settings is located in
TWShome/config/localopts.

During the installation process, a working copy of the Local Options
file is installed as TWShome/localopts unless you have specified an
non-default location for netman. Then there two copies of the
localopts file, one in TWShome and one in Netmanhome. Any
options pertaining to netman need to updated to the localopts file in
Netmanhome.

You can customize the working copy to your needs. The following is
a sample of a Local Options file:
# Localopts file defines attributes of this workstation.
#-----------------------------------------------------
thiscpu =sys1
merge stdlists =yes
stdlistwidth =80
sysloglocal =-1
#-----------------------------------------------------
# Attributes of this workstation for batchman process:
bm check file =120
bm check until =300
bm look =30
bm read =15
bm stats =off
bm verbose =off
#-----------------------------------------------------
# Attributes of this workstation for jobman process:
jm job table size =160
jm look =300
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jm nice =0
jm no root =no
jm read =10
#-----------------------------------------------------
# Attributes of this workstation for mailman process:
mm response =600
mm retrylink =600
mm sound off =no
mm unlink =960
#-----------------------------------------------------
# Attributes of this workstation for netman process:
nm mortal =no
nm port =31111
nm read =60
nm retry =800
#-----------------------------------------------------
# Attributes of this workstation for writer process:
wr read =600
wr unlink =720
#-----------------------------------------------------
# Optional attributes of this workstation for remote
# database files
# mozart directory = d:\tws\mozart
# parameters directory = d:\tws
# unison network directory = d:\tws\..\unison\network
#
#------------------------------------------------------------
# End of localopts.

Setting Netman Local Options
If the home directory for Netman is not the same as the home
directory for TWS, the following local options are moved to a
separate localopts file in the Netman directory:

¶ nm ipvalidate

¶ nm mortal

¶ nm port

¶ nm read

¶ nm retry

¶ merge stdlists

¶ stdlist width

¶ syslog local
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For more information about the Netman directory, refer the Tivoli
Workload Scheduler Planning and Installation Guide.

Setting Options for Decentralized Administration on
Windows NT

If you installed TWS using the procedure that permits decentralized
administration of scheduling objects, you can define the shared
directories on the master domain manager with the following
options.

For information about installation prerequisites, the Tivoli Workload
Scheduler Planning and Installation Guide.

mozart directory
Specify the name of the master domain manager’s shared
mozart directory.

unison network directory
Specify the name of the master domain manager’s shared
unison directory.

parameters directory
Specify the name of the master domain manager’s shared
TWShome directory.

If an option is not set or does not exist, the TWS programs attempt
to open the database files on the local computer.

TWS Console Messages and Prompts
The TWS control processes (Netman, Mailman, Batchman, Jobman,
and Writer) write their status messages, referred to as console
messages, to standard list files. These messages include the prompts
used as job and job stream dependencies. On UNIX, the messages
can also be directed to the syslog daemon (syslogd) and to a
terminal running the TWS console manager. These features are
described in the following sections.

Setting sysloglocal on UNIX
If you set sysloglocal in the Local Options file to a positive number,
TWS’s control processes send their console and prompt messages to
the syslog daemon. Setting it to -1 turns this feature off. If you set it
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to a positive number to enable system logging, you must also set the
Local Option stdlistwidth to 0, or a negative number.

TWS’s console messages correspond to the following syslog levels:

LOG_ERR
Error messages such as control process abends and file
system errors.

LOG_WARNING
Warning messages such as link errors and stuck job streams.

LOG_NOTICE
Special messages such as prompts and tellops.

LOG_INFO
Informative messages such as job launches and job and job
stream state changes.

Setting sysloglocal to a positive number defines the syslog facility
used by TWS. For example, specifying 4 tells TWS to use the local
facility LOCAL4. After doing this, you must make the appropriate
entries in the /etc/syslog.conf file, and reconfigure the syslog
daemon. To use LOCAL4 and have the TWS messages sent to the
system console, enter the following line in /etc/syslog.conf:
local4 /dev/console

To have the TWS error messages sent to the maestro and root users,
enter the following:
local4.err maestro,root

Note that the selector and action fields must be separated by at least
one tab. After modifying /etc/syslog.conf, you can reconfigure the
syslog daemon by entering the following command:
kill -HUP vcat /etc/syslog.pidv

console Command
You can use the Console Manager’s console command to set the
TWS message level and to direct the messages to your terminal. The
message level setting affects only Batchman and Mailman messages,
which are the most numerous. It also sets the level of messages
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written to the standard list file or files and the syslog daemon. The
following command, for example, sets the level of Batchman and
Mailman messages to 2 and sends the messages to your computer:
console sess;level=2

Messages are sent to your computer until you either execute another
console command, or exit Conman. To stop sending messages to
your terminal, you can enter the following Conman command:
console sys
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TWS Security

TWS programs and commands determine a user’s capabilities by
comparing the user’s name with the user definitions in the Security
file. This chapter explains how to write user definitions and manage
the Security file.

The Security File
A template file named TWShome/config/Security is provided with
the software. During installation, a copy of the template is installed
as TWShome/Security and a compiled, operational copy is installed
as TWShome/../unison/Security.

Creating the Security File
To create user definitions, edit the template file TWShome/Security.
Do not modify the original template in TWShome/config/Security.
Then, use the makesec command to compile and install a new
operational Security file. After it is installed, you can make further
modifications by creating an editable copy of the operational file
with the dumpsec command. The makesec and dumpsec commands
are described later in this chapter. Changes to the Security file take
effect when TWS is stopped and restarted.

Managing Security in a Network
Each workstation in a TWS network (domain managers,
fault-tolerant agents, and standard agents) has its own Security file.
You can maintain a file on each workstation, or you can create a

4
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Security file on the master domain manager and copy it to each
domain manager, fault-tolerant agent, and standard agent.

Security File Syntax
The Security file contains one or more user definitions. Each user
definition identifies a set of users, the objects they are permitted to
access, and the types of actions they can perform.

User Definitions
A user definition defines a set of users, the objects they can access,
and the actions they can perform.

Synopsis
[#comment]

user def-name user-attributes

begin [* comment]

object-type [object-attributes] access[=action[,...]]

[object-type ... ]

[end]

Variables
[# | *] comment

All text following a pound sign or an asterisk and at least
one space is treated as a comment. Comments are not copied
into the operational Security file installed by the makesec
command.

def-name
Specifies the name of the user definition. The name can
contain up to 36 alphanumeric characters and must start with
a letter.

The Security File
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user-attributes
Specifies one or more attributes that identify the set of users
to whom the definition applies. Specify user attributes as
follows:

user-attribute[{+ | x}user-attribute[...]]

Use a plus sign (+) to add an attribute the user or users must
have. Use a tilde (x) to add an attribute the user or users
must not have. A user-attribute is defined as:

cpu=wkstation|$framework|@ [,...]
where:

wkstation
Specifies the workstation or workstation
class on which the user is logged in.
Wildcard characters are permitted. The
following TWS variables can be used:

$master
The user is logged in on the TWS
master domain manager.

$remotes
The user is logged in on any TWS
standard agent.

$slaves
The user is logged in on any TWS
fault-tolerant agent.

$thiscpu
The user is logged in on the TWS
workstation on which the secured
program is running.

For Job Scheduling Console users, use
$framework.

$framework
Specifies the workstation from which the
user is running the Job Scheduling Console.
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@ Specifies that the user is accessing TWS
with the Job Scheduling Console or is logged
in on any TWS workstation.

group=groupname[,...]
For UNIX users only. Do not use this argument for
Job Scheduling Console users. Specifies the UNIX
group in which the user is a member. Wildcard
characters are permitted.

logon=username|tme-admin|@ [,...]
where:

username
Specifies the name with which the user is
logged in on a TWS workstation. Wildcard
characters are permitted. The cpu= attribute
must be set to a workstation name or @.

tme-admin
Specifies the name of the TME
administrators group in which the user is a
member. If the name contains spaces, it must
be enclosed in double quotation marks.
Wildcards are permitted. The cpu= attribute
must be set to $framework or @.

@ Specifies that the user is logged in with any
name or is a member of any TME
administrators group.

object-type
Specifies the type of object the user is given permission to
access. The object types are as follows:
calendar

User calendars.
cpu Workstations, domains, and workstation classes.
file TWS database files.
job Scheduled jobs.
parameter

User parameters.
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prompt
Global prompts.

resource
Scheduling resources.

schedule
Job streams.

userobj
User objects.

You can include multiple object types in a user definition.
Omitting an object type prevents access to all objects of that
type.

object-attributes
Specifies one or more attributes that identify a set of objects
of the specified type. If no attributes are specified, all objects
of the specified type are accessible. Specify object attributes
as follows:

object-attribute[{+ | x}object-attribute[...]]

Use a plus sign (+) to add an attribute objects must have.
Use a tilde (x) to add an attribute objects must not have. An
object-attribute can be any of the following:

¶ For the object type calendar:

name=calendar-name[,...]
Specifies one or more calendar names. Wildcard
characters are permitted. Multiple names must be
separated by commas. If omitted, all calendars
qualify.

¶ For the object type cpu (workstation):

cpu=wkstation[,...]
Specifies one or more workstation, domain, or
workstation class names. Wildcard characters are
permitted. Multiple names must be separated by
commas. If omitted, all workstations qualify. The
following TWS variables are permitted: $master,
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55Tivoli Workload Scheduler User’s Guide

4.
T

W
S

S
ecu

rity



$remotes, $slaves, and $thiscpu. See
“Tivoli-Supplied Variables” on page 64 for more
information.

¶ For the object type file:

name=filename[,...]
Specifies the names of TWS database files.
Wildcard characters are permitted. Multiple
names must be separated by commas. If omitted,
all files qualify. The file names are as follows:
calendars

Contains calendars.
cpudata

Contains workstation, workstation
classes, and domains.

jobs Contains jobs.
mastsked

Contains job streams.
parameters

Contains parameters.
prodsked

Contains the production schedule.
prompts

Contains prompts.
resources

Contains resources.
security

The Security file.
Symphony

Contains the production plan.

¶ For the object type job:

cpu=wkstation
Specifies the name of the workstation or
workstation class on which the job runs.
Wildcard characters are permitted. If omitted, all
workstations qualify. The following TWS
variables are permitted: $master, $remotes,
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$slaves, and $thiscpu. See “Tivoli-Supplied
Variables” on page 64 for more information.

jcl=″path″ | ″cmd″
Specifies the command or the path name of the
job’s executable file. The command or path must
be enclosed in quotation marks (″). Wildcard
characters are permitted. If omitted, all job files
and commands qualify.

logon=username[,...]
Specifies the user names under which the jobs
run. Wildcard characters are permitted. Multiple
names must be separated by commas. If omitted,
all user names qualify. The following TWS
variables are permitted: $jclowner, $owner, and
$user. See “Tivoli-Supplied Variables” on
page 64 for more information.

name=[jobstream.]job[,...]
Specifies the TWS job name. The job’s job
stream name is optional. Wildcard characters are
permitted. Multiple names must be separated by
commas. If omitted, all job names qualify.

¶ For the object type parameter:

cpu=wkstation
Specifies the name of the workstation on which
the parameters are defined. Wildcard characters
are permitted. If omitted, all workstations
qualify. The following TWS variables are
permitted: $master, $remotes, $slaves, and
$thiscpu. See “Tivoli-Supplied Variables” on
page 64 for more information.

name=parameter[,...]
Specifies one or more parameter names.
Wildcard characters are permitted. Multiple
names must be separated by commas. If omitted,
all parameters qualify.
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¶ For the object type prompt:

name=prompt[,...]
Specifies one or more prompt names. Wildcard
characters are permitted. Multiple names must be
separated by commas. If omitted, all prompts
qualify.

¶ For the object type resource:

cpu=wkstation[,...]
Specifies the name of the workstation or
workstation class on which the resources are
defined. Wildcard characters are permitted.
Multiple names must be separated by commas. If
omitted, all workstations qualify. The following
TWS variables are permitted: $master,
$remotes, $slaves, and $thiscpu. See
“Tivoli-Supplied Variables” on page 64 for more
information.

name=resource[,...]
Specifies one or more resource names. Wildcard
characters are permitted. Multiple names must be
separated by commas. If omitted, all resources
qualify.

¶ For the object type schedule (job stream):

cpu=wkstation
Specifies the name of the workstation or
workstation class on which the job streams run.
Wildcard characters are permitted. If omitted, all
workstations qualify. The following TWS
variables are permitted: $master, $remotes,
$slaves, and $thiscpu. See “Tivoli-Supplied
Variables” on page 64 for more information.

name=jobstream[,...]
Specifies one or more job stream names.
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Wildcard characters are permitted. Multiple
names must be separated by commas. If omitted,
all job streams qualify.

¶ For the object type userobj:

cpu=wkstation
Specifies the name of the workstation on which
the user is defined. Wildcard characters are
permitted. If omitted, all workstations qualify.
The following TWS variables are permitted:
$master, $remotes, $slaves, and $thiscpu. See
“Tivoli-Supplied Variables” on page 64 for more
information.

logon=username[,...]
Specifies one or more user names. Wildcard
characters are permitted. Multiple names must be
separated by commas. If omitted, all users
qualify.

action Specifies the actions users can perform. Multiple actions
must be separated by commas. If none are specified, no
actions are permitted. Entering access=@ gives users the
ability to perform all actions.

¶ For the object type calendar:

add Add and save new calendars in the database.

delete Delete calendars from the database.

display
Display calendars in the database.

modify
Modify calendars in the database.

use Use calendars to schedule job streams.

¶ For the object type cpu, which includes workstations,
workstation classes, and domains:

add Add and save new workstations, workstation
classes, and domains in the database.
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console
View and alter the TWS console.

delete Delete workstations, workstation classes, and
domains from the database.

display
Display workstations, workstation classes, and
domains in the database.

fence Alter workstation job fences in the production
plan.

limit Alter workstation job limits in the production
plan.

link Open workstation links.

modify
Modify and replace workstations, workstation
classes, and domains in the database.

shutdown
Shutdown TWS processing. This action is only
available in the command line.

start Start TWS processing.

stop Stop TWS processing.

unlink
Close workstation links.

To permit a user to switch the domain manager function
to a workstation, the user must have both start and stop
access to the workstation.

¶ For the object type file:

build Build TWS’s database files. This action is only
available in the command line.

delete Not yet implemented.

display
Access the Security file with the dumpsec
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command. Also display the calendars,
parameters, prompts, and resources master files.
These actions are only valid in the command
line.

modify
Access the Security file with the makesec
command. Also modify the calendars,
parameters, prompts, and resources master files.
These actions are only available in the command
line.

Note:The object type file is used to manage security on
the CLI and is only valid for the CLI.

¶ For the object type job:

add Add and save new jobs in the database.

adddep
Add dependencies to jobs in the production plan.

altpri Alter the priority of jobs in the production plan.

cancel Cancel jobs in the production plan.

confirm
Confirm the completion of jobs in the production
plan.

deldep
Delete dependencies from jobs in the production
plan.

delete Delete jobs from the database.

display
Display jobs in the database.

kill Kill jobs in the production plan.

modify
Modify and replace jobs in the database.
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release
Release jobs from their dependencies in the
production plan.

reply Reply to job prompts in the production plan.

rerun Rerun jobs in the production plan.

submit
Submit jobs into the production plan.

use Add jobs to job streams in the database.

¶ For the object type parameter:

add Add and save new parameters in the database.

delete Delete parameters from the database.

display
Display parameters in the database.

modify
Modify and replace parameters in the database.

¶ For the object type prompt:

add Add and save new prompts in the database.

delete Delete prompts from the database.

display
Display prompts in the database.

modify
Modify and replace prompts in the database.

use Add prompts to job streams in the database and
add prompts to jobs and job streams in the
production plan.

¶ For the object type resource:

add Add and save new resources in the database.

delete Delete resources from the database.

display
Display resources in the database.
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modify
Modify and replace resources in the database.

use Add resources to job streams in the database and
add resources to jobs and job streams in the
production plan.

¶ For the object type schedule (job stream):

add Add and save new job streams in the database.

adddep
Add dependencies to job streams in the
production plan.

altpri Alter the priority of job streams in the
production plan.

cancel Cancel job streams in the production plan.

deldep
Delete dependencies from job streams in the
production plan.

delete Delete job streams from the database.

display
Display job streams in the database.

limit Alter the job limit of job streams in the
production plan.

modify
Modify and replace job streams in the database.

release
Release job streams from their dependencies in
the production plan.

reply Reply to job stream prompts in the production
plan.

submit
Submit job streams into the production plan.

¶ For the object type userobj:
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add Add new users in the database.

delete Delete users from the database.

display
Display users in the database.

modify
Modify and replace users in the database.

altpass
Alter user passwords in the database.

Order of User Qualification
In qualifying users to access TWS objects, a user’s actual attributes
are compared to user definitions in the order the definitions are
entered in the Security file. The first definition that matches the user
determines the user’s capabilities. For this reason, it is important to
order user definitions from most specific to least specific. See
“Sample Security File” on page 66 for more information.

Order of Object Qualification
In a user definition, you can use multiple statements for a single
object type to assign different access capabilities to different sets of
objects. Because the first matching statement is used, the order of
object statements is important. They must be ordered from most
specific to least specific. For example:
#Incorrect:
job name=@ access=display
job name=ar@ access=@

#Correct:
job name=ar@ access=@
job name=@ access=display

See “Sample Security File” on page 66 for more information.

Tivoli-Supplied Variables
The Tivoli-supplied variables that can be used in object attributes are
as follows:

$jclgroup
The group name of a job’s executable file.
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$jclowner
The owner of a job’s executable file.

$master
The TWS master domain manager.

$owner
The creator of a job stream and its jobs.

$remotes
All standard agent workstations.

$slaves
All fault-tolerant agent workstations.

$thiscpu
The TWS workstation on which the user is executing the
TWS command or program.

$user The user executing the TWS command or program.

The variables $jclgroup and $jclowner are verifiable only if the
user is running a TWS program on the workstation where the job’s
executable file resides. If the program is being run on a different
workstation, the user is denied access.

Wildcard Characters
Where noted in the syntax descriptions, the following wildcard
characters are permitted:

? Replaces one alphabetic character.

% Replaces one numeric character.

@ Replaces zero or more alphanumeric characters.

The Superuser on UNIX
If a Security file does not exist, no users other than root can access
TWS objects, and the root user has unrestricted access to all objects
and can execute all TWS programs and commands. To control root,
create a Security file with a user definition for the root user. In the
Security file for a network, you can make a distinction between local
root users and the root user on the master domain manager. For
example, you can restrict local users to performing operations
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affecting only their login workstations and permit the master root
user to perform operations that affect any workstation in the
network. See “Sample Security File” for more information.

Sample Security File
The following is a sample Security file. An explanation of the file
follows the listing.
###########################################################

# Sample Security File

###########################################################

# (1) APPLIES TO MAESTRO OR ROOT USERS LOGGED IN ON THE

# MASTER DOMAIN MANAGER OR FRAMEWORK.

user mastersm cpu=$master,$framework + logon=maestro,root,
Root_london-region

begin

# OBJECT ATTRIBUTES ACCESS CAPABILITIES

# ---------- ------------ ----------------------

job access=@

schedule access=@

resource access=@

prompt access=@

file access=@

calendar access=@

cpu access=@

parameter name=@ x name=r@ access=@

userobj cpu=@ + logon=@ access=@

end
###########################################################
# (2) APPLIES TO MAESTRO OR ROOT USERS LOGGED IN ON ANY
# WORKSTATION OTHER THAN THE MASTER DOMAIN MANAGER.
user sm logon=maestro,root
begin
# OBJECT ATTRIBUTES ACCESS CAPABILITIES
# ---------- ------------ ----------------------
job cpu=$thiscpu access=@
schedule cpu=$thiscpu access=@
resource cpu=$thiscpu access=@
prompt access=@
file access=@
calendar access=@
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cpu cpu=$thiscpu access=@
parameter cpu=$thiscpu

x name=r@ access=@
end
###########################################################
# (3) APPLIES TO USERS LOGGED INTO THE SYS GROUP ON THE
# MASTER DOMAIN MANAGER OR FRAMEWORK.
user masterop cpu=$master,$fw + group=sys
begin
# OBJECT ATTRIBUTES ACCESS CAPABILITIES
# ---------- ------------ ----------------------
job cpu=@

+ logon=$user access=@
job cpu=@

+ logon=root access=adddep,altpri,cancel,
confirm,deldep,release,
reply,rerun,submit,use

job cpu=@
+ logon=$user,$jclowner
x logon=root access=add,adddep,altpri,

cancel,confirm,
deldep,release,reply,
rerun,submit,use

schedule cpu=$thiscpu access=@
schedule cpu=@ access=adddep,altpri,cancel,

deldep,limit,release,
submit

resource access=add,display,
resource,use

prompt access=add,display,reply,use
file access=build
calendar access=display,use
cpu cpu=@ access=@
parameter name=@ x name=r@ access=@
end
###########################################################
# (4) APPLIES TO USERS LOGGED INTO THE SYS GROUP ON ANY
# WORKSTATION OTHER THAN THE MASTER DOMAIN MANAGER
user op group=sys
begin
# OBJECT ATTRIBUTES ACCESS CAPABILITIES
# ---------- ------------ ----------------------
job cpu=$thiscpu

+ logon=$user access=@
job cpu=$thiscpu

+ logon=root access=adddep,altpri,cancel,
confirm,deldep,release,
reply,rerun,submit,use

job cpu=$thiscpu
x logon=root access=adddep,altpri,cancel,
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confirm,deldep,release,
reply,rerun,submit,use

schedule cpu=$thiscpu access=@
resource access=add,display,resource,use
prompt access=add,display,reply,use
file access=build
calendar access=use
cpu cpu=$thiscpu access=console,fence,limit,

link,start,stop,unlink
parameter name=@ x name=r@ access=@
end

###########################################################
# (5) APPLIES TO USERS LOGGED INTO THE MIS GROUP ON
# ANY WORKSTATION OR FRAMEWORK.
user misusers group=mis
begin
# OBJECT ATTRIBUTES ACCESS CAPABILITIES
# ---------- ------------ ----------------------
job cpu=$thiscpu

+ logon=$user access=@
job cpu=$thiscpu

+ logon=$jclowner
x logon=root access=submit,use

schedule cpu=$thiscpu access=add,submit,
modify,display

parameter name=r@ access=@
parameter name=@ access=display
end
###########################################################
# (6) APPLIES TO ALL OTHER USERS LOGGED IN ON ANY
# WORKSTATION.
user default logon=@
begin
# OBJECT ATTRIBUTES ACCESS CAPABILITIES
# ---------- ------------ ----------------------
job cpu=$thiscpu

+ logon=$user access=@
job cpu=$thiscpu

+ logon=$jclowner
x logon=root access=submit,use

schedule cpu=$thiscpu access=add,submit,
modify,display

parameter name=u@ access=@
parameter name=@ x name=r@ access=display
end
###########################################################
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Explanation of the Sample Security File
Note that the order of definitions is from most to least specific.
Because of the order, maestro and root users are matched first,
followed by users in the sys group, and then users in the mis group.
All other users are matched with the last definition, which is the
least specific.

# (1) APPLIES TO MAESTRO OR ROOT USERS LOGGED IN
ON THE MASTER DOMAIN MANAGER OR FRAMEWORK.
user mastersm cpu=$master,$fw +
logon=maestro,root,Root_london-region

This user definition applies to legacy GUI and CLI access for
maestroandroot users logged into a master domain manager. It also
gives TWS GUI access to users listed in the Root_london-
regionTME administrators group. or a Framework computer. They
are given unrestricted access to all objects, except parameters that
have names beginning with r. Access to the r parameters is given
only to users in the mis group.

# (2) APPLIES TO MAESTRO OR ROOT USERS LOGGED IN
ON ANY WORKSTATION OTHER THAN THE MASTER
DOMAIN MANAGER. user sm logon=maestro,root

This user definition applies to maestro and root users to whom
definition 1 does not apply, which are those who are logged in on
any workstation other than the master domain manager or a
Framework computer. They are given unrestricted access to all
objects on their login workstation. Note that prompts, files, and
calendars are global in nature and are not associated with a
workstation.

# (3) APPLIES TO USERS LOGGED INTO THE SYS GROUP
ON THE MASTER DOMAIN MANAGER OR FRAMEWORK.
user masterop cpu=$master,$fw + group=sys

This user definition applies to users logged into the sys group on the
master domain manager or a Framework computer. They are given a
unique set of access capabilities. Multiple object statements are used
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to give these users specific types of access to different sets of
objects. For example, there are three job statements:

¶ The first job statement permits unrestricted access to jobs that
run on any workstation (@) under the user’s name ($user).

¶ The second job statement permits specific types of access to jobs
that run on any workstation and that run as root.

¶ The third job statement permits specific types of access to jobs
that run on any workstation. The jobs must run under the user’s
name ($user) or under the name of the owner of the job file
($jclowner). Jobs that run as root are excluded.

# (4) APPLIES TO USERS LOGGED INTO THE SYS GROUP
ON ANY WORKSTATION OTHER THAN THE MASTER
DOMAIN MANAGER. user op group=sys

This user definition applies to sys group users to whom definition 3
does not apply, which are those who are logged in on any
workstation other than the master domain manager or a Framework
computer. They are given a set of access capabilities similar to those
in definition 3. The exception is that access is restricted to objects
on the user’s login workstation ($thiscpu).

# (5) APPLIES TO USERS LOGGED INTO THE MIS GROUP
ON ANY WORKSTATION OR FRAMEWORK. user misusers
group=mis

This user definition applies to users logged into the mis group on
any workstation or a Framework computer. They are given a limited
set of access capabilities. Resources, prompts, files, calendars, and
workstations are omitted, which prevents access to these objects.
These users are given unrestricted access to parameters with names
that begin with r, but can only display other parameters.

# (6) APPLIES TO ALL OTHER USERS LOGGED IN ON ANY
WORKSTATION.

user default logon=@
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This user definition gives a set of default capabilities to users other
than those covered by the preceding definitions. These users are
given unrestricted access to parameters with names that begin with
u, but can only display other parameters. No access is permitted to
parameters with names that begin with r.
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The dumpsec Command
Decompiles the Security file and sends the output to stdout.

The user must have display access to the Security file.

Synopsis
dumpsec -v | -u

dumpsec security-file

Description
If no arguments are specified, the operational Security file
(../unison/Security) is dumped. To create an editable copy of a
Security file, redirect the output of the command to another file, as
shown in the examples.

Arguments
-v Displays command version information only.

-u Displays command usage information only.

security-file
Specifies the name of the Security file to dump.

Examples
The following example displays the command version:
dumpsec -v

The following example dumps the operational Security file to
stdout:
dumpsec

The following example dumps the operational Security file to a file
named mysec:
dumpsec > mysec

The following example dumps a Security file named sectemp to
stdout:
dumpsec sectemp
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The makesec Command
Compiles user definitions and installs the Security file. Changes to
the Security file take effect when TWS is stopped and restarted.
Affected are:

¶ conman

¶ gconman

¶ composer

¶ gcomposer

¶ TWS connectors

Simply exit the programs. The next time they are run, the new
security definitions will be recognized. For TWS Connectors, you
will need to stop them by running the wmaeutil

command. The connectors will automatically be restarted with a
refresh of any query in the JS console.

The user must have modify access to the Security file.

Note:For Windows NT, the connector processes must be stopped
(using the wmaeutil command) before the makesec command will
work correctly.

Synopsis
makesec -v | -u

makesec [-verify] in-file

Description
The makesec command compiles the specified file and installs it as
the operational Security file (../unison/Security). If the -verify
argument is specified, the file is checked for correct syntax, but it is
not compiled and installed.

Arguments
-v Displays command version information only.
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-u Displays command usage information only.

-verify
Checks the syntax of the user definitions in in-file only. The
file is not installed as the Security file. (Syntax checking is
performed automatically when the Security file is installed.)

in-file Specifies the name of a file or set of files containing user
definitions. A file name expansion pattern is permitted.

Examples
The following example displays the command version:
makesec -v

The following example creates an editable copy of the operational
Security file in a file named tempsec; modifies the user definitions
with a text editor; then compiles tempsec and replaces the
operational Security file:
dumpsec > tempsec
edit tempsec

Here you make any required modifications to the tempsec file. When
you are complete modifying the tempsec file execute the makesec
command to load the security file into TWS:
makesec tempsec

The following example compiles user definitions from the file set
userdef* and replaces the operational Security file:
makesec userdef*
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The Production Cycle

TWS’s processing day begins at the time defined by the Global
Option start, which is set by default to 6:00 a.m. To turnover a new
day, pre-production set up is performed for the upcoming day, and
post-production logging and reporting is performed for the day just
ended. The procedures and commands to perform these tasks are
described in this chapter. For information about the start options, see
“Global Options” on page 33.

Figure 3. Processing day compared to calendar day
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Automating the Production Cycle
Pre and post-production processing can be fully automated by adding
the Tivoli-supplied final job stream, or a user-supplied equivalent, to
the TWS database along with other job streams. A copy of the
Tivoli-supplied job stream can be found in TWShome/config/Sfinal,
and a copy of the job script can be found in TWShome/Jnextday.
You may find it helpful to have printed copies to assist in
understanding the turnover process.

The final job stream is placed in production everyday, and results in
running a job named Jnextday prior to the start of a new day. The
job performs the following tasks:

1. Execute the schedulr command to select job streams for the new
day’s production plan. See “The schedulr Command” on page 79
for more information.

2. Execute the compiler command to compile the production plan.
See “The compiler Command” on page 81 for more information.

3. Execute the reptr command to print pre-production reports. See
“The reptr Command” on page 104 for more information.

4. Stop TWS.

5. Execute the stageman command to carry forward uncompleted
job streams, log the old production plan, and install the new
plan. See “The stageman Command” on page 83 for more
information.

6. Start TWS for the new day.

7. Execute the reptr command to print post-production reports for
the previous day. See “The reptr Command” on page 104 for
more information.

8. Execute the logman command to log job statistics for the
previous day. See “The logman Command” on page 88 for more
information.

In the TWS manual set, the terms final and Jnextday are used when
referring to both the Tivoli-supplied versions, and any user-supplied
equivalents.
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Customizing the final Job Stream
Before using the final job stream, it can be modified to meet your
needs, or you can create a different job stream to use in its place.

When creating your own job stream, model it after the one supplied
by Tivoli. If you choose to do so, consider the following:

¶ If you choose to change the way stageman generates log file
names, remember that reptr and logman must use the same
names.

¶ If you would like to print the pre-production reports in advance
of a new day, you can split the Jnextday job into two jobs. The
first job will execute schedulr, compiler and reptr. The second
job will stop TWS, execute stageman, start TWS, and execute
reptr and logman. The first job can then be scheduled to run at
any time prior to the end of day, while the second job is
scheduled to run just prior to the end of day.

Adding the final Job Stream
If you performed the quick start procedure in the Tivoli Workload
Scheduler Installation Guide, the final job stream is already added to
the database. If not, follow these steps to add the final job stream, or
a user-supplied equivalent.

1. Log in as the maestro user on the master domain manager.

2. At a command prompt, execute the following command on
UNIX:
composer “add Sfinal”

or the following command on Windows NT:
composer “add Sfinal”

To add your own job stream, use its name in place of Sfinal.

Starting a Production Cycle
If it has not been started before follow these steps:

1. Log in as the maestro user on the master domain manager.
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2. At a command prompt, execute the Jnextday job by entering the
following command:
Jnextday

This will perform pre-production processing and start TWS’s
production processes.

Production Processing Commands
The pre and post-production processing commands executed by the
Jnextday job are described on the pages that follow.
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The schedulr
Command

The schedulr command selects job streams for a specific date from
the database file mastsked, and copies them to a new production
schedule file named prodsked.

You must have build access to TWS’s database files.

Synopsis
schedulr -v|-u

schedulr [-date date|-autodate] [-scheds {in-file|-}] [-prodsked
{out-file|-}]

Arguments
-u Display the command version and exit.

-v Display command usage information and exit.

-date Select job streams for a specific date. The date is entered as
mm/dd/[yy]yy.

-autodate
Select job streams for the current system date.

-scheds
In addition to those selected by -date or -autodate, if any,
select the job streams named in in-file. The names must
appear in the file as [workstation#]jobstream, with one name
per line. If a dash is entered instead of a file name, schedulr
prompts for job stream names at stdin.

-prodsked
Direct schedulr output to out-file. If a dash is entered
instead of a file name, the output is directed to stdout. If the
argument is omitted, the output is written to a file named
prodsked.

Production Processing Commands

79Tivoli Workload Scheduler User’s Guide

5.
T

h
e

P
ro

d
u

ctio
n

C
ycle



Description
If -autodate, and -date are omitted, schedulr prompts for a date. If
you respond to the prompt by pressing Return, job streams are
selected only from the in-file.

Examples
Select job streams for today’s date, plus the job streams named in
the file myskeds:
schedulr -autodate -scheds myskeds

Select job streams for February 15, 1999, do not prompt for extra
job stream names, and write the output to the file myprodsked:
schedulr -date 2/15/90 -prodsked myprodsked

Select job streams for February 15, 1999, and prompt for extra job
streams:
schedulr -date 2/15/1999 -scheds -

Prompt for the production date, and extra job streams (note that
“schedule” is the same as “job stream”):
schedulr
Enter schedule date: 4/14/99
Enter a list of extra schedules
Schedule name: site1#sked2
Schedule name: <Return>
<list of job streams selected>
End of Program
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The compiler
Command

The compiler command compiles the production schedule file, and
creates an interim production plan file.

Synopsis
compiler -v|-u

compiler [-date date] [-input in-file] [-output out-file]

Arguments
-u Display the command version and exit.

-v Display command usage information and exit.

-date The production date to be recorded in the interim production
plan file. The date is entered as mm/dd/[yy]yy.

-input The name of the file containing the production schedule. If
this option is omitted, the default name is prodsked.

-output
Direct compiler output to out-file. If the argument is
omitted, the output is written to a file named Symnew.

Description
If you omit the -date argument, Symnew is given the same date as
that recorded in the production schedule file created by schedulr. If
there is no date in production schedule file, the current system date
is used. The date in Symnew is the date that TWS will begin
executing the production plan. The ability to enter a different date
can be used to set up processing for past or future dates.

Missing Object Messages
The following messages are produced by compiler to indicate
missing scheduling objects. The messages are normally found in the
standard list file for the Jnextday job.
job. 5 ... Undefined parameter in "schedule"; not replaced.
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A parameter called for in a job stream does not exist in TWS’s
database. No substitution occurs and the parameter string itself is
used.
102 ... Job name is not found in database. Added a dummy job in FAIL state.

A job named in a job stream does not exist in TWS’s database. A
dummy job of the same name is placed in the production schedule
with a priority of zero and a state of FAIL.
103 ... Prompt name not found. Added prompt name in Symphony.

A prompt named in a job stream does not exist in TWS’s database.
A dummy prompt containing the following text is used instead:
Prompt name was not found in database. This is dummy text. Do
you want to continue (Y/N).
104 ... Resource name for cpu name not found in database. Added
resource name with 0 units.

A resource named in a job stream does not exist in TWS’s database.
A dummy resource with zero available units is used instead:
106 ... Cpu name does not exist in cpu database. Ignoring schedule name.

A job stream is defined to run on a cpu that does not exist. The job
stream is ignored and not placed in the production schedule.

Examples
Compile prodsked into Symnew:
compiler

Compile prodsked into Symnew, and enter a production date of
May 15, 1999:
compiler -date 5/15/99

Compile the file mysked into a file named mysym:
compiler -input mysked -output mysym
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The stageman
Command

The stageman command carries forward uncompleted job streams,
logs the old production plan, and installs the new production plan.
The new production plan file is named Symphony. A copy of
Symphony, named Sinfonia, is also created. Sinfonia is sent to
domain managers and agents as part of the initialization process for
the new day.

You must have build access to the Symphony file.

Synopsis
stageman -v|-u

stageman[-carryforward {yes|no|all}] [-log log-file|-nolog]
[symnew]

Arguments
-u Display the command version and exit.

-v Display command usage information and exit.

-carryforward
Define the type of carry forward as follows:

no Do not carry forward any job streams.

yes Carry forward only those uncompleted job streams
that are Carry Forward enabled.

all Ignore Carry Forward enabling in job streams, and
carry forward all uncompleted job streams.

-log Log the old production plan, and give the log file this name.
See “Log File Names” on page 84 for more information.

-nolog Do not log the old production plan.

symnew
The name of the interim production plan file created by
compiler. If omitted, the file Symnew is used.
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Description
If you omit -carryforward, the default for carry forward is
determined by the carryforward global option. See “Understanding
the Carry Forward Options” on page 38 for more information.

On UNIX only, stageman also determines which executable files
can be deleted for jobs submitted with the TWS at and batch
commands. These are jobs that were not carried forward. The files
are actually deleted when TWS starts up for the new day.

If TWS processes are still running and accessing the Symphony file,
stageman displays the message:
Unable to get exclusive access to Symphony.
Shutdown batchman and mailman.

To continue, stop TWS and rerun stageman. If stageman aborts for
any reason, you must rerun both compiler and stageman.

Users accessing the plan through the CLI during the time Symphony
is being switched are sent the message:
Current Symphony file is old. Switching to new Symphony.
Schedule mm/dd/yy (nnnn) on cpu, Symphony switched.

Some user commands executed during the switch may not execute
properly because the target jobs or job streams were not carried
forward.

Log File Names
Production plan log files are stored in the TWShome/schedlog
directory. The default naming convention used by stageman, when
the -log and -nolog arguments are omitted, is as follows:
TWShome/schedlog/Myyyymmddhhtt

where yyyymmddhhtt is the year, month, day, hour, and minute the
log file was created.

The above naming convention is coded in the Jnextday script
supplied by Tivoli. If you wish, you can change the naming
convention when you automate the production cycle. For more
information see “Automating the Production Cycle” on page 76.
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Note: Be sure to monitor the disc space in the schedlog directory
and remove older log files on a regular basis.

Job Streams Carried Forward
The carry forward option remains enabled on job streams that are
carried forward, so they may be carried forward again. If an
unsuccessful job stream is carried forward and it continues to
terminate in a state other than SUCC, it may be carried forward
indefinitely unless its Until time expires or it is cancelled.

For carry forward to work properly in a network, the master domain
manager’s production plan file, Symphony, must be updated with
the latest job stream status from its agents and subordinate domain
managers. This can be accomplished by entering the following at a
command prompt on the master domain manager prior to executing
stageman:
conman "link @"

Job Stream Names
Job streams that are carried forward are renamed as follows. If the
global option expanded version is set to no the new name is:

CFyjjjnn

where y is the last digit of the year, jjj is the Julian date, and nn is a
sequence number (00-99, AA-ZZ).

If the global option expanded version is set to yesthe new name is:

CFyjjjnnxxxxxxxxx

where y is the last digit of the year, jjj is the Julian date, nn is a
sequence number (00-99, AA-ZZ), and xxxxxxxxx is a random alpha
string.

For information about the global option expanded version, see
“Setting the Global Options” on page 33.
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Carry Forward Prompts
To retain continuity when carrying job streams forward, stageman
creates special prompts in the new production plan to account for
disconnected Follows dependencies. These prompts are issued after
the new processing day begins, when TWS checks to see if the job
or job stream is ready to launch, and are replied to as standard
prompts. The following is an example of a Carry Forward prompt:
INACT 12 (SYS1#CF9123AA) follows SYS1#SKED3 satisfied?

This prompt indicates that a job stream from the previous day was
carried forward as CF9123AA, and that it follows a job stream
named sked3 which was not carried forward. The state of the
prompt– INACT in this case– defines the state of the corresponding
Follows dependency. The possible states are:

INACT
The prompt has not been issued and the dependency is not
satisfied.

ASKED
The prompt has been issued, and is awaiting a reply. The
dependency is not satisfied.

NO Either a ″no″ reply was received, or it was determined
before Carry Forward occurred that the followed job stream
(sked3) had not completed successfully. The dependency is
not satisfied.

YES Either a ″yes″ reply was received, or it was determined
before Carry Forward occurred that the followed job stream
(sked3) had completed successfully. The dependency is
satisfied.

Examples
Carry forward all uncompleted job streams (regardless of the status
of the Carry Forward option), log the old Symphony file, and create
the new Symphony file:
DATE=vdatecalc today pic YYYYMMDDHHTTv
stageman -carryforward all -log schedlog/M$DATE
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Carry forward uncompleted job streams as defined by the
carryforward Global Option, do not log the old Symphony file,
and create a new production control file named mysym:
stageman -nolog mysym
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The logman
Command

The logman command log job statistics from a production plan log
file.

Synopsis
logman -v|-u

logman [-smooth percent] [-minmax {elapsed|cpu}] log-file

Arguments
-u Display the command version and exit.

-v Display command usage information and exit.

-smooth
Use a weighting factor that favors the most recent job run
when calculating the normal (average) run time for a job.
This is expressed as a percentage. For example, -smooth 40
will apply a weighting factor of 40% to the most recent job
run, and 60% to the existing average. The default is zero.

-minmax
Define how the minimum and maximum job run times are
logged and reported.

elapsed
Base the minimum and maximum run times on
elapsed time.

cpu Base the minimum and maximum run times on cpu
time.

log-file
The name of the production plan file or log file from which
job statistics are extracted.

Description
Jobs that have already been logged, cannot be logged again.
Attempting to do so generates a 0 jobs logged error message.
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Elapsed Time vs. CPU Time
Elapsed time, expressed in minutes, is greatly affected by system
activity. It includes both the amount of time a job made use of the
CPU and the intervals the job had to wait for other processes to
release the CPU. In periods of high system activity, for example, a
job may have a long elapsed time, and yet use no more CPU time
than in periods of low system activity. On the other hand, CPU time,
expressed in seconds, is a measure of the actual time a job made use
of the CPU, and does not include the intervals when the job was
waiting.

If you run logman with the -minmax elapsed argument, the
maximum and minimum run times and dates are based solely on a
job’s elapsed time. The values are updated only if the latest job run
has an elapsed time greater than the existing maximum, or less than
the existing minimum. The CPU times, in this case, will not
necessarily indicate their maximum and minimum extremes.

If you run logman with the -minmax CPU argument, the maximum
and minimum run times and dates are based solely on a job’s CPU
time. The values are updated only if the latest job run has a CPU
time greater than the existing maximum, or less than the existing
minimum. The elapsed times, in this case, will not necessarily
indicate their maximum and minimum extremes.

If you run logman without the -minmax argument, the elapsed time
and CPU time values are updated independently to indicate their
maximum and minimum extremes, but the run dates correspond only
to the elapsed time values. No record is kept, in this case, of the run
dates for maximum and minimum CPU times.

Examples
Log job statistics from the log file M199903170935:
logman schedlog/M199903170935

Log job statistics from the log file M$DATE based on elapsed time,
giving the most recent job runs a weight of 40% when calculating
normal (average) run times:
logman -smooth 40 -minmax elapsed schedlog/M$DATE
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The $DATE variable contains the date and time stamp used by
stageman to create the log file name. See “The stageman
Command” on page 83 for more information.
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The wmaeutil Command
Used to stop the connector server for the plan, database, and engine.
The makesec command will not run successfully on Windows NT
until the connectors are stopped.

Note: If you recreate a plan file manually (not using Jnextday), you
must stop the connectors by running the wmaeutil command and
then refresh the views in the Job Scheduling Console to view the
new production day. Otherwise, the views in the Job Scheduling
Console will remain on the prior production day.

Synopsis
wmaeutilinstance_name [-stop DB | PL | EG | *] [-version DB |
PL | EG | *] [-dbinfo DB | PL | *] [-sethome] [-gethome] [ALL
-stop]

Arguments
instance_name

The name of the TWS instance. This refers to the instance
name you entered during installation of the TWS engine, and
the installation of the connector.

-stop DB | PL | EG | *
This option can be used to shut down specified connector
server. The (*) asterisk can be used to shut down all three
connector server.

-version DB | PL | EG | *
This option is used to obtain the version number of the
connector server for the plan, database, engine and installed
on the system. The (*) asterisk can be used to obtain
versions for all three connector server at once.

-dbinfo DB | PL | *
This option is used to find out if the TWS database and plan
to which this connector is linked is expanded or unexpanded.
The (*) asterisk can be used to obtain versions for both
database and plan.
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-sethome
This option is used to set MaestroHomeDir attribute of the
TWS objects (Engine, Database, and Plan) in Tivoli’s object
database. This attribute value links connectors for the
specified object instance to the core TWS product. It takes
fully qualified name of the TWS home directory as an
arguments. Also the pathname string should be enclosed in
quotes in order to prevent any shell interpretation.

-gethome
This option does not require any arguments and it prints the
value of MaestroHomeDir attribute for the Engine, Database,
and Plan object instances as set in the object database.

ALL -stop
This option stops the connector servers for all TWS
connector instances connected to the current TWS
installation, that is, it stops the connector servers for all
instances whose MaestroHomeDir attribute matches the
home directory of the TWS current installation.

Usage Notes

Set Environment Variables
Before wmaeutil can be run successfully, you must execute
following file in order to set framework environment.

On Windows NT:
c: \> %SystemRoot%\system32\drivers\etc\Tivoli\setup_env.cmd

For UNIX:
$. /etc/Tivoli/setup_env.sh

You can update your UNIX profile to run this file, in order to avoid
having to run the command manually.

Makesec Considerations
The wmaeutil command must be run before running the makesec
command. The makesec command will not run successfully on
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Windows NT until the connectors are stopped. You should also stop
the connectors when using the makesec command on UNIX.

TWS Instance Name
If you are not sure of the instance name that was entered at
installation time, perform the following steps:

1. Source the Tivoli environment variables:
. /etc/Tivoli/setup_env.sh (for UNIX)

C:\winnt\system32\drivers\etc\Tivoli\setup_env.cmd (for NT)

2. Run the wlookup command to get the TWS instance name:
wlookup -ar MaestroEngine

maestro2 1697429415.1.596#Maestro::Engine#

where maestro2 is the TWS instance name.

Examples
Stop the connectors for the database, plan, and engine for an
instance called maestro:
wmaeutil maestro -stop *

Stop the connectors for the database for an instance called tws:
wmaeutil tws -stop DB

Stop the connector versions for the database, plan and engine for an
instance called maestro2:
wmaeutil maestro2 -version *
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Managing the Production Environment
This section provides information on changing the start of day for
TWS and creating a plan to process future or past days processing.

Choosing the TWS Start of Day
There are three common choices for the start of the production day.

¶ early morning

¶ late afternoon

¶ midnight

These are a few of the scheduling implications:

Start and Deadline Times

Start times (at keyword) specified are always in relationship to the
TWS production day start time. You may need to add “+ 1 day” to
job streams whose jobs process across production days. Also be
certain that the deadline (until keyword) time comes after the start
time.

On keyword

Production and calendar days may not be the same. If your
production day starts at 06:00 a.m. (the default setting), 05:59 a.m.
will be the last minute of the production day. A Job Stream defined
to run ON MONDAY at 05:30 will be selected on Monday and will
run on the calendar day Tuesday at 5:30 a.m.

Carryforward keyword

Placing the start of day near midnight to correspond with the
calendar day will tend to produce a large number of carried forward
Job Streams. This may increase the complexity of managing the data
center.
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Changing the Start of Day
The start of day for TWS is when the final Job Stream is run and
the TWS processes are stopped and restarted. To specify the start of
day for TWS:

1. Modify the start option in the globalopts file. This is the start
time of TWS’s processing day in 24 hour format: hhmm
(0000-2359). The default start time is 6:00 A.M.

2. Modify the start time (at keyword) of the final job stream to run
one minute before the end of day.

Creating a Plan for Future or Past Dates
You can create a plan that executes processing normally scheduled
for a future or past day of processing. This procedure effectively
recreates any specified day of processing. You may need to use this
procedure if you lost a day of processing due to an emergency.

1. Unlink and stop all workstations in your TWS network. This
stops all processing in the network.

2. Run the schedulr command with the date option to create a
prodsked file:
schedulr -date ddmmyyyy

With the date option you can specify to create a plan based on a
future or past day of processing.

3. Run the compiler command to create a Symnew file:
compiler (-date ddmmyyyy)

You can use the date option with the compiler to specify today’s
date or the date of the day you are trying to recreate. This option
may necessary if you have job streams that contain date sensitive
input parameters. The scheddate parameter is keyed off the date
specified with the compiler command.

4. Run console manager to stop TWS processes:
conman stop @!@

5. Run stageman to create the new Symphony file:
stageman
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6. Run console manager to start TWS processes:
conman start
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Report Commands

Report Commands
TWS report commands are listed in the following table.

Command Report

rep1 Report 01 - Job Details Listing

rep2 Report 02 - Prompt Listing

rep3 Report 03 - Calendar Listing

rep4a Report 04A - Parameter Listing

rep4b Report 04B - Resource Listing

rep7 Report 07 - Job History Listing

rep8 Report 08 - Job Histogram

rep11 Report 11 - Planned Production Schedule

reptr Report 09A - Planned Production Summary
Report 09B - Planned Production Detail
Report 09D - Planned Production Detail
(Long Names)

Report 10A - Actual Production Summary
Report 10B - Actual Production Detail

xref Report 12 - Cross Reference Report

Command Output
The output of the report commands is controlled by the following
variables:

6
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MAESTROLP
Specifies the destination of the output of a command. The
default is stdout. You can set it to any of the following:

filename
Write the output to a file.

> filename
UNIX only. Redirect output to a file, overwriting the
contents of the file. If the file does not exist it is
created.

>> filename
UNIX only. Redirect output to a file, appending to
the end of file. If the file does not exist it is created.

| command
UNIX only. Pipe output to a system command or
process. The system command is always executed.

|| command
UNIX only. Pipe output to a system command or
process. The system command is not executed if
there is no output.

MAESTROLPLINES
Specifies the number of lines per page. The default is 60.

MAESTROLPCOLUMNS
The number of characters per line. The default is 132.

MAESTRO_OUTPUT_STYLE
Specifies the output style for long object names. Set the
variable to LONG to use full length (long) fields for object
names.

If it is not set or it is set to anything other than LONG, and
the global option expanded version is set to yes, long
names are truncated to eight characters and a plus sign. For
example: A1234567+. If expanded version is set to no, long
names are truncated to eight characters.
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The rep1 - rep4b Commands
These commands print the following reports:

Report 01 - Job Details Listing

Report 02 - Prompt Messages Listing

Report 03 - User Calendar Listing

Report 04A - User Parameters Listing

Report 04B - Maestro Resource Listing

Synopsis
rep[x][-v|-u]

Arguments
x A number corresponding to the report. The numbers are: 1,

2, 3, 4a, or 4b.

-u Display the command version and exit.

-v Display command usage information and exit.

Examples
Print Report 03, User Calendar Listing:
rep3

Display usage information for the rep2 command:
rep2 -u

On UNIX, print two copies of report 04A, User Parameters Listing,
on printer lp2:
MAESTROLP="| lp -dlp2 -n2"
export MAESTROLP
rep4a
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The rep7 Command
This command prints Report 07-Job History Listing.

Synopsis
rep7-v|-u

rep7[-c wkstat] [-s jstream] [-j job] [-f date -t date]

Arguments
-u Display the command version and exit.

-v Display command usage information and exit.

-c wkstat
Specifies the name of the workstation on which the jobs run.
The default is all workstations.

-s jstream
Specifies the name of the job stream in which the jobs run.
The default is all job streams.

-j job Specifies the name of the job. The default is all jobs.

-f date Specifies to print job history from this date forward. Enter
the date as yyyymmdd. The default is the earliest available
date.

-t date Specifies to print job history up to this date. Enter the date
as yyyymmdd. The default is the most recent date.

Examples
Print all job history for workstation ux3:
rep7 -c ux3

Print all job history for all jobs in job stream sked25:
rep7 -s sked25

Print job history for all jobs in job stream mysked on workstation
x15 between 1/21/99 and 1/25/99:
rep7 -c x15 -s mysked -f 19990121 -t 19990125
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The rep8 Command
This command prints Report 08-Job Histogram.

Synopsis
rep8-v|-u

rep8[-f date -b time -t date -e time] [-i file] [-p ]

rep8[-b time -e time] [-i file] [-p ]

Arguments
-u Display the command version and exit.

-v Display command usage information and exit.

-f date Specifies to print job history from this date forward. Enter
the date as yyyymmdd. The default is today’s date.

-b time
Specifies to print job history from this time forward. Enter
the time as hhmm. The default is the TWS start of day time.

-t date Specifies to print job history up to this date. Enter the date
as yyyymmdd. The default is the most recent date.

-e time
Specifies to print job history up to this time. Enter the time
as hhmm. The default is the TWS start of day time.

-i file Specifies the name of the log file from which job history is
extracted. Note that log files are stored in the schedlog
directory. The default is the current plan (Symphony file).

-p Specifies to insert a page break after each run date.

Examples
Print a job histogram which includes all information in the current
plan (Symphony file):
rep8

Print a job histogram beginning at 6:00 a.m. on 1/22/99, and ending
at 5:59 a.m. on 1/26/99. This assumes that the dates requested are
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included in the specified log file. If some dates in the range are
missing, the report contains only those available in the log file. Print
the report with page breaks after each date:
rep8 -p -f 19990122 -b 0600 -t 19990126 -e 0559 -i schedlog/M199801260601

Print a job histogram, from the current plan (Symphony file),
beginning at 6:00 am, and ending at 10:00 pm:
rep8 -b 0600 -e 2200
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The rep11 Command
This command prints Report 11-Planned Production Schedule.

Synopsis
rep11-v|-u

rep11[-mmm[yy] [...]] [-c wkstat [...]] [-o file]

Arguments
-u Display the command version and exit.

-v Display command usage information and exit.

-mmm[yy]
Specifies the months to be reported. Enter the month number
as mm. The default is the current month.

You can also enter a year as yy. The default is the current
year or next year if you specify a month earlier than the
current month.

-c wkstat
Specifies workstations to be reported. The default is all
workstations.

-o file Specifies the output file. The default is the file defined by
the MAESTROLP variable. If MAESTROLP is not set, the
default is stdout.

Examples
Report on June, July, and August of 1999 for workstations main,
site1 and sagent1:
rep11 -m 0699 0799 0899 -c main site1 sagent1

Report on June, July, and August of this year for all workstations,
and direct output to the file r11out:
rep11 -m 06 07 08 -o r11out

Report on this month and year for workstation site2:
rep11 -c site2
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The
reptr Command

This command prints the following reports:

Report 09A - Planned Production Summary Report 09B - Planned
Production Detail (unexpanded databases)

Report 09D - Planned Production Detail (expanded databases)

Report 10A - Actual Production Summary Report 10B - Actual
Production Detail

Synopsis
reptr [-v|-u]

reptr-pre [-{summary| detail}] [symfile]

reptr-post [-{summary | detail}] [logfile]

Arguments
-u Display the command version and exit.

-v Display command usage information and exit.

-pre Specifies to print the pre-production reports (09A, 09B,
09D).

-post Specifies to print the post-production reports (10A, 10B).

-summary
Specifies to print the summary reports (09A, 10A). If
-summary and -detail are omitted, both sets of reports are
printed.

-detail Specifies to print the detail reports (09B, 09D, 10B). If
-summary and -detail are omitted, both sets of reports are
printed.

symfile
Specifies the name of the plan file from which reports will
be printed. The default is Symnew in the current directory.
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logfile Specifies the name of the log file from which the reports
will be printed. Note that plan log files are stored in the
schedlog directory. The default is the current plan
(Symphony file).

If the command is run with no options, all pre and post reports are
printed.

Examples
Print the pre-production detail report from the Symnew file:
reptr -pre -detail

Print the pre-production summary report from the file mysym:
reptr -pre -summary mysym

Print the post-production summary report from the log file
M199903170935:
reptr -post -summary schedlog/M199903170935

Print all pre and post-production reports.
reptr

The pre-production reports are based on information read from the
Symnew file. The post-production reports are based on information
read from the Symphony file.
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The xref Command
This command prints Report 12-Cross Reference Report.

Synopsis
xref [-V|-U]

xref [-cpuwkstat][-depends|-files|-jobs|-prompts|-resource|-
schedules|-when [...]]

Arguments
-U Display the command version and exit.

-V Display command usage information and exit.

-cpu wkstat
Specifies to print the report for the named workstation. The
@ wildcard is permitted, in which case, information from all
qualified workstations is included. The default is all
workstations.

-depends
Specifies to print a report showing the job streams and jobs
that are successors of each job.

-files Specifies to print a report showing the job streams and jobs
that are dependent on each file.

-jobs Specifies to print a report showing the job streams in which
each job is run.

-prompts
Specifies to print a report showing the job streams and jobs
that are dependent on each prompt.

-resource
Specifies to print a report showing the job streams and jobs
that are dependent on each resource.

-schedules
Specifies to print a report showing the job streams and jobs
that are successors of each job stream.
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-when Specifies to print a report showing job stream Include and
Exclude dates.

If the command is run with no options, all workstations and all
options are selected.

Examples
Print a report for all workstations, showing all cross-reference
information:
xref

Print a report for all workstations. Include cross-reference
information about all successor dependencies:
xref -cpu @ -depends -schedules

Report Commands

107Tivoli Workload Scheduler User’s Guide

6.
R

ep
o

rt
C

o
m

m
an

d
s



Report Commands

108 Version 7.0



TWS Database Tasks

Using Database Lists
Database lists are used to display objects in the TWS database.
When you create a list, you give it a name and specify filtering
criteria. When you run a list, it displays a filtered table of objects in
the database. Each list you create is represented by an icon in the
tree view of the Job Scheduling Console.

You can create lists in the TWS branch or you can create groups
below the TWS branch to organize your lists. Tivoli supplies a basic
set of lists in a group named Default Database Lists.

Creating a Group for Database Lists
To create a group for database lists, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Click the Create a Group of Listsbutton on the toolbar or
right-click the TWS controller icon and select Create Group...
from the pop-up menu.

To create a group in an existing group, select the group and click
the Create a Group of Lists button on the toolbar or right-click
the existing group icon and select Create Group... from the
pop-up menu.

This displays the Properties - Group of Lists window.
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3. In the Properties - Group of List window, fill in the text box as
follows:

Name Specifies the name of the list group. The name can
contain up to 40 characters, starting with a letter.

4. Click the OK button to close the window and save the new
group. An icon is created for the new group in the tree view of
the Job Scheduling Console.

Click the Cancel button to close the window without saving the
new group.

Creating a Database List of Workstations
To create a list to display workstations in the database, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.

3. Click the List Workstations in Databasebutton on the toolbar.
Alternatively, you can right-click the TWS controller icon or
group icon and choose Create Database List > Workstations
from the pop-up menu.

This displays the Properties - Database Workstation List window.

Figure 4. Properties - Group of Lists window.
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4. Type a name for the list in the Name text box.

5. To have the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default periodic
refresh settings.

6. To filter the list results, enter a workstation name in the
Workstation Name text box. The workstation name can contain
the following wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Figure 5. Properties - Database Workstation List window.
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Creating a Database List of Workstation Classes
To create a list to display workstation classes in the database, follow
these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.

3. Right-click the TWS controller icon or group icon and choose
Create Database List > Workstation Classes from the pop-up
menu.

This displays the Properties - Workstation Class List window.

4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default refresh
settings from the TWS properties.

6. To filter the list results, enter a workstation class name in the
Workstation Class Name text box. The workstation class name
can contain the following wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Figure 6. Properties - Workstation Class List window.
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Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Creating a Database List of Domains
To create a list to display domains in the database, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.

3. Right-click the TWS controller icon or group icon and choose
Create Database List > Domains from the pop-up menu.

This displays the Properties - Domain List window.

Figure 7. Properties - Domain List window.
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4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default refresh
settings from the TWS properties.

6. To filter the list results, enter a domain name in the Domain
Name text box. The domain name can contain the following
wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Creating a Database List of Job Streams
To create a list to display job streams in the database, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.
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3. Click the List Job Streams icon on the toolbar. Alternatively,
you can right-click the TWS controller icon or group icon and
choose Create Database List > Job Stream... from the pop-up
menu.

This displays the Properties - Job Stream List window.

4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default refresh
settings from the TWS properties.

6. To filter the list results, enter a job stream name in the Job
Stream Name text box and a workstation name in the
Workstation Name text box. The job stream name and
workstation name can contain the following wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

Figure 8. Properties - Job Stream List window.
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¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Creating a Database List of Job Definitions
To create a list to display jobs in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.

3. Click the List Job Definitions icon on the toolbar. Alternatively,
you can right-click the TWS controller icon or group icon and
choose Create Database List > Job... from the pop-up menu.
This displays the Properties - Job List window.

4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default refresh
settings from the TWS properties.

Figure 9. Properties - Job List window.
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6. To filter the list results, enter a job name in the Job Name text
box and a workstation name in the Workstation Name text box.
The job name and workstation name can contain the following
wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Creating a Database List of Resources
To create a list to display resources in the database, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.

3. Click the List Resources in Database icon on the toolbar.
Alternatively, you can right-click the TWS controller icon or
group icon and choose Create Database List > Resources from
the pop-up menu.

This displays the Properties - Database Resource List window.
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4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default refresh
settings from the TWS properties.

6. To filter the list results, enter a resource name in the Resource
Name text box and a workstation name in the Workstation
Name text box. The resource name and workstation name can
contain the following wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Figure 10. Properties - Database Resource List window.
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Creating a Database List of Prompts
To create a list to display prompts in the database, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.

3. Right-click the TWS controller icon or group icon and choose
Create Database List > Prompts from the pop-up menu. This
displays the Properties - Prompt List window.

4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default refresh
settings from the TWS properties.

6. To filter the list results, enter a prompt name in the Prompt
Name text box. The prompt name can contain the following
wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Figure 11. Properties - Prompt List window.
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Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Creating a Database List of Parameters
To create a list to display parameters in the database, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.

3. Right-click the TWS controller icon or group icon and choose
Create Database List > Parameters from the pop-up menu.

This displays the Properties - Parameter List window.

Figure 12. Properties - Parameter List window.
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4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default refresh
settings from the TWS properties.

6. To filter the list results, enter a parameter name in the
Parameter Name text box. The parameter name can contain the
following wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Creating a Database List of Users
To create a list to display users in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.

3. Right-click the TWS controller icon or group icon and choose
Create Database List > Users from the pop-up menu.
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This displays the Properties - User List window.

4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default refresh
settings from the TWS properties.

6. To filter the list results, enter a user name in the User Name text
box. The user name can contain the following wildcard
characters:

* Specifies one or more characters.

? Specifies one character.

Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Figure 13. Properties - User List window.
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Creating a Database List of Calendars
To create a list to display calendars in the database, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. To create the list in the TWS branch, select the TWS controller
icon. To create the list in a group, expand the TWS branch and
select the group icon. For information about creating groups, see
“Creating a Group for Database Lists” on page 109.

3. Right-click the TWS controller icon or group icon and choose
Create Database List > Calendars from the pop-up menu.

This displays the Properties - Calendar List window.

4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and enter a refresh interval in
seconds in the Period (secs) text box.

Click the Apply defaults button to enter the default refresh
settings from the TWS properties.

6. To filter the list results, enter a calendar name in the Calendar
Name text box. The calendar name can contain the following
wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Figure 14. Properties - Calendar List window.
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Leaving a text box blank results in an unfiltered list.

7. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the list and close the window. A
new icon is created for the list in the tree view of the Job
Scheduling Console.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the list.

Modifying the Properties of a Database List
To modify the properties of a database list, do the following:

1. Select the list icon in the tree view of the Job Scheduling
Console.

2. Right-click the list icon and select Properties from the pop-up
menu.This displays the properties window for the list.

3. Make your modification in the properties window.

4. When you have finished making your entries, do one of the
following:

¶ Click the OK button to save the changes and to close the
window.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

¶ Click the Cancel button to close the window without running
or saving the changes.

Deleting a Database List
To delete a database list, do the following:

1. Select the list icon in the tree view of the Job Scheduling
Console.
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2. Click the Delete icon in the toolbar or right-click the list icon
and select Delete from the pop-up menu.

3. When asked to confirm the operation, click the Yes button to
delete the list or click the Cancel button to cancel the delete
operation.

Detaching a Database List Display
Detaching a list frees the right-panel of the Job Scheduling Console
to display other objects. You can detach multiple lists to view several
objects simultaneously. To detach a database list display, do the
following:

1. Select the list icon in the tree view of the Job Scheduling
Console.

2. Right-click the list icon and select Detach View from the pop-up
menu. This displays the separate window for the list display.

3. To re-attach a list display, either close the detached window or
right-click the list icon in the tree view and select Attach View
from the pop-up menu.

Finding Objects in the Database
Search tools are provided in the Job Scheduling Console to help you
find objects in the database. The availability of a search tool is
indicated by an ellipsis located next to the text box where you enter
an object name. In the following example of the Properties -
Resource in Database window, the Workstation text box provides a
search tool.

Figure 15. Properties - Resource in Database window.
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Clicking the ellipsis button opens a Find window.

To use the Find window, do the following:

1. Type search arguments in the available text boxes. The
arguments can contain the following wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving a text box blank results in an unfiltered list of objects.

2. Select other filter criteria using radio buttons and checkbox.

3. Click the Start button. The results of the search are listed in the
lower part of the Find window.

4. Select an object in the list and do one of the following:

¶ Double-click the object in the list or click the OK button to
insert the name of the object in the text box on the parent
window and close the Find window.

¶ Click the Apply button to insert the name of the object in
the text box on the parent window. The Find window
remains open to permit you to select other objects from the
list.

Figure 16. Find Workstation window.
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¶ Click the Cancel button to close the Find window without
inserting an object name.

Managing Job Definitions in the Database
A job is a unit of work that is part of a job stream processed at a
workstation. It usually includes all necessary computer programs,
links, files, and instructions to the operating system.

Creating a Job Definition in the Database
You create jobs in the database using the Properties - Job Definition
window. To create a new job, follow these steps:

1. In the tree view of the Job Scheduling Console, click the TWS
controller icon.

2. Click the New Job Definition button on the toolbar or
right-click the TWS controller icon and select New Job
Definition from the pop-up menu. This opens the Select a task
type window.

3. In the Select a task type window, select a Task Type from the
drop-down list. Once a task type is defined for a job it cannot be
changed. The following are the task types:

Unix Script
Specifies that the job is an executable file on a UNIX
computer.

Unix Command
Specifies that the job is a UNIX command.

Figure 17. Select a Task Type window.
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NT Script
Specifies that the job is an executable file on a Windows
NT computer.

NT Command
Specifies that the job is a Windows NT command.

Workstation Class Script
Specifies that the job is an executable file that runs on a
workstation class.

Workstation Class Command
Specifies that the job is a command that runs on a
workstation class.

Extended Agent
Specifies that the job is associated with an Extended
Agent workstation.

MPE Job File
Specifies that the job is an executable file on an MPE
computer.

MPE User Job
Specifies that the job is streamed by an MPE user and is
managed by TWS.

SAP Specifies that the job is an SAP job that runs on a TWS
Extended Agent for SAP. The SAP task type is only
displayed if the Extended Agent for SAP has been
installed.

4. Click the OK button to proceed or click the Cancel button to
cancel the operation. Clicking the OK button opens the General
view of the Properties - Job Definition window.
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5. In the General view of the Properties - Job Definition window,
fill in the text boxes and select options as follows:

Job Name
Specify the name of the job. The name must start with a
letter, and can contain alphanumeric characters, dashes
and underscores. For non-expanded databases, it can
contain up to eight characters. For expanded databases, it
can contain up to 40 characters.

Workstation
Specify the name of the workstation or workstation class
on which the job runs. You can type a name directly or
you can click the Find button and select a workstation or
workstation class from a list. If you specify a workstation
class, it must match the workstation class of any job
stream in which the job will be included. For information
about using the Find button, refer to “Finding Objects in
the Database” on page 125.

Description
Specify a description of the job. The description can
contain up to 64 characters.

Figure 18. Properties - Job Definition: General window.
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Is Interactive
For Windows NT jobs only. Specify this option to
indicate that the job runs interactively on the Windows
NT desktop.

Login

Specify the user name under which the job runs. The
name can contain up to 47 characters. If the name
contains special characters it must be enclosed in quotes
(“). Specify a user that can log on to the workstation on
which the job runs. For Windows NT jobs, the user must
also be defined in the database. See “Managing Users in
the Database” on page 225 for more information.

To include a parameter in the name, do the following:

¶ Place the cursor in the Login where you want to
insert the parameter and click the Add Parameter
button.

¶ This displays the Find Parameters window.

¶ Enter a parameter name in the Find text box. The
name can contain wildcard characters.

¶ Click the Start button to display a list of parameter
names.

¶ Select a parameter name in the list and do one of the
following:

v Click the OK button or double-click the
parameter in the list to insert the parameter name
in the Login text box of the Properties - Job
Definition window and close the Find Parameters
window.

v Click the Apply button to insert the parameter
name in the Login text box of the Properties -
Job Definition window and keep the Find
Parameters window open.
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v Click the Cancel button to close the Find
Parameters window without inserting a parameter
name.

A parameter can be used for all or part of the text box
and multiple parameters are permitted.

Recovery Options
Specify the recovery options for the job.

Action
Specify the action to be taken if the job ends
abnormally (abends). Select one of the following.
The default it Stop.

Stop If the job abends, do not continue with
the next job.

Continue
If the job abends, continue with the next
job.

Rerun If the job abends, rerun the job.

Prompt
Specify the text of a recovery prompt, enclosed
in quotes, to be displayed if the job abends. The
text can contain up to 64 characters. The
recovery prompt is a local prompt and is
responded to using the Job Scheduling Console.

Job

Specify the name of a recovery job to run if the
parent job abends. Click the Find button and
select a job from a list. Recovery jobs are run
only once for each abended instance of the parent
job. For information about using the Find button,
refer to “Finding Objects in the Database” on
page 125.

Workstation
Specify the name of the workstation on which
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the recovery job runs. The name is entered
automatically when you select a recovery job.

Not all jobs are eligible to have recovery jobs
run on a different workstation. Follow these
guidelines:

¶ If either workstation is an extended agent, it
must be hosted by a domain manager or a
fault-tolerant agent that runs in Full Status
mode.

¶ The recovery job’s workstation must be in
the same domain as the parent job’s
workstation.

¶ If the recovery job’s workstation is a
fault-tolerant agent, it must run in Full
Status mode.

6. Select Task in the left panel of the Properties - Job Definition
window. This displays the Task view.

7. The Task view is different for each task type.

Figure 19. Properties - Job Definition: Task window.
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For task types Unix Script, NT Script, or Workstation Class
Script fill in the text box as follows:

Script

Specify the name of the file the job executes. Enter the
file name and any options and arguments. For
non-expanded databases, the text box can contain up to
255 characters. For expanded databases, it can contain up
to 4095 characters.

For Windows NT jobs, include the file extensions.
Universal Naming Convention (UNC) names are
permitted. Do not specify files on mapped drives.

If the file name contains spaces, enter the name in
another file that does not have spaces in its name and use
the second file’s name in this text box.

To include a parameter in the Script text box, do the
following:

¶ Place the cursor in the Script text box where you
want to insert the parameter and click the Add
Parameter button.

¶ This displays the Find Parameters window.

¶ Enter a parameter name in the Find text box. The
name can contain wildcard characters.

¶ Click the Start button to display a list of parameter
names.

¶ Select a parameter name in the list and do one of the
following:

v Click the OK button or double-click the
parameter in the list to insert the parameter name
in the Script text box of the Properties - Job
Definition window and close the Find Parameters
window.

v Click the Apply button to insert the parameter
name in the Script text box of the Properties -
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Job Definition window and keep the Find
Parameters window open.

v Click the Cancel button to close the Find
Parameters window without inserting a parameter
name.

A parameter can be used for all or part of the text box
and multiple parameters are permitted.

For task types Unix Command, NT Command, or Workstation
Class Command fill in the text box as follows:

Command

Specify the name of the command the job executes.
Enter the command name and any options and
arguments. For non-expanded databases, the text box can
contain up to 255 characters. For expanded databases, it
can contain up to 4095 characters. Commands are
executed directly and the jobmanrc standard
configuration script is not executed.

To include a parameter in the Command text box, do the
following:

¶ Place the cursor in the Command text box where
you want to insert the parameter and click the Add
Parameter button.

¶ Enter a parameter name in the Find text box. The
name can contain wildcard characters.

¶ Click the Start button to display a list of parameter
names.

¶ Select a parameter name in the list and do one of the
following:

v Click the OK button or double-click the
parameter in the list to insert the parameter name
in the Command text box of the Properties - Job
Definition window and close the Find Parameters
window.
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v Click the Apply button to insert the parameter
name in the Command text box of the Properties
- Job Definition window and keep the Find
Parameters window open.

v Click the Cancel button to close the Find
Parameters window without inserting a parameter
name.

A parameter can be used for all or part of the text box
and multiple parameters are permitted.

For task type MPE Job File, fill in the text box as follows:

Job File

Specify the name of the MPE file the job executes. For
example, JFILE4.JCL.CORP.

For task type MPE User Job, fill in the text box as follows:

User Job

Specify the name from the JOB card of the MPE job. If
the TWS job name does not match the MPE job card
name or you want to use skeleton jobs, click the override
userjob checkbox and enter the name or wildcard. For
example, $USERJOB=UJOB1 or $USERJOB=UJ@.

For task type SAP Job, refer to the TWS SAP/R3 Extended Agent
User Guide for information about defining the task.

For task type Extended Agent, refer to the specific user guide
for the Extended Agent you are working with for more
information.

8. When you are finished in the Properties - Job Definition window,
do one of the following:

¶ Click the OK button to close the Properties - Job Definition
window and save the new job in the database.
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¶ Click the Cancel button to close the Properties - Job
Definition window without saving the job in the database.

Displaying a List of Job Definitions in the Database
To display a list of jobs in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below TWS until you see the icon for the
job list you want to run. See “Creating a Database List of Job
Definitions” on page 116 for information about creating job lists.

3. Select the job list icon.

4. Click the Load List button on the toolbar or right-click the job
list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console.

The following are descriptions of the column headings.

Figure 20. Job Definition list window.
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Workstation
Specifies the name of the workstation on which the job
runs.

Name Specifies the name of the job.

Task Type
Specifies the task type of the job. The following are the
task types:

Unix Script
Specifies that the job is an executable file on a
UNIX computer.

Unix Command
Specifies that the job is a UNIX command.

NT Script
Specifies that the job is an executable file on a
Windows NT computer.

NT Command
Specifies that the job is a Windows NT
command.

Workstation Class Script
Specifies that the job is an executable file on a
specific class of workstations.

Workstation Class Command
Specifies that the job is a command on a specific
class of workstations.

Extended Agent
Specifies that the job is an Extended Agent job.
Refer to the specific user guide for the Extended
Agent you are using for more information.

MPE Job File
Specifies that the job is an executable file on an
MPE computer.

MPE User Job
Specifies that the job is streamed by an MPE
user and is managed by TWS.
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SAP Job
Specifies that the job is an SAP job. You must
install the TWS Extended Agent for SAP
software to use SAP jobs.

Creator
Specifies the name of the user who created the job in the
database.

Last Runtime
Specifies the duration in minutes of the last run of the
job.

Displaying a Job Definition in the Database
To display a job in the database, follow these steps:

1. Run a list of jobs that contains the job you want to display. See
“Displaying a List of Job Definitions in the Database” on
page 136 for more information.

2. In the list results, double-click on the job you want to display or
right-click the job and choose Properties from the pop-up menu.

This displays the job in the Properties - Job Definition window.
For information about the Properties - Job Definition window,
see “Creating a Job Definition in the Database” on page 127.

3. Click the OK or the Cancel button to close the Properties - Job
Definition window.

Displaying Job Definition Details in the Database
To display job details in the database, follow these steps:

1. Run a list of jobs that contains the job you want to display. See
“Displaying a List of Job Definitions in the Database” on
page 136 for more information.

2. In the list results, right-click the job you want to display and
choose Job Details from the pop-up menu.

This displays the Details for Job window.
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The following are descriptions of the fields.

Job Information
Displays the job’s logon information.

Logon Displays the user logon for the job.

Description
Displays the description of the job.

Script File
Displays the name of the job’s script file.

Recovery Information
Displays the job’s recovery information.

Option
Displays the job’s recovery option. It can be
Stop, Continue, or Rerun.

Job Displays the name of the job’s recovery job.

Figure 21. Details for Job window.
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Prompt
Displays the job’s recovery prompt.

Job Run Summary
Displays information about the job from the most recent
production plan.

Total Runs
Displays the total number of times the job has
run.

Aborted Runs
Displays the total number of abended runs of the
job.

Successful Runs
Displays the total number of successful runs of
the job.

Total CpuTime
Displays the total CPU time of the job.

Total Elapsed Time
Displays the total elapsed time of the job.

Normal Elapsed Time
Displays the elapse time for previous runs of the
job.

Run Time History
Displays the job’s run time history for the last run, the
minimum run, and the maximum run.

Run Date
Displays the date and time of the run.

CpuTime
The the CPU time of the run.

Elapsed Time
Displays the elapsed time of the run.

3. Click the OK button to close the Details for Job window.
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Modifying a Job Definition in the Database
To modify a job in the database, follow these steps:

1. Run a list of jobs that contains the job you want to modify. See
“Displaying a List of Job Definitions in the Database” on
page 136 for more information.

2. In the list results, double-click on the job you want to modify or
right-click the job and choose Properties from the pop-up menu.
This displays the job in the Properties - Job Definition window.

Note that you cannot modify the name of a job once it has been
created. You can however use the create another command to
save the job with a new name.

3. Make your changes in the Properties - Job Definition window.
For information about the Properties - Job Definition window,
see “Creating a Job Definition in the Database” on page 127.

4. When you are finished in the Properties - Job Definition window,
do one of the following:

¶ Click the OK button to save the job in the database and
close the Properties - Job Definition window.

¶ Click the Cancel button to close the Properties - Job
Definition window without saving the job in the database.

Deleting Job Definitions in the Database
To delete jobs in the database, follow these steps:

1. Run a list of jobs that contains the job you want to delete. See
“Displaying a List of Job Definitions in the Database” on
page 136 for more information.

2. In the list results, do one of the following:

¶ To delete one job, right-click the job.

¶ To delete multiple jobs in a range, hold down the Shift key,
click the first and last jobs in the range, then right-click one
of the selected jobs.
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¶ To delete multiple jobs that are not in a range, hold down the
Ctrl key, click on each job, then right-click one of the
selected jobs.

3. Choose Delete from the pop-up menu. A message is displayed
for each job asking for confirmation.

4. Click the OK button to delete the job in the database or click the
Cancel button to cancel the delete operation.

Managing Job Streams in the Database
Job streams are created and modified using the Job Stream Editor
and the Properties - Job Stream window. The Job Stream Editor is
used to work with the jobs and follows dependencies between the
jobs, as well as the run cycles of the job stream. The Properties -
Job Stream window is used to specify time restrictions, resource
dependencies, file dependencies, and prompt dependencies at the job
stream level.

Using the Job Stream Editor
Use the Job Stream Editor to create and modify job streams in the
database. Job stream management functions are divided between
three views, Graph, Timeline, and Run Cycle. Each view contains
a set of menu and toolbar functions.

Graph View
The Graph view provides a graphical display of the jobs in a job
stream. Jobs and external job dependencies are represented by icons.
Dependencies between jobs are represented as arrows pointing to the
successor jobs. Use this view to add and delete jobs and specify
dependencies between jobs.
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The toolbar in the Graph view of the Job Stream Editor contains the
following buttons.

Properties Click this button to display the Job Stream Properties
window.

Save Click this button to save the job stream in the database.

Delete Click this button to delete the selected job.

Undo Delete Click this button to undo the previous Delete
operation.

Copy Click this button to copy the selected job to the clipboard.

Paste Click this button to add the job on the clipboard to the job
stream.

Figure 22. Job Stream Editor: Graph view window.
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Select Click this button to change the mouse pointer to a selection
arrow.

Add Job Definition Click this button to add a job to the job
stream. An icon is added to represent the job.

Add Dependency on Internetwork Click this button to add an
icon to represent an internetwork dependency.

Add Dependency on External Job Stream Click this button to
add an icon to represent an external job stream dependency.

Add Dependency on External Job Click this button to add an icon
to represent an external job dependency.

Add Link Click this button to add a dependency between jobs in
the job stream.

Graph Click this button to display the Graph view.

Timeline Click this button to display the Timeline view.

Run Cycle Click this button to display the Run Cycle view.

Timeline View
The Timeline view provides a tabular and timeline display of the
time restriction properties of the job stream and its jobs. Use this
view to display and adjust time restriction properties.

The window is divided into four panels. The job stream is displayed
in the upper panel and its jobs are displayed in the lower panel. Use
the borders and the arrows on the borders to adjust the sizes of the
panels. Use the arrows at the top of the timeline panel to move the
view in one hour and one day increments.
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Time intervals are shown in the right panel. A dark blue bar
represents the time restrictions for a job or job stream. A light blue
bar represents the expected duration, based on past run times. A
black segment at the end of a timeline represents the deadline time
(see“Deadline” below “Specifying Job Stream Properties” on page
148). Where the duration of the job exceeds the deadline time, the
blue bar becomes red. The left panel lists the start, deadline, and
duration times for each timeline shown in the right panel.

Dragging a line, or the end of a line, adjusts the start and deadline
times of the job stream or a job. Double-clicking the job or job
stream name opens time properties windows. You can edit the time
properties of the job or job stream from these windows.

The toolbar in the Timeline view of the Job Stream Editor contains
the following buttons.

Properties Click this button to display the Job Stream Properties
window.

Figure 23. Job Stream Editor: Timeline view window.
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Save Click this button to save the job stream in the database.

Go to Day... Click this button to move the timeline display to a day
offset from the schedule date of the plan (Day 0).

Go to First Click this button to move the timeline display to the
start time and day offset of the job stream or its earliest job,
whichever is the first to occur.

Graph Click this button to display the Graph view.

Timeline Click this button to display the Timeline view.

Run Cycle Click this button to display the Run Cycle view.

Run Cycle View
The Run Cycle view shows the run cycles of the job stream in a
calendar format. Use this view to add and modify the run cycles of
the job stream.

The window is divided into two panels. The names of the run cycles
for the job stream are listed in the left panel and a calendar showing
included and excluded days is displayed in the right panel. Use the
border and the arrows on the border to adjust the sizes of the panels.

Use the tabs above the calendar to select the Monthly or Yearly
view and use the arrows above and below the calendar to change the
month or year of the calendar.
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The toolbar in the Run Cycles view of the Job Stream Editor
contains the following buttons.

Properties Click this button to display the Job Stream Properties
window.

Save Click this button to save the job stream in the database.

Select a Run Cycle Click this button to change the mouse pointer
to a selection arrow.

Delete Click this button to delete the selected run cycle.

Include Simple Run-Cycle Click this button to add a run cycle of
included days.

Exclude Simple Run-Cycle Click this button to add a run cycle of
excluded days.

Figure 24. Job Stream Editor: Run Cycle view window.
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Include Weekly Run-Cycle Click this button to add a run cycle of
included days of the week.

Exclude Weekly Run-Cycle Click this button to add a run cycle of
excluded days of the week.

Include Calendar Run-Cycle Click this button to add a run cycle
of included days based on a calendar.

Exclude Calendar Run-Cycle Click this button to add a run cycle
of excluded days based on a calendar.

Graph Click this button to display the Graph view.

Timeline Click this button to display the Timeline view.

Run Cycle Click this button to display the Run Cycle view.

Creating a Job Stream in the Database
You create job streams in the database using the Job Stream Editor.
To create a new job stream, follow these steps:

1. In the tree view of the Job Scheduling Console, click the TWS
controller icon.

2. Click the New Job Stream button on the toolbar or right-click
the TWS controller icon and select New Job Stream from the
pop-up menu.

This displays the Job Stream Editor and the Job Stream
Properties window.

Specifying Job Stream Properties
Job stream properties are specified in the Job Stream Properties
window of the Job Stream Editor. There are five groups of job
stream properties:

¶ General
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¶ Time Restrictions

¶ Resources

¶ Files

¶ Prompts

The Job Stream Properties window opens automatically when you
create a new job stream. If the Job Stream Properties window is not
displayed, select Properties... from the File menu of the Job Stream
Editor.

To specify job stream properties, do the following:

1. Click General in the left panel of the Job Stream Properties
window. This displays the General view.

2. In the General view of the Job Stream Properties window, fill
in the text boxes and select options as follows:

Name Specify the name of the job stream. The name must
start with a letter, and can contain alphanumeric
characters and dashes. For non-expanded databases, it
can contain up to eight characters. For expanded
databases, it can contain up to 16 characters. The name
of a job stream cannot be changed once is has been

Figure 25. Properties - Job Stream: General window.
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saved. However, you can use the create another
command to save the job stream with another name.

Workstation
Specify the name of the workstation or workstation
class on which the job stream is launched. You can type
a name directly or you can click the Find button and
select a workstation or workstation class from a list. If
you specify a workstation class, it must match the
workstation class of any jobs or resources used in the
job stream. For information about using the Find button,
refer to “Finding Objects in the Database” on page 125.

Description
Specify a description of the job stream.

Priority
Specify the priority of the job stream. Select a priority
value from the drop-down list or click one of the
following buttons:

Hold Sets the priority to 0.

High Sets the priority to 100.

Go Sets the priority to 101.

Possible priority values are 0 through 101, where 101 is
the highest priority. A priority value of zero prevents the
job stream from launching. In the case of High and Go,
all jobs in the job stream are given the priority. High
and Go jobs are launched as soon as their dependencies
are satisfied, overriding the workstation’s job limit, but
not overriding the job stream’s job limit or the
workstation’s job fence.

Limit Specify the number of jobs that can be running at the
same time in the schedule. Select a job limit value from
the drop-down list. Possible values are 0 through 1024.
If you specify a job limit of 0, no jobs are launched in
the job stream.
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On Request
Check this to specify that the job stream is selected for
execution by request. If you select On Request and
specify run cycles for the job stream, the On request
flag is ignored and the job stream will run according to
the run cycle. Normally, these job stream must be
submitted into the plan by the user or specifically
requested when schedulr is run. For more information,
see “The schedulr Command” on page 79.

Carry Forward
Check this to specify that the job stream is eligible to
be carried forward to the next day’s production plan if it
is not completed before the end of the current day’s
production day. Job streams that are carried forward
retain the carryforward option, and therefore, can be
carried forward again. You can control the number of
days a job stream is carried forward by specifying a
deadline time (UNTIL keyword) plus x number of days.

3. To specify time restrictions for a job stream, click Time
Restrictions in the left panel of the Job Stream Properties
window. This displays the Time Restrictions view.

4. In the Time Restrictions view of the Job Stream Properties
window, fill in the text boxes and select options as follows:

Figure 26. Properties - Job Stream: Time Restrictions window.
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Start Specify the earliest time the job stream will be
launched. The job stream will not be launched before
this time. Make your selections as follows:

Specify time
Specify this option to enable the entry of a start
time.

At Specify a start time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Delay for
Specify the number of days to offset the start
time from the day the job stream is selected for
inclusion in the production plan.

Deadline
Specify the latest time the job stream will be launched.
The job stream will not be launched after this time.
Make your selections as follows:

Specify time
Specify this option to enable the entry of a
deadline time.

At Specify a deadline time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Note: The Deadline time must be later than the
Start Time.

Delay for
Specify the number of days to offset the
deadline time from the day the job stream is
selected for inclusion in the production plan.

Time Zone
Specify the time zone in which the job stream runs. All
time values specified are in this time zone. Select a
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time zone from the drop-down list. For information
about the time zone feature, see “Time Zones” on
page 21. If a time zone is not specified for the job
stream, all time values specified in the Time
Restrictions properties window are in the time zone of
the workstation on which the job stream is launched.

Note: Time Restrictions can also be set in the Timeline View
of the Job Stream Editor. See “Specifying Time
Restrictions in the Timeline View” on page 182 for more
information.

5. To specify resource dependencies for a job stream, click
Resources in the left panel of the Job Stream Properties
window. This displays the Resources view.

6. To add a resource dependency for the job stream, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of resource dependencies.

b. Double-click the text box in the Resources column and
click the Find button to locate and insert a resource name.
For information about using the Find window, see “Finding
Objects in the Database” on page 125.

Figure 27. Properties - Job Stream: Resources window.
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c. Double-click the text box in the Quantity column and enter
the number of resource units required by the job stream. The
default is one. Resources can be defined with up to 1024
units, but they can only be allocated in increments of 32.
For example, to allocate 1024 units of a resource to a job
stream or job you would need to create 32 entries for the
resource with 32 units each.

7. To remove a resource dependency for the job stream, select the
resource row in the list and click the Delete from Table (X)
button.

8. To specify file dependencies for the job stream, click Files in
the left panel of the Job Stream Properties window. This
displays the Files view.

9. To add a file dependency for the job stream, do the following:

a. Click the Add Row (+) button. This creates a new row in
the list of file dependencies.

b. Double-click the text box in the Workstation column and
click the Find button to locate and insert the name of a
workstation or workstation class. For information about
using the Find window, see “Finding Objects in the
Database” on page 125.

Figure 28. Properties - Job Stream: Files window.
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c. Double-click the text box in the Filename column and type
in a file name. Alternatively, click the Find button to locate
and insert a file name. For information about using the
select window, see “Finding Objects in the Database” on
page 125.

d. Double-click the text box in the Qualifiers column and
enter the test conditions for the file dependency. On UNIX,
the valid qualifiers are the same as UNIX test command
conditions. For more information, refer to your UNIX
system documentation.

On Windows NT, only the following qualifiers are valid:

-d %p True if the file exists and is a directory.

-e %p True if the file exists.

-f %p True if the file exists and is a regular file.

-r %p True if the file exists and is readable.

-s %p True if the file exists and it’s size is greater
than zero.

-w %p True if the file exists and is writable.

On both UNIX and Windows NT, the expression %p,
inserts the file name.

Entering notempty is the same as entering -s %p. If no
qualifier is specified, the default is -f %p.

10. To remove a file dependency for the job stream, select the file
row in the list and click the Delete from Table (X) button.

11. To specify prompt dependencies for the job stream, click
Prompts in the left panel of the Job Stream Properties window.
This displays the Prompts view.
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12. For an ad hoc prompt dependency, select Ad Hoc Prompt from
the drop-down list. For a predefined prompt dependency, select
Predefined Prompt from the drop-down list.

13. To add a prompt dependency for the job stream, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of prompt dependencies.

b. For a pre-defined prompt, double-click the text box in the
Name column and click the Find button to locate and insert
the name of a prompt. For information about using the Find
window, see “Finding Objects in the Database” on page 125.

c. For an ad hoc prompt, double-click the text box in the Text
column and type in the text of the prompt. The default
behavior of a prompt is to display a message and wait for a
reply. If the string begins with a colon (:), the message is
displayed but no reply is necessary. If the string begins with
an exclamation mark (!), the message is not displayed but it
requires a reply. You can include backslash n (\n) within the
text for new lines.

You can include one or more TWS parameters as part or all
of the text string. To use a parameter, place its name
between carets (^).

Figure 29. Properties - Job Stream: Prompts window.
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14. To remove a prompt dependency for the job stream, select the
prompt row in the list and click the Delete from Table (X)
button.

15. When you have finished specifying job stream properties, do
one of the following:

¶ Click the OK button to keep the properties you have
selected and close the Job Stream Properties window.

¶ Click the Cancel button to ignore the properties you have
selected and close the Job Stream Properties window.

Adding External Dependencies for a Job Stream
Job streams can be dependent on the successful execution of other
job streams, jobs in other job streams, and jobs in other TWS
networks (internetwork jobs). These external dependencies are also
called predecessors.

To add external dependencies for a job stream, do the following:

1. Open the job stream in the Job Stream Editor.

2. Select External Dependencies from the File menu. This displays
the Job Stream External Dependencies window.

3. To add an external job stream dependency, do the following:

a. Select External Job Stream from the drop-down menu at the
top of the window.

b. Click the Add Row (+) button.

Figure 30. Job Stream External Dependencies window.

Managing Job Streams in the Database

157Tivoli Workload Scheduler User’s Guide

7.
T

W
S

D
atab

ase
Tasks



c. Double-click in the Job Stream Name column of the new
row.

d. Click the find (...) part of the Job Stream Name column and
use the Find Job Stream window to select a job stream. For
information about using the Find window, see “Finding
Objects in the Database” on page 125.

e. Click the OK button to add the external job stream
dependency and close the window or click the Cancel button
to close the window without adding the dependency.

4. To add an internetwork dependency, do the following:

a. Select Internetwork from the drop-down menu at the top of
the window.

b. Click the Add Row (+) button.

c. Double-click in the Network Agent column of the new row.

d. Click the find (...) part of the Network Agent column and use
the Find Workstation window to select the name of the
network agent. Internetwork dependencies require that a
Network Agent is configured to communicate with the
external TWS network. For information about configuring a
Network Agent, refer to the Tivoli Workload Scheduler
Reference Guide.

e. Double-click the Dependency column of the new row and
enter a freeform dependency or the job/job stream
predecessor in the form workstation#jobstream.job.

f. Click the OK button to add the internetwork dependency and
close the window or click the Cancel button to close the
window without adding the dependency.

5. To add an external job dependency, do the following:

a. Select External Job from the drop-down menu at the top of
the window.

b. Click the Add Row (+) button.

c. Double-click in the Job Name column of the new row.
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d. Click the find (...) part of the Job Name column and use the
Find Job window to select a job. For information about using
the Find window, see “Finding Objects in the Database” on
page 125.

e. Click the OK button to add the external job dependency and
close the window or click the Cancel button to close the
window without adding the dependency.

Deleting External Dependencies from a Job Stream
Job streams can be dependent on the successful execution of other
job streams, jobs in other job streams, and jobs in other TWS
networks (internetwork jobs). These external dependencies are also
called predecessors.

To delete external dependencies for a job stream, do the following:

1. Open the job stream in the Job Stream Editor.

2. Select External Dependencies from the File menu. This displays
the Job Stream External Dependencies window.

3. Select External Job Stream, Internetwork, or External Job
from the drop-down menu.

4. Click the row of the dependency in the list you want to delete
and click the Delete Row button (×).

5. Click the OK button to delete the dependency and close the
window or click the Cancel button to close the window without
deleting the dependency.

Adding a Job to a Job Stream
A job definition is a description of work to be performed on a
workstation. Jobs are scheduled for execution by adding them to job
streams.

You add jobs in a job stream using the Graph view of the Job
Stream Editor. See “Graph View” on page 142 for more information.
To add a job to a job stream, do the following:

1. Open the Graph view by selecting Graph from the View menu
or by clicking the Graph button in the toolbar.
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2. Select Add Job -> Job Definition from the Actions menu or
click the Add Job Definition button in the toolbar. This changes
the mouse pointer to a cross (+).

3. Move the mouse pointer to the position you want to place the
new job in the Graph view and left-click. This displays the
Properties - Job window. When the job properties are completed,
a new job icon is added in the Graph view.

Specifying Job Properties
The Properties - Job window opens automatically when you add a
new job to a job stream. If the Properties - Jobwindow is not
displayed, right-click a job in the Graph view of the Job Stream
Editor and select Properties... from the pop-up menu.

In the Properties - Job window, there are five groups of job
properties:

¶ General

¶ Time Restrictions

¶ Resources

¶ Files

¶ Prompts

To specify job properties, do the following:

1. Click General in the left panel of the Properties - Job window.
This displays the General view.
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2. In the General view of the Properties - Job window, fill in the
text boxes and select options as follows:

Name Specify the name of the job. Click the Find button to
choose the job. See “Finding Objects in the Database”
on page 125 for more information.

Workstation Name
Displays the workstation this job is defined to run on. If
this workstation is deleted, the task type for the job is
unknown and must be specified before you can save the
job again.

Priority
Specify the priority of the job. Select a priority value
from the drop-down list or click one of the following
buttons:

Hold Sets the priority to zero.

High Sets the priority to 100.

Go Sets the priority to 101.

Possible priority values are 0 through 101, where 101 is
the highest priority. A priority value of zero prevents the
job from launching.

Figure 31. Properties - Job: General window.
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Description
Specify a description for the job.

Requires Confirmation
Specify this check box to indicate that job completion
must be confirmed by the operator. When a job with
requires confirmation enabled completes, it remains in
the internal status PEND until confirmation is received.
If confirmation is received before the job completes, its
internal status is either SUCCP or ABENDP and other
job and job stream successors are not released.

3. To specify time restrictions for a job, click Time Restrictions
in the left panel of the Properties - Job window. This displays
the Time Restrictions view.

4. In the Time Restrictions view of the Properties - Job window,
fill in the text boxes and select options as follows:

Start time
Specifies the earliest time the job will be launched. The
job will not be launched before this time. Make your
selections as follows:

Figure 32. Properties - Job: Time Restrictions window.
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Specify time
Select this option to enable the entry of a start
time.

At Enter a start time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Delay for
Enter the number of days to offset the start time
from the day the job is selected for inclusion in
the production plan.

Deadline
Specifies the latest time the job will be launched. The
job will not be launched after this time. Make your
selections as follows:

Specify time
Select this option to enable the entry of a
deadline time.

At Enter a deadline time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Note: The Deadline time must be later than the
Start Time.

Delay for
Enter the number of days to offset the deadline
time from the day the job is selected for
inclusion in the production plan.

Time Zone
Specify the time zone in which the job runs. All time
values specified in the Time Restrictions view of the
Properties - Job window are in this time zone. Select a
time zone from the drop-down list. For information
about the time zone feature, see “Time Zones” on
page 21. If a time zone is not specified for the job, all
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time values specified in the Time Restrictions view of
the Properties - Job window are in the time zone of the
workstation on which the job is launched.

Repeat Range
Specify the repetition rate of the job. The job is
launched multiple times at this rate. Make your
selections as follows:

Hours Specify the hours that a job repeats.

Minutes
Specify the minutes that the job repeats.

If you cancel a repetitive job, it will not be launched
again. If you rerun a repetitive job, the next iteration of
the job is run immediately. If you rerun a repetitive job
that had been cancelled, the repetition rate is reinstalled.
If a repetitive job abends, the repetitions continue
following the optional recovery action.

Est. Duration
This field displays the estimated duration of the job if
the job has run before.

Normal Elapsed Time
Displays the average time this job requires to
execute, based on previous runs.

Note: Time Restrictions can also be set in the Timeline View
of the Job Stream Editor. See “Timeline View” on
page 144 for more information.

5. To specify resource dependencies for a job, click Resources in
the left panel of the Properties - Job window. This displays the
Resources view.
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6. To add a resource dependency for the job, do the following:

a. Click the Add Row (+) button. This creates a new row in
the list of resource dependencies.

b. Double-click the text box in the Resources column and
click the Find button to locate and insert a resource name.
For information about using the Find window, see “Finding
Objects in the Database” on page 125.

c. Double-click the text box in the Quantity column and enter
the number of resource units required by the job.

7. To remove a resource dependency for the job, select the
resource row in the list and click the Delete from Table (X)
button.

8. To specify file dependencies for the job, click Files in the left
panel of the Properties - Job window. This displays the Files
view.

Figure 33. Properties - Job: Resources window.
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9. To add a file dependency for the job, do the following:

a. Click the Add Row (+) button. This creates a new row in
the list of file dependencies.

b. Double-click the text box in the Workstation column and
type in a workstation or workstation class name.
Alternatively, click the Find button to locate and insert the
name of a workstation or workstation class. For information
about using the Find window, see “Finding Objects in the
Database” on page 125.

c. Double-click the text box in the Filename column and type
in a file name. Alternatively, click the Find button to locate
and insert a file name. For information about using the
select window, see “Finding Objects in the Database” on
page 125.

d. Double-click the text box in the Qualifiers column and
enter the test conditions for the file dependency. On UNIX,
the valid qualifiers are the same as UNIX test command
conditions. For more information, refer to your UNIX
system documentation.

On Windows NT, only the following qualifiers are valid:

-d %p True if the file exists and is a directory.

Figure 34. Properties - Job: Files window.
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-e %p True if the file exists.

-f %p True if the file exists and is a regular file.

-r %p True if the file exists and is readable.

-s %p True if the file exists and it’s size is greater
than zero.

-w %p True if the file exists and is writable.

On both UNIX and Windows NT, the expression %p,
inserts the file name.

Entering notempty is the same as entering -s %p. If no
qualifier is specified, the default is -f %p.

10. To remove a file dependency for the job, select the file row in
the list and click the Delete from Table (X) button.

11. To specify prompt dependencies for the job, click Prompts in
the left panel of the Properties - Job window. This displays the
Prompts view.

12. For an ad hoc prompt dependency, select Ad Hoc Prompt from
the drop-down list. For a predefined prompt dependency, select
Predefined Prompt from the drop-down list.

Figure 35. Properties - Job: Prompts window.
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13. To add a prompt dependency for the job, do the following:

a. Click the Add Row (+) button. This creates a new row in
the list of prompt dependencies.

b. For a pre-defined prompt, double-click the text box in the
Name column and click the Find button to locate and insert
the name of a prompt. For information about using the Find
window, see “Finding Objects in the Database” on page 125.

c. For an ad hoc prompt, double-click the text box in the Text
column and type in the text of the prompt. The default
behavior of a prompt is to display a message and wait for a
reply. If the string begins with a colon (:), the message is
displayed but no reply is necessary. If the string begins with
an exclamation mark (!), the message is not displayed but it
requires a reply. You can include backslash n (\n) within the
text for new lines.

You can include one or more TWS parameters as part or all
of the text string. To use a parameter, place its name
between carets (^).

14. To remove a prompt dependency for the job, select the prompt
row in the list and click the Delete from Table (X) button.

15. When you have finished specifying job properties, do one of the
following:

¶ Click the OK button to keep the properties you have
selected and close the Properties - Job window. If you are
adding a new job, a job icon is added in the Graph view.

¶ Click the Cancel button to ignore the properties you have
selected and close the Properties - Job window without
adding an icon in the Graph view.

Copying and Pasting Jobs
Within the Job Stream Editor you can copy and paste job and job
stream icons to create dependencies:

¶ You can copy a job stream from a job stream list and paste it
into the Graph view of the Job Stream Editor. Then, using the

Managing Job Streams in the Database

168 Version 7.0



Add Link button, you can create a dependency between this job
stream and any jobs in the Job Stream Editor.

¶ You can open multiple job streams in separate Job Stream
Editors and copy and paste jobs between the job streams.

¶ You can copy a job within the Job Stream Editor and clone its
dependencies to another job.

Cloning the Job Dependencies
This procedure is used to clone the dependencies of a job to a new
job within the Graph view of the Job Stream Editor. To clone the
dependencies of a job:

1. right-click the job icon and select Copy from the pop-up menu.
Alternatively, select the job icon and click the Copy button in
the toolbar or select Copy from the Edit menu. This copies the
job to the clipboard.

2. Click the Paste button in the toolbar or select Paste from the
Edit menu. This displays the Properties - Job window for the
copied job.

3. Use the search tool to find and select a new job to add to the job
stream. The job name is added to the General tab of the
Properties - Job window.

4. When you click the OK button in the Properties - Job window, a
new icon is added for the job in the Graph view of the Job
Stream Editor. This job has the same dependencies as the copied
job.

5. If you are finished in the Job Stream Editor, save the job stream
and close the Job Stream Editor. For more information see
“Saving a Job Stream in the Database” on page 186 and “Closing
the Job Stream Editor” on page 186.

Adding an Internetwork Dependency to a Job Stream
An internetwork dependency is a d13ependency on a job that runs in
another TWS network. Internetwork dependencies require a Network
Agent workstation to communicate with the external TWS network.
For more information on configuring a Network Agent, refer to the
Tivoli Workload Scheduler Reference Guide.
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Add internetwork dependencies to a job stream to create
predecessors for the jobs in the job stream you are editing. A
predecessor must complete successfully before the successor job is
launched.

You add internetwork dependencies in a job stream using the Graph
view of the Job Stream Editor. See “Graph View” on page 142 for
more information. To add an internetwork dependency, do the
following:

1. Open the Graph view by selecting Graph from the View menu
or by clicking the Graph button in the toolbar.

2. Select Add Dependency -> Internetwork from the Actions
menu or click the Add Dependency on Internetwork button.
This changes the mouse pointer to a cross (+).

3. Move the mouse pointer to the position you want to place the
new internetwork dependency in the Graph view and left-click.
This displays the Internetwork Dependency window.

4. Click the find (...) button and use the Find Workstation window
to select the name of the Network Agent.

5. Fill in the text box as follows:

Dependency
Specify the freeform dependency or the job/job stream
predecessor in the format: workstation#jobstream.job The
maximum length of this field is 120 for freeform
characters or 16 for workstation, 16 for the job stream,
and 40 for the job.

6. When you are finished with the Internetwork Dependency
Properties window, do one of the following:

¶ Click the OK button to close the Internetwork Dependency
Properties window. If you are adding a new internetwork
dependency, a new internetwork dependency icon is added in
the Graph view.

¶ Click the Cancel button to ignore the properties you have
selected and close the Internetwork Dependency Properties
window without adding an icon in the Graph view.
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7. See “Creating Dependencies Between Jobs in a Job Stream” on
page 173 for information about using an internetwork
dependency as a predecessor.

Adding an External Job Stream to a Job Stream
An external job stream is any job stream other than the one you are
editing. Add external job streams to a job stream to create
predecessors for the jobs in the job stream you are editing. A
predecessor must complete successfully before the successor job is
launched.

You add external job streams in a job stream using the Graph view
of the Job Stream Editor. See “Graph View” on page 142 for more
information. To add an external job stream, do the following:

1. Open the Graph view by selecting Graph from the View menu
or by clicking the Graph button in the toolbar.

2. Select Add Dependency -> External Job Stream from the
Actions menu or click the Add External Job Stream button in
the toolbar. This changes the mouse pointer to a cross (+).

3. Move the mouse pointer to the position you want to place the
new external job stream in the Graph view and left-click. This
displays the Properties - External Job Stream window.

Figure 36. External Job Stream Dependency window.
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4. Click the Find button next to the Workstation text box to locate
and insert the name of the workstation on which the job stream
runs.

5. Click the Show Job Streams button to list the job streams that
run on the workstation.

6. Select a job stream in the list and do one of the following:

¶ Click the OK button to close the Properties - External Job
Stream window. If you are adding a new external job stream,
a job stream icon is added in the Graph view.

¶ Click the Cancel button to ignore the properties you have
selected and close the Properties - External Job Stream
window without adding an icon in the Graph view.

7. See “Creating Dependencies Between Jobs in a Job Stream” on
page 173 for information about using an external job stream as a
predecessor.

Adding an External Job to a Job Stream
An external job is a job that runs in a job stream other than the one
you are editing. Add external jobs to a job stream to create
predecessors for the jobs in the job stream you are editing. A
predecessor must complete successfully before the successor job is
launched.

You add external jobs in a job stream using the Graph view of the
Job Stream Editor. See “Graph View” on page 142 for more
information. To add an external job, do the following:

1. Open the Graph view by selecting Graph from the View menu
or by clicking the Graph button in the toolbar.

2. Select Add Job -> External Job from the Actions menu or
click the Add External Job button in the toolbar. This changes
the mouse pointer to a cross (+).

3. Move the mouse pointer to the position you want to place the
new external job in the Graph view and left-click. This displays
the Properties - External Job window.
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4. Click the Find button next to the Job Stream Name text box to
locate and insert the name of the job stream in which the job
runs. For information about using the Find window, see “Finding
Objects in the Database” on page 125.

5. Click the Show Jobs button to list the jobs in the selected job
stream that run on the selected workstation.

6. Select a job in the list and do one of the following:

¶ Click the OK button to close the Properties - External Job
window. If you are adding a new external job, a job icon is
added in the Graph view.

¶ Click the Cancel button to close the Properties - External
Job window without adding an icon in the Graph view.

7. See “Creating Dependencies Between Jobs in a Job Stream” for
information about using an external job as a predecessor.

Creating Dependencies Between Jobs in a Job Stream
You can add dependencies between jobs to specify the order in
which they run. A job that depends on the successful completion of
another job is called a successor and the job or job stream that it
depends on is called a predecessor.

Figure 37. External Job Dependency window.
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You add dependencies between jobs in the Graph view of the Job
Stream Editor. See “Graph View” on page 142 for more information.
The dependencies are represented by arrows. To add a dependency
between jobs, do the following:

1. Select Add Link from the Actions menu or click the Add Link
button in the toolbar. This changes the mouse pointer to a cross
(+).

2. Click on the predecessor job or job stream and drag to the
successor job. When you release the mouse button, an arrow is
drawn from the predecessor to the successor.

Notes:

a. Internetwork dependencies, external jobs, and external job
streams cannot be successors.

b. Internetwork dependencies, external jobs, and external job
streams that are not linked are not saved when the Job
Stream Editor is closed.

Figure 38. Graph View of the Job Stream Editor window.
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To remove a dependency between jobs, select the arrow between the
predecessor and the successor and right-click the arrow and select
Delete from the pop-up menu.

If you are finished in the Job Stream Editor, refer to “Saving a Job
Stream in the Database” on page 186.

Specifying Run Cycles for a Job Stream
Run cycles specify when a job stream in the database will run in the
plan. Combinations of run cycles are used to include and exclude
certain dates. Run cycles can be defined based on the following
criteria:

¶ Simple Run Cycles are based on specific calendar dates.

¶ Weekly Run Cycles are based on days of the week.

¶ Calendar Run Cycles are based on pre-defined calendars.

You specify run cycles for a job stream using the Run Cycle view
of the Job Stream Editor. To display the Run Cycle view, select
Run Cycle from the View menu in the Job Stream Editor or click
the Run Cycle button in the toolbar. See “Run Cycle View” on
page 146 for more information.

Managing Job Streams in the Database

175Tivoli Workload Scheduler User’s Guide

7.
T

W
S

D
atab

ase
Tasks



Colored Bars on Dates
As you include and exclude dates, colored bars are displayed across
the dates. The bars have the following meanings:

Blue Specifies an included date.

Red Specifies an excluded date.

White Specifies a non-workday. Note that dates that are defined on
the Holidays calendar are shown as non-workdays. For more
information, see “The Holidays Calendar” on page 230.

White/Blue
Specifies an included non-workday.

White/Red
Specifies an excluded non-workday.

Specifying Simple Run Cycles
To specify a simple run cycle for a job stream, do the following:

1. Include run cycles specify when the job stream will run in the
plan. To add an include simple run cycle, select Add->Include
Simple Run Cycle from the Actions menu or click the Include
Simple Run Cycle button in the toolbar.

Figure 39. Run Cycle View of the Job Stream Editor window.
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Exclude run cycles specify when the job stream will not run in
the plan. To add an exclude simple run cycle, select
Add->Exclude Simple Run Cycle from the Actions menu or
click the Exclude Simple Run Cycle button in the toolbar.

This displays the Include Simple Run Cycle or Exclude Simple
Run Cycle window.

2. In the left panel, select either the Monthly or Yearly view. Use
the arrow buttons in the upper and lower bars of the selected
view to move to the desired month and year.

3. Click on the dates in the calendar to add them to the run cycle.
Click the same date a second time to remove it from the run
cycle.

4. When you are finished in the run cycle window, do one of the
following:

¶ Click the OK button to close the window and add the run
cycle to the job stream.

¶ Click the Cancel button to close the window without adding
the run cycle to the job stream.

Figure 40. Include Simple Run Cycle window.
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Specifying Weekly Run Cycles
To specify a weekly run cycle for a job stream, do the following:

1. Include run cycles specify when the job stream will run in the
plan. To add an include weekly run cycle, select Add->Include
Weekly Run Cycle from the Actions menu or click the Include
Weekly Run Cycle button in the toolbar.

Exclude run cycles specify when the job stream will not run in
the plan. To add an exclude weekly run cycle, select
Add->Exclude Weekly Run Cycle from the Actions menu or
click the Exclude Weekly Run Cycle button in the toolbar.

This displays the Include Weekly Run Cycle or Exclude Weekly
Run Cycle window.

2. Select the days by name to add them to the run cycle. In addition
to single days, the following can also be selected:

Weekdays
Specifies every day of the week except Saturday and
Sunday.

Workdays
Specifies every day of the week except Saturday, Sunday,
and the days defined on a calendar named HOLIDAYS.
Note: If your company requires more than a single
HOLIDAYS calendar, you can create the same effect by
using weekdays except HOLIDAYS_NAME calendar. For

Figure 41. Include Weekly Run Cycle window.
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example, you can specify for a job stream to run on
Weekdays except a calendar called H_FRANCE.

Everyday
Specifies every day of the week.

3. When you are finished in the run cycle window, do one of the
following:

¶ Click the OK button to close the window and add the run
cycle to the job stream.

¶ Click the Cancel button to close the window without adding
the run cycle to the job stream.

Specifying Calendar Run Cycles
To specify a calendar run cycle for a job stream, do the following:

1. Include run cycles specify when the job stream will run in the
plan. To add an include calendar run cycle, select Add->Include
Calendar Run Cycle from the Actions menu or click the
Include Calendar Run Cycle button in the toolbar.

Exclude run cycles specify when the job stream will not run in
the plan. To add an exclude calendar run cycle, select
Add->Exclude Calendar Run Cycle from the Actions menu or
click the Exclude Calendar Run Cycle button in the toolbar.

This displays the Include Calendar Run Cycle or Exclude
Calendar Run Cycle window.

Figure 42. Include Calendar Run-Cycle window.
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2. Type the name of the calendar in the Name text box or click the
Find button to locate a calendar. See “Finding Objects in the
Database” on page 125 for more information.

3. In the Offset group, you can specify an offset from the dates
defined in the calendar. For example, if a calendar date is
3/13/2000, an offset of +2 Days results in an effective date of
3/15/2000. To specify an offset, do the following:

a. Select + for a positive offset or - for a negative offset from
the drop-down menu.

b. Enter the number of days in the text box. The range of
numbers is 0 to 9999.

c. Select one of the following from the drop-down menu:

Days Specifies calendar days with no exceptions.

Workdays
Specifies calendar days except Saturday, Sunday, and
days that are defined in the holidays calendar.

Weekdays
Specifies calendar days except Saturday and Sunday.

4. When you are finished in the run cycle window, do one of the
following:

¶ Click the OK button to close the window and add the run
cycle to the job stream.

¶ Click the Cancel button to close the window without adding
the run cycle to the job stream.

Modifying Run Cycles for a Job Stream
To modify the run cycles for a job stream, do the following:

1. Open the job stream in the Job Stream Editor.

2. Display the Run Cycle View, by clicking the Run Cycle view
button.

3. In the Run Cycles Name column, double click the Run Cycle
you want to modify.
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¶ If this is a Simple Run Cycle (either inclusionary or
exclusionary) a window is opened displaying the days
selected by that run cycle. Modify the days selected and
click the OK button to save your changes.

¶ If this is a Weekly Run Cycle (either inclusionary or
exclusionary) a window is opened displaying the days
selected by that run cycle. Modify the days selected and
click the OK button to save your changes.

¶ If this is a Calendar Run Cycle (either inclusionary or
exclusionary) a window is opened displaying the name of the
calendar you selected and offset specified. Modify the
calendar selected or the offset and click the OK button to
save your changes.

Note: You can only specify two simple and two weekly run
cycles per job stream, one inclusionary and one
exclusionary. Exclusionary run cycles take precedence
over inclusionary run cycles.

4. When you are finished in the run cycle window, do one of the
following:

¶ Click the OK button to close the window and save the
changes to the job stream.

¶ Click the Cancel button to close the window without saving
the changes to the job stream.

Deleting Run Cycles from a Job Stream
To delete a run cycle from a job stream, do the following:

1. Open the job stream in the Job Stream Editor.

2. Display the Run Cycle View, by clicking the Run Cycle view
button.

3. In the Run Cycles Name column, select the Run Cycle you want
to delete from the job stream.

Managing Job Streams in the Database

181Tivoli Workload Scheduler User’s Guide

7.
T

W
S

D
atab

ase
Tasks



4. Click the Delete Button. The Run Cycle is deleted from the job
stream. If the run cycle was a calendar it is deleted from this job
stream, but it was not deleted from the database, and still may be
used by other job streams.

5. When you are finished in the run cycle window, do one of the
following:

¶ Click the OK button to close the window and save the
changes to the job stream.

¶ Click the Cancel button to close the window without saving
the changes to the job stream.

Specifying Time Restrictions in the Timeline View
You can display and specify the time restrictions for a job stream
and its jobs using the Timeline view of the Job Stream Editor. For
information about the Timeline view refer to “Timeline View” on
page 144.

Specifying Time Restrictions for a Job Stream
To specify time restrictions for the job stream in the Timeline view
of the Job Stream Editor, do the following:

1. Select Timeline from the View menu in the Job Stream Editor or
click the Timeline button in the toolbar.

2. To adjust the time restrictions using the timeline, do any of the
following:

¶ Drag the left side of the timeline to adjust the start time.

¶ Drag the right side of the timeline to adjust the deadline
time.

¶ Drag the center of the timeline to change both the start and
the deadline time.

3. To adjust the time restrictions using a window, do the following:

a. Double-click the job stream row in the tabular panel or
right-click the row and select Properties... from the pop-up
menu. This displays a Properties window.
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b. In the Properties window, fill in the text boxes and select
options as follows:

Start Specify the earliest time the job stream will be
launched. The job stream will not be launched before
this time. Make your selections as follows:

Specify time
Select this option to enable the entry of a
start time.

At Enter a start time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Delay for
Enter the number of days to offset the start
time from the day the job stream is selected
for inclusion in the production plan.

Deadline
Specify the latest time the job stream will be
launched. The job stream will not be launched after
this time. Make your selections as follows:

Specify time
Select this option to enable the entry of a
deadline time.

At Enter a deadline time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Note: The Deadline time must be later than
the Start Time.

Delay for
Enter the number of days to offset the
deadline time from the day the job stream is
selected for inclusion in the production plan.
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c. When you are finished in the Properties window, do one of
the following:

¶ Click the OK button to close the window and save the
time restrictions.

¶ Click the Cancel button to close the window without
saving the time restrictions.

Note: Time Restrictions can also be set in the Time Restrictions
view of the Properties - Job window. See “Specifying Job
Stream Properties” on page 148 for more information.

Specifying Time Restrictions for a Job
To specify time restrictions for a job in the Timeline view of the Job
Stream Editor, do the following:

1. Select Timeline from the View menu in the Job Stream Editor or
click the Timeline button in the toolbar.

2. To adjust the time restrictions using the timeline, do any of the
following:

¶ Drag the left side of the timeline to adjust the start time.

¶ Drag the right side of the timeline to adjust the deadline
time.

¶ Drag the center of the timeline to change both the start and
the deadline time.

3. To adjust the time restrictions using a window, do the following:

a. Double-click the job row in the tabular panel or right-click
the row and select Properties... from the pop-up menu. This
displays a Properties window.

b. In the Properties window, fill in the text boxes and select
options as follows:

Start Specify the earliest time the job will be launched.
The job will not be launched before this time. Make
your selections as follows:
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Specify time
Select this option to enable the entry of a
start time.

At Enter a start time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Delay for
Enter the number of days to offset the start
time from the day the job is selected for
inclusion in the production plan.

Deadline
Specify the latest time the job will be launched. The
job will not be launched after this time. Make your
selections as follows:

Specify time
Select this option to enable the entry of a
deadline time.

At Enter a deadline time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Note: The Deadline time must be later than
the Start Time.

Delay for
Enter the number of days to offset the
deadline time from the day the job is selected
for inclusion in the production plan.

Time Zone
Specify the time zone for this job. For information
about the time zone feature, see “Time Zones” on
page 21
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Repeat Range
Specify the repetition rate of the job. The job is
launched multiple times at this rate. Make your
selections as follows:

Hours Specify the hours that a job repeats.

Minutes
Specify the minutes that the job repeats.

c. When you are finished in the Properties window, do one of
the following:

¶ Click the OK button to close the window and save the
time restrictions.

¶ Click the Cancel button to close the window without
saving the time restrictions.

Note: Time Restrictions can also be set in the Time Restrictions
view of the Properties - Job window. See “Specifying Job
Properties” on page 160 for more information.

Saving a Job Stream in the Database
To save a job stream in the database from the Job Stream Editor,
click the Save button in the toolbar or select Save from the File
menu.

Closing the Job Stream Editor
To close the Job Stream Editor, click the Close button in the window
titlebar or select Close on the File menu. You receive a warning
message if your job stream changes have not been saved. Respond to
the message in one of the following ways:

¶ Click Yes to save the job stream in the database before closing
the Job Stream Editor.

¶ Click No to close the Job Stream Editor without saving the job
stream in the database.

¶ Click Cancel to return to the Job Stream Editor without saving
the job stream in the database.
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Displaying a List of Job Streams in the Database
To display a list of job streams in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below TWS until you see the icon for the
job stream list you want to run. See “Creating a Database List of
Job Streams” on page 114 for information about creating job
stream lists.

3. Select the job stream list icon.

4. Click the Load List button on the toolbar or right-click the job
stream list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console.

The following are descriptions of the column headings.

Name Specifies the name of the job stream.

Figure 43. Job Streams list window.
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Workstation
Specifies the name of the workstation on which the job
stream runs.

Priority
Specifies the priority of the job stream.

Limit Specifies the job limit of the job stream.

Creator
Specifies the name of the user who created the job
stream in the database.

Last Updated
Specifies the date the job stream was last updated in the
database.

Displaying a Job Stream in the Database
To display a job stream in the database, follow these steps:

1. Run a list of job streams that contains the job stream you want to
display. See “Displaying a List of Job Streams in the Database”
on page 187 for more information.

2. In the list results, double-click on the job stream you want to
display or right-click the job stream and choose Properties from
the pop-up menu.

This displays the job stream in the Job Stream Editor. For
information about the Job Stream Editor, see “Creating a Job
Stream in the Database” on page 148.

3. Click the OK or the Cancel button to close the Job Stream
Editor.

Modifying a Job Stream in the Database
To modify a job stream in the database, follow these steps:

1. Run a list of job streams that contains the job stream you want to
modify. See “Displaying a List of Job Streams in the Database”
on page 187 for more information.

2. In the list results, double-click on the job stream you want to
modify or right-click the job stream and choose Properties from
the pop-up menu.
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This displays the job stream in the Job Stream Editor.

3. Make your changes in the Job Stream Editor. For information
about the Job Stream Editor, see “Using the Job Stream Editor”
on page 142 and “Creating a Job Stream in the Database” on

page 148.

4. To edit the properties of the job stream, click Properties button
in the toolbar or select Properties... from the File menu. For
information about job stream properties, see “Specifying Job
Stream Properties” on page 148.

For information about modifying the objects in a job stream,
refer to the following:

¶ For jobs, see “Modifying a Job in a Job Stream” and
“Deleting a Job in a Job Stream” on page 190.

¶ For internetwork dependencies, see “Modifying an
Internetwork Dependency in a Job Stream” on page 190 and
“Deleting an Internetwork Dependency in a Job Stream” on
page 190.

¶ For external job streams, see “Modifying an External Job
Stream in a Job Stream” on page 190 and “Deleting an
External Job Stream in a Job Stream” on page 190.

¶ For external jobs, see “Modifying an External Job in a Job
Stream” on page 190 and “Deleting Job Streams in the
Database” on page 191.

5. When you are finished modifying the job stream, save the job
stream in the database and close the Job Stream Editor. For more
information, see “Saving a Job Stream in the Database” on
page 186 and “Closing the Job Stream Editor” on page 186.

Modifying a Job in a Job Stream
To modify a job in a job stream, right-click the job icon in the
Graph view and select Properties... from the pop-up menu. For
information about job properties, see “Specifying Job Properties” on
page 160.
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Deleting a Job in a Job Stream
To delete a job in a job stream, right-click the job icon in the Graph
view and select Delete from the pop-up menu.

Modifying an Internetwork Dependency in a Job Stream
To modify an internetwork dependency in a job stream, right-click
its icon in the Graph view and select Properties... from the pop-up
menu. For information about internetwork dependency properties, see
“Adding an Internetwork Dependency to a Job Stream” on page 169.

Deleting an Internetwork Dependency in a Job Stream
To delete an internetwork dependency in a job stream, right-click its
icon in the Graph view and select Delete from the pop-up menu.

Modifying an External Job Stream in a Job Stream
To modify an external job stream in a job stream, right-click its icon
in the Graph view and select Edit -> External Job Stream from
the pop-up menu. This displays the job stream in a Job Stream
Editor. For information about the Job Stream Editor, see “Using the
Job Stream Editor” on page 142 and “Creating a Job Stream in the
Database” on page 148.

Deleting an External Job Stream in a Job Stream
To delete an external job stream in a job stream, right-click its icon
in the Graph view and select Delete from the pop-up menu.

Modifying an External Job in a Job Stream
To modify an external job in a job stream, right-click its icon in the
Graph view and select Edit -> External Job Stream from the
pop-up menu. This displays the job’s job stream in a Job Stream
Editor. For information about the Job Stream Editor, see “Using the
Job Stream Editor” on page 142 and “Creating a Job Stream in the
Database” on page 148. To edit the job in the external job stream,
right-click the job icon in the Graph view and select Properties...
from the pop-up menu. For information about job properties, see
“Specifying Job Properties” on page 160.

Deleting an External Job in a Job Stream
To delete an external job in a job stream, right-click its icon in the
Graph view and select Delete from the pop-up menu.
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Deleting Job Streams in the Database
To delete job streams in the database, follow these steps:

1. Run a list of job streams that contains the job stream you want to
delete. See “Displaying a List of Job Streams in the Database” on
page 187 for more information.

2. In the list results, do one of the following:

¶ To delete one job stream, right-click the job stream.

¶ To delete multiple job streams in a range, hold down the
Shift key, click the first and last job streams in the range,
then right-click one of the selected job streams.

¶ To delete multiple job streams that are not in a range, hold
down the Ctrl key, click on each job stream, then right-click
one of the selected job streams.

3. Choose Delete from the pop-up menu. A message is displayed
for each job stream asking for confirmation.

4. Click the OK button to delete the job stream in the database or
click the Cancel button to cancel the delete operation.

Managing Workstations in the Database
A workstation is usually an individual computer, on which jobs and
job streams are executed. A workstation definition is required for
every computer that executes jobs in the TWS network.

Primarily workstation definitions refer to physical workstations.
However, in the case of extended agents, the workstations are logical
definitions that must be hosted by a physical workstation.

There are several types of workstations in a TWS Network:

¶ Master Domain Manager

¶ Domain Manager

¶ Backup Domain Manager

¶ Fault Tolerant Agent
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¶ Standard Agent

¶ Extended Agent

¶ Network Agent

Creating a Workstation in the Database
You create workstations in the database using the Properties -
Workstation in Database window. To create a new workstation,
follow these steps. See also “Creating a Workstation in the Database
by Copying Another Workstation” on page 202. For information
about creating extended agent workstations, see the user manual for
the specific extended agent.

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Click the New Workstation button on the toolbar or right-click
the TWS controller icon and select New Workstation from the
pop-up menu.

This opens the Properties - Workstation in Database window.
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3. In the Properties - Workstation in Database window, fill in the
text boxes and select options as follows:

Workstation name
Specify the name of the workstation. The name must
start with a letter and can contain alphanumeric
characters, dashes, and underscores. For non-expanded
databases, it can contain up to eight characters. For
expanded databases, it can contain up to 16 characters.

Note: Workstation names must be unique, and cannot be
the same as workstation class and domain names.

Node Specify the host name or the IP address of the
workstation. Fully-qualified domain names are accepted.

TCP Port
Specify the Netman TCP port number that TWS uses for
communications on the workstation. The default is 31111.
The port number of Netman on a workstation is defined
by the localopts file in the parameter nm port.

Figure 44. Properties - Workstation in Database window.
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Operating System
Specify the operating system of the workstation as one of
the following:

UNIX
MPE/IX
MPE/V
Windows NT
Other

Domain name
Specify the name of the TWS domain of the workstation.
The name must start with a letter and can contain
alphanumeric characters, dashes, and underscores. For
non-expanded databases, it can contain up to eight
characters. For expanded databases, it can contain up to
16 characters.

Note: Domain names must be unique, and cannot be the
same as workstation and workstation class names.

The default for fault-tolerant and standard agents is the
master domain, usually named MASTERDM. The
default for a domain manager is the domain in which it
is defined as the manager. The default for an extended
agent is the domain of its host.

Time Zone
Specify the time zone of the workstation. Choose a time
zone name from the drop-down list. For a description of
time zone names, refer to the Tivoli Workload Scheduler
Reference Guide. To ensure the accuracy of scheduling
times, this time zone must be the same as the computer’s
operating system time zone.

Description
Specify a description of the workstation. The description
can contain up to 40 characters.

Workstation type
Specify the type of workstation. Select one of the
following from the drop-down list:
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Fault-Tolerant Agent
Select this type for an agent workstation that is
capable of launching its jobs and resolving local
dependencies without a domain manager. Select
this type for fault-tolerant agents, domain
managers, and backup domain managers.

Standard Agent
Select this type for an agent workstation that
launches jobs only under the direction of its
domain manager.

Extended Agent
Select this type for an agent workstation that
launches jobs only under the direction of its host.
Extended agents can be used to interface TWS
with non-Tivoli systems and applications. For
more information refer the user manual for the
specific extended agent.

Auto Link
Specify whether to open the link between workstations at
startup. For fault-tolerant and standard agents, select this
option to have the domain manager open the link to the
agent when the domain manager is started. For a domain
manager, select this option to have its agents open links
to the domain manager when they are started.

Auto Link is useful primarily during the startup
sequence at the beginning of each day. At that time, a
new production plan is created and compiled on the
master domain manager, and all workstations are stopped
and restarted. For each agent that has Auto Link
selected, the domain manager automatically sends a copy
of the new production plan and starts the agent. If Auto
Link is also selected for the domain manager, the agent,
in turn, opens a link back to the domain manager. If
Auto Link is not selected for an agent, it is initialized
when you execute a link action on the agent’s domain
manager or the master domain manager.
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Full Status
Specify whether the agent is updated with full or partial
status. This is for fault-tolerant agents only. When Full
Status is selected, the agent is updated about the status
of jobs and job streams running on all other workstations
in its domain and subordinate domains.

If Full Status is not selected, the agent is informed only
about the status of jobs and job streams on other
workstations that affect its own jobs and job streams.
This can improve performance by reducing network
activity.

To keep an agent’s production plan at the same level of
detail as its domain manager, select Full Status and
Resolve Dependencies. Always select these options for
backup domain managers.

Ignore
Specify that TWS will ignore this workstation. This can
be used to define workstations before they are actually
installed.

Resolve Dependencies
Specify whether an agent will track all dependencies or
only its own. This is for fault-tolerant agents only. When
Resolve Dependencies is selected, the agent tracks
dependencies for all jobs and job streams, including
those running on other workstations. Note that Full
Status must also be selected so that the agent is
informed about activity on other workstations. If Resolve
Dependencies is not selected, the agent tracks
dependencies for its own jobs and job streams only. This
reduces processing overhead.

To keep an agent’s production plan at the same level of
detail as its domain manager, select Full Status and
Resolve Dependencies. Always select these options for
backup domain managers.

Server ID
Specify a Mailman server on the domain manager to
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handle communications with the agent. This is for
fault-tolerant and standard agents only. Do not use this
option for domain managers. Using servers can reduce
the time required to initialize agents and improve the
timeliness of messages.

To specify a server, select a letter or a number (A-Z and
0-9) from the drop-down list. The IDs are unique to each
domain manager, so you can use the same IDs in other
domains without conflict. If more than 36 server IDs are
required in a domain, consider dividing it into two or
more domains.

If a server ID is not specified, communications with the
agent are handled by the main Mailman process on the
domain manager.

When a domain manager starts up, it creates a separate
server for each unique server ID. If the same ID is used
for multiple agents, a single server is created to handle
their communications. As a guide, extra servers should be
defined to prevent a single server from handling more
than eight agents.

Access Method
Specify an access method for extended agents and
network agents. This must be the name of a method file
that resides in the TWShome/methods directory on the
agent’s host workstation. For a local UNIX extended
agent, the method name is unixlocl. For a remote UNIX
extended agent the method name is unixrsh. For
Network agents, the method name is netmth. For more
information about extended agents, refer to the individual
extended agent user’s guides. For more information about
network agents, refer to the Tivoli Workload Scheduler
Reference Guide.

Host Specify the name of the agent’s host workstation. This is
required for extended agents. The host is the workstation
with which the extended agent communicates and where
its access method resides. The host for an extended agent
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must be a Master, Domain Manager, or FTA. The host
for an extended agent can be specified as $MASTER.
This assigns the host as the Master Domain Manager,
and is useful if you need to switch masters in the
domain. The extended agent will automatically connect
to the new manager.

Note: The host option is no longer required for Standard agents.
The host workstation for standard agents is now defaulted to the
domain manager.

4. When you are finished in the Properties - Workstation in
Database window, do one of the following:

¶ Click the OK button to save the workstation in the database
and close the Properties - Workstation in Database window.

¶ Click the Cancel button to close the Properties - Workstation
in Database window without saving the workstation in the
database.

Displaying a List of Workstations in the Database
To display a list of workstations in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below TWS until you see the icon for the
workstation list you want to run. See “Creating a Database List
of Workstations” on page 110 for information about creating
workstation lists.

3. Select the workstation list icon.

4. Click the Load List button on the toolbar or right-click the
workstation list icon and select Load List from the pop-up
menu.

The list results are displayed in the right panel of the Job
Scheduling Console.
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The following are descriptions of the column headings in the
workstation display.

Name Specifies the name of the workstation.

Type Specifies the type of workstation as one of the following:

Fault-Tolerant Agent
Standard Agent
Extended Agent

OS Specifies the type of Operating System for the
workstation as one of the following:

UNIX
MPE/IX
MPE/V
Windows NT
Other

Figure 45. Workstation list window.
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Domain
Specifies the name of the domain in which the
workstation is a member.

Time Zone
Specifies the time zone of the workstation, if one is
defined.

Creator
Specifies the name of the user who created the
workstation in the database.

Last Updated
Specifies the date the workstation was last updated in the
database.

Displaying a Workstation in the Database
To display a workstation in the database, follow these steps:

1. Run a list of workstations that contains the workstation you want
to display. See “Displaying a List of Workstations in the
Database” on page 198 for more information.

2. In the list results, double-click on the workstation you want to
display or right-click the workstation and choose Properties
from the pop-up menu.

This opens the workstation in the Properties - Workstation in
Database window. For information about the Properties -
Workstation in Database window, see “Creating a Workstation in
the Database” on page 192.

3. Click the OK or the Cancel button to close the Properties -
Workstation in Database window.

Modifying a Workstation in the Database
To modify a workstation in the database, follow these steps:

1. Run a list of workstations that contains the workstation you want
to display. See “Displaying a List of Workstations in the
Database” on page 198 for more information.
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2. In the list results, double-click on the workstation you want to
modify or right-click the workstation and choose Properties
from the pop-up menu.

This opens the workstation in the Properties - Workstation in
Database window.

3. Make your changes in the Properties - Workstation in Database
window. For information about the Properties - Workstation in
Database window, see “Creating a Workstation in the Database”
on page 192.

4. When you are finished in the Properties - Workstation in
Database window, do one of the following:

¶ Click the OK button to save the workstation in the database
and close the Properties - Workstation in Database window.

¶ Click the Cancel button to close the Properties - Workstation
in Database window without saving the workstation in the
database.

Deleting Workstations in the Database
To delete workstations in the database, follow these steps:

1. Run a list of workstations that contains the workstation you want
to delete. See “Creating a Workstation in the Database” on
page 192 for more information.

2. In the list results, do one of the following:

¶ To delete one workstation, right-click the workstation.

¶ To delete multiple workstations in a range, hold down the
Shift key, click the first and last workstations in the range,
then right-click on of the selected workstations.

¶ To delete multiple workstations that are not in a range, hold
down the Ctrl key, click on each workstation, then
right-click one of the selected workstations.

3. Choose Delete from the pop-up menu. A message is displayed
for each workstation asking for confirmation.

4. Click the OK button to delete the workstation in the database or
click the Cancel button to cancel the delete operation.
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Creating a Workstation in the Database by Copying
Another Workstation

To create a new workstation in the database using a copy of another
workstation, follow these steps:

1. Run a list of workstations that contains the workstation you want
to copy. See “Displaying a List of Workstations in the Database”
on page 198 for more information.

2. In the list results, right-click the workstation you want to copy
and choose Create another from the pop-up menu.

This displays a copy of the workstation in the Properties -
Workstation in Database window.

3. Change the Workstation name text box to the name of the new
workstation.

4. Make other changes as needed to define the new workstation.
For information about the Properties - Workstation in Database
window, see “Creating a Workstation in the Database” on
page 192.

5. When you are finished in the Properties - Workstation in
Database window, do one of the following:

¶ Click the OK button to save the workstation in the database
and close the Properties - Workstation in Database window.

¶ Click the Cancel button to close the Properties - Workstation
in Database window without saving the workstation in the
database.

Managing Workstation Classes in the Database
A workstation class is a group of workstations. Any number of
workstations can be placed in a class. Job streams and jobs can be
assigned to execute on a workstation class, making replication across
many workstations easy.
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If a job stream is defined on a workstation class then each job added
to the job stream must be defined either on a single workstation or
on the exact same workstation class that the job stream was defined
on.

Creating a Workstation Class in the Database
You create workstation classes in the database using the Properties -
Workstation Class window. To create a new workstation class, follow
these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Right-click the TWS controller icon and select New Workstation
Class from the pop-up menu.

This opens the General page of the Properties - Workstation
Class window.

3. On the General page of the Properties - Workstation Class
window, fill in the text box as follows:

Name Specifies the name of the workstation class. The name
must start with a letter and can contain alphanumeric
characters, dashes, and underscores. For non-expanded
databases, it can contain up to eight characters. For
expanded databases, it can contain up to 16 characters.

Figure 46. Properties - Workstation Class: General window.
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Note: Workstation class names must be unique and
cannot be the same as workstation and domain
names.

4. Select Workstations in the left panel of the Properties -
Workstation Class window. This opens the Workstations view.

5. To add individual workstations to the class, click the Find
Workstations button. For information about using the find
facility, refer to “Finding Objects in the Database” on page 125.

6. To add all of the workstations in the database to the workstation
class, click the Add All Workstations button.

7. To delete a workstation from the workstation class, select the
workstation in the Workstation List and click the Delete from
Table (X) button.

8. When you are finished in the Properties - Workstation Class
window, do one of the following:

¶ Click the OK button to close the Properties - Workstation
Class window and save the new workstation class in the
database.

¶ Click the Cancel button to close the Properties - Workstation
Class window without saving the workstation class in the
database.

Figure 47. Properties - Workstation Class: Workstations window.
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Displaying a List of Workstation Classes in the
Database

To display a list of workstation classes in the database, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below TWS until you see the icon for the
workstation class list you want to run. See “Creating a Database
List of Workstation Classes” on page 112 for information about
creating workstation class lists.

3. Select the workstation class list icon.

4. Click the Load List button on the toolbar or right-click the
workstation class list icon and select Load List from the pop-up
menu.

The list results are displayed in the right panel of the Job
Scheduling Console.

The following are descriptions of the column headings.

Name Specifies the name of the workstation class.

Figure 48. Workstation Class list window.
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Creator
Specifies the name of the user who created the
workstation class in the database.

Last Updated
Specifies the date the workstation class was last updated
in the database.

Displaying a Workstation Class in the Database
To display a workstation class in the database, follow these steps:

1. Run a list of workstation classes that contains the workstation
class you want to display. See “Displaying a List of Workstation
Classes in the Database” on page 205 for more information.

2. In the list results, double-click on the workstation class you want
to display or right-click the workstation class and choose
Properties from the pop-up menu.

This opens the workstation class in the Properties - Workstation
Class window. For information about the Properties - Workstation
Class window, see “Creating a Workstation Class in the
Database” on page 203.

3. Click the OK or the Cancel button to close the Properties -
Workstation Class window.

Modifying a Workstation Class in the Database
To modify a workstation class in the database, follow these steps:

1. Run a list of workstation classes that contains the workstation
class you want to modify. See “Displaying a List of Workstation
Classes in the Database” on page 205 for more information.

2. In the list results, double-click on the workstation class you want
to modify or right-click the workstation class and choose
Properties from the pop-up menu.

This opens the workstation class in the Properties - Workstation
Class window.

Managing Workstation Classes in the Database

206 Version 7.0



3. Make your changes in the Properties - Workstation Class
window. For information about the Properties - Workstation Class
window, see “Creating a Workstation Class in the Database” on
page 203.

4. When you are finished in the Properties - Workstation Class
window, do one of the following:

¶ Click the OK button to save the workstation class in the
database and close the Properties - Workstation Class
window.

¶ Click the Cancel button to close the Properties - Workstation
Class window without saving the workstation class in the
database.

Deleting Workstation Classes in the Database
To delete workstation classes in the database, follow these steps:

1. Run a list of workstation classes that contains the workstation
class you want to delete. See “Displaying a List of Workstation
Classes in the Database” on page 205 for more information.

2. In the list results, do one of the following:

¶ To delete one workstation class, right-click the workstation
class.

¶ To delete multiple workstation classes in a range, hold down
the Shift key, click the first and last workstation classes in
the range, then right-click one of the selected workstation
classes.

¶ To delete multiple workstation classes that are not in a range,
hold down the Ctrl key, click on each workstation class, then
right-click one of the selected workstation classes.

3. Choose Delete from the pop-up menu. A message is displayed
for each workstation class asking for confirmation.

4. Click the OK button to delete the workstation class in the
database or click the Cancel button to cancel the delete
operation.
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Managing Domains in the Database
A domain is a named group of TWS workstations, consisting of one
or more workstations and a domain manager acting as the
management hub. All domains have a parent domain, except for the
master domain.

Creating a Domain in the Database
You create domains in the database using the Properties - Domain
window. To create a new domain, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Right-click the TWS controller icon and select New Domain
from the pop-up menu.

This opens the Properties - Domain window.

3. In the Properties - Domain window, fill in the text boxes as
follows:

Domain Name
Specify the name of the domain. The name must start
with a letter and can contain alphanumeric characters,
dashes, and underscores. For non-expanded databases, it
can contain up to eight characters. For expanded
databases, it can contain up to 16 characters.

Note: Domain names must be unique and cannot be the
same as workstation and workstation class names.

Figure 49. Properties - Domain window.
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Description
Specify a description of the domain.

Parent Domain
Specify the name of the parent domain to which the
domain manager is linked. The default is the master
domain. For information about using the Find button,
refer to “Finding Objects in the Database” on page 125.

Domain Manager
Specify the name of the workstation that is the domain
manager. The domain manager must be a fault-tolerant
agent with Full Status and Resolve Dependencies
selected. Note that when creating a new domain, you can
specify a domain manager workstation that does not yet
exist. For information about using the Find button, refer
to “Finding Objects in the Database” on page 125.

4. When you are finished in the Properties - Domain window, do
one of the following:

¶ Click the OK button to close the Properties - Domain
window and save the new domain in the database.

¶ Click the Cancel button to close the Properties - Domain
window without saving the domain in the database.

Displaying a List of Domains in the Database
To display a list of domains in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below TWS until you see the icon for the
domain list you want to run. See “Creating a Database List of
Domains” on page 113 for information about creating domain
lists.

3. Select the domain list icon.

4. Click the Load List button on the toolbar or right-click the
domain list icon and select Load List from the pop-up menu.
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The list results are displayed in the right panel of the Job
Scheduling Console. The following are descriptions of the
column headings.

Name Specifies the name of the domain.

Parent Domain
Specifies the name of the domain above this domain in
the hierarchy.

Domain Manager
Specifies the name of the workstation that is the manager
of this domain.

Creator
Specifies the name of the user who created the domain in
the database.

Last Updated
Specifies the date the domain was last updated in the
database.

Displaying a Domain in the Database
To display a domain in the database, follow these steps:

1. Run a list of domains that contains the domain you want to
display. See “Displaying a List of Domains in the Database” on
page 209 for more information.

2. In the list results, double-click on the domain you want to
display or right-click the domain and choose Properties from the
pop-up menu.

This opens the domain in the Properties - Domain window. For
information about the Properties - Domain window, see “Creating
a Domain in the Database” on page 208.

3. Click the OK or the Cancel button to close the Properties -
Domain window.

Modifying a Domain in the Database
To modify a domain in the database, follow these steps:
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1. Run a list of domains that contains the domain you want to
modify. See “Displaying a List of Domains in the Database” on
page 209 for more information.

2. In the list results, double-click on the domain you want to
modify or right-click the domain and choose Properties from the
pop-up menu.

This opens the domain in the Properties - Domain window.

3. Make your changes in the Properties - Domain window. For
information about the Properties - Domain window, see “Creating
a Domain in the Database” on page 208.

4. When you are finished in the Properties - Domain window, do
one of the following:

¶ Click the OK button to save the domain in the database and
close the Properties - Domain window.

¶ Click the Cancel button to close the Properties - Domain
window without saving the domain in the database.

Deleting Domains in the Database
To delete domains in the database, follow these steps:

1. Run a list of domains that contains the domain you want to
delete. See “Displaying a List of Domains in the Database” on
page 209 for more information.

2. In the list results, do one of the following:

¶ To delete one domain, right-click the domain.

¶ To delete multiple domains in a range, hold down the Shift
key, click the first and last domains in the range, then
right-click one of the selected domains.

¶ To delete multiple domains that are not in a range, hold
down the Ctrl key, click on each domain, then right-click
one of the selected domains.

3. Select Delete from the pop-up menu. A message is displayed for
each domain asking for confirmation.
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4. Click the OK button to delete the domain in the database or
click the Cancel button to cancel the delete operation.

Managing Resources in the Database
Resources represent any type of resources on your system such as
tape drives, communication lines, databases, or printers, that are
needed to run a job. Resources can be physical or logical. After
defining a resource in the TWS database, it can be used as a
dependency for jobs and job streams that run on the workstation or
workstation class for which the resource is defined.

For example, you can define a resource called TAPES with a value
of 2 and define jobs that require both tape drives as a dependency.
Jobs with this dependency cannot run concurrently, because each
time a job is run the TAPES resource is in use.

Creating a Resource in the Database
You create resources in the database using the Properties - Resource
in Database window. To create a new resource, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Click the New Resource button on the toolbar or right-click the
TWS controller icon and select New Resource from the pop-up
menu. This displays the Properties - Resource in Database
window.

3. In the Properties - Resource in Database window, fill in the text
boxes as follows:

Figure 50. Properties - Resource in Database window.
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Name Specify the name of the resource. The name must start
with a letter and can contain alphanumeric characters,
dashes, and underscores. The name can contain up to
eight characters.

Description
Specify a description of the resource.

Quantity
Specify the number of available resource units. Values
can be 0 through 1024.

Workstation
Specify the name of the workstation or workstation class
on which the resource is used. You can type a name
directly or you can click the Find button and select a
workstation or workstation class from a list. For
information about using the Find button, refer to
“Finding Objects in the Database” on page 125.

4. When you are finished in the Properties - Resource in Database
window, do one of the following:

¶ Click the OK button to close the Properties - Resource In
Database Window and save the new resource in the database.

¶ Click the Cancel button to close the Properties - Resource In
Database Window without saving the resource in the
database.

Displaying a List of Resources in the Database
To display a list of resources in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below TWS until you see the icon for the
resource list you want to run. See “Creating a Database List of
Resources” on page 117 for information about creating resource
lists.

3. Select the resource list icon.
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4. Click the Load List button on the toolbar or right-click the
resource list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console.

The following are descriptions of the column headings.

Workstation
Specifies the name of the workstation or workstation
class on which the resource is used.

Resource
Specifies the name of the resource.

Quantity
Specifies the number of available resource units.

Displaying a Resource in the Database
To display a resource in the database, follow these steps:

1. Run a list of resources that contains the resource you want to
display. See “Displaying a List of Resources in the Database” on
page 213 for more information.

Figure 51. Resource list window.

Managing Resources in the Database

214 Version 7.0



2. In the list results, double-click on the resource you want to
display or right-click the resource and choose Properties from
the pop-up menu.

This opens the resource in the Properties - Resource In Database
window. For information about the Properties - Resource In
Database window, see “Creating a Resource in the Database” on
page 212.

3. Click the OK or the Cancel button to close the Properties -
Resource In Database window.

Modifying a Resource in the Database
To modify a resource in the database, follow these steps:

1. Run a list of resources that contains the resource you want to
modify. See “Displaying a List of Resources in the Database” on
page 213 for more information.

2. In the list results, double-click on the resource you want to
modify or right-click the resource and choose Open from the
pop-up menu.

This opens the resource in the Properties - Resource In Database
Window.

3. Make your changes in the Properties - Resource In Database
Window. For information about the Properties - Resource In
Database Window, see “Creating a Resource in the Database” on
page 212.

4. When you are finished in the Properties - Resource In Database
Window, do one of the following:

¶ Click the OK button to save the resource in the database and
close the Properties - Resource In Database Window.

¶ Click the Cancel button to close the Properties - Resource In
Database Window without saving the resource in the
database.

Deleting Resources in the Database
To delete resources in the database, follow these steps:
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1. Run a list of resources that contains the resource you want to
delete. See “Displaying a List of Resources in the Database” on
page 213 for more information.

2. In the list results, do one of the following:

¶ To delete one resource, right-click the resource.

¶ To delete multiple resources in a range, hold down the Shift
key, click the first and last resources in the range, then
right-click one of the selected resources.

¶ To delete multiple resources that are not in a range, hold
down the Ctrl key, click on each resource, then right-click
one of the selected resources.

3. Select the Delete command from the pop-up menu. A message is
displayed for each resource asking for confirmation.

4. Click the OK button to delete the resource in the database or
click the Cancel button to cancel the delete operation.

Creating a Resource in the Database by Copying
Another Resource

To create a new resource in the database using a copy of another
resource, follow these steps:

1. Run a list of resources that contains the resource you want to
copy. See “Displaying a List of Resources in the Database” on
page 213 for more information.

2. In the list results, right-click the resource you want to copy and
choose Create another from the pop-up menu.

This displays a copy of the resource in the Properties - Resource
In Database Window.

3. Change the Name text box to the name of the new resource.

4. Change the other text boxes as needed to define the new
resource. For information about the Properties - Resource In
Database Window, see “Creating a Resource in the Database” on
page 212.
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5. When you are finished in the Properties - Resource In Database
Window, do one of the following:

¶ Click the OK button to save the resource in the database and
close the Properties - Resource In Database Window.

¶ Click the Cancel button to close the Properties - Resource In
Database Window without saving the resource in the
database.

Managing Prompts in the Database
Prompts can be used as dependencies for jobs and job streams. A
prompt must be answered affirmatively for the dependent job or job
stream to launch. For example, you can issue a prompt to make sure
that a printer is online before a job that prints a report runs.

There are two types of prompts:

¶ ad hoc prompts

¶ predefined prompt

An ad hoc prompt is defined within the properties of a job or job
stream and is unique to that job or job stream. A predefined prompt
is defined in the TWS database and can be used by any job or job
stream.

Creating a Prompt in the Database
You create prompts in the database using the Properties - Prompt
window. To create a new prompt, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Right-click the TWS controller icon and select New Prompt
from the pop-up menu. This opens the Properties - Prompt
window.
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3. In the Properties - Prompt window, fill in the text boxes as
follows:

Name Specify the name of the prompt. The name must start
with a letter and can contain alphanumeric characters,
dashes, and underscores. The name can contain up to
eight characters.

Text

Specify the text of a prompt. The default behavior of a
prompt is to display a message and wait for a reply. If
the string begins with a colon (:), the message is
displayed but no reply is necessary. If the string begins
with an exclamation mark (!), the message is not
displayed but it requires a reply.

You can include backslash n (\n) within the text to create
a new line.

4. When you are finished in the Properties - Prompt window, do
one of the following:

¶ Click the OK button to close the Properties - Prompt
window and save the new prompt in the database.

¶ Click the Cancel button to close the Properties - Prompt
window without saving the prompt in the database.

Displaying a List of Prompts in the Database
To display a list of prompts in the database, follow these steps:

Figure 52. Properties - Prompt window.
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1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below TWS until you see the icon for the
prompt list you want to run. See “Creating a Database List of
Prompts” on page 119 for information about creating prompt lists.

3. Select the prompt list icon.

4. Click the Load List button on the toolbar or right-click the
prompt list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console.

The following are descriptions of the column headings.

Name Specifies the name of the prompt.

Text Specifies the text of the prompt.

Displaying a Prompt in the Database
To display a prompt in the database, follow these steps:

Figure 53. Prompts list window.
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1. Run a list of prompts that contains the prompt you want to
display. See “Displaying a List of Prompts in the Database” on
page 218 for more information.

2. In the list results, double-click on the prompt you want to display
or right-click the prompt and choose Open from the pop-up
menu.

This opens the prompt in the Properties - Prompt window. For
information about the Properties - Prompt window, see “Creating
a Prompt in the Database” on page 217.

3. Click the OK or the Cancel button to close the Properties -
Prompt window.

Modifying a Prompt in the Database
To modify a prompt in the database, follow these steps:

1. Run a list of prompts that contains the prompt you want to
modify. See “Displaying a List of Prompts in the Database” on
page 218 for more information.

2. In the list results, double-click on the prompt you want to modify
or right-click the prompt and choose Open from the pop-up
menu.

This opens the prompt in the Properties - Prompt window.

3. Make your changes in the Properties - Prompt window. For
information about the Properties - Prompt window, see “Creating
a Prompt in the Database” on page 217.

4. When you are finished in the Properties - Prompt window, do
one of the following:

¶ Click the OK button to save the prompt in the database and
close the Properties - Prompt window.

¶ Click the Cancel button to close the Properties - Prompt
window without saving the prompt in the database.

Deleting Prompts in the Database
To delete prompts in the database, follow these steps:
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1. Run a list of prompts that contains the prompt you want to
delete. See “Displaying a List of Prompts in the Database” on
page 218 for more information.

2. In the list results, do one of the following:

¶ To delete one prompt, right-click the prompt.

¶ To delete multiple prompts in a range, hold down the Shift
key, click the first and last prompts in the range, then
right-click one of the selected prompts.

¶ To delete multiple prompts that are not in a range, hold
down the Ctrl key, click on each prompt, then right-click
one of the selected prompts.

3. Choose Delete from the pop-up menu. A message is displayed
for each prompt asking for confirmation.

4. Click the OK button to delete the prompt in the database or click
the Cancel button to cancel the delete operation.

Managing Parameters in the Database
Parameters are useful to substitute values into your jobs and job
streams. Since parameters are stored in the TWS database, all jobs
and job streams that use the particular parameter are updated
automatically when the value changes. For scheduling, a parameter
can be used as a substitute for all or part of:

¶ File dependency path names

¶ Text for prompts

¶ Logon, command, and script file names

When using a parameter in a job script, the value is substituted at
run time. In this case, the parameter must be defined on the
workstation where it will be used. Parameters cannot be used when
scripting Extended Agent jobs.
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Note: Use caution when renaming a parameter, it may be part of a
dependency for a job scheduler object in the database. If this is the
case, and you rename it, any action you perform that refers to the
old name will return an error.

Creating a Parameter in the Database
You create parameters in the database using the Properties -
Parameter window. To create a new parameter, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Right-click the TWS controller icon and select New Parameter
from the pop-up menu.

This opens the Properties - Parameter window.

3. In the Properties - Parameter window, fill in the text boxes as
follows:

Name Specify the name of the parameter. The name must start
with a letter and can contain alphanumeric characters,
dashes, and underscores. The name can contain up to
eight characters.

Value Specify the value assigned to the parameter. Do not
include the names of other parameters.

4. When you are finished in the Properties - Parameter window, do
one of the following:

¶ Click the OK button to close the Properties - Parameter
window and save the new parameter in the database.

Figure 54. Properties - Parameter window.
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¶ Click the Cancel button to close the Properties - Parameter
window without saving the parameter in the database.

Displaying a List of Parameters in the Database
To display a list of parameters in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below the TWS controller icon until you
see the icon for the parameter list you want to run. See “Creating
a Database List of Prompts” on page 119 for information about
creating parameter lists.

3. Select the parameter list icon.

4. Click the Load List button on the toolbar or right-click the
parameter list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console.

The following are descriptions of the column headings.

Figure 55. Parameter list window.
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Name Specifies the name of the parameter.

Value Specifies the value of the parameter.

Displaying a Parameter in the Database
To display a parameter in the database, follow these steps:

1. Run a list of parameters that contains the parameter you want to
display. See “Displaying a List of Parameters in the Database” on
page 223 for more information.

2. In the list results, double-click on the parameter you want to
display or right-click the parameter and choose Open from the
pop-up menu.

This opens the parameter in the Properties - Parameter window.
For information about the Properties - Parameter window, see
“Creating a Parameter in the Database” on page 222.

3. Click the OK or the Cancel button to close the Properties -
Parameter window.

Modifying a Parameter in the Database
To modify a parameter in the database, follow these steps:

1. Run a list of parameters that contains the parameter you want to
modify. See “Displaying a List of Parameters in the Database” on
page 223 for more information.

2. In the list results, double-click on the parameter you want to
modify or right-click the parameter and choose Open from the
pop-up menu.

This opens the parameter in the Properties - Parameter window.

3. Make your changes in the Properties - Parameter window. For
information about the Properties - Parameter window, see
“Creating a Parameter in the Database” on page 222.

4. When you are finished in the Properties - Parameter window, do
one of the following:

¶ Click the OK button to save the parameter in the database
and close the Properties - Parameter window.
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¶ Click the Cancel button to close the Properties - Parameter
window without saving the parameter in the database.

Deleting Parameters in the Database
To delete parameters in the database, follow these steps:

1. Run a list of parameters that contains the parameter you want to
delete. See “Displaying a List of Parameters in the Database” on
page 223 for more information.

2. In the list results, do one of the following:

¶ To delete one parameter, right-click the parameter.

¶ To delete multiple parameters in a range, hold down the
Shift key, click the first and last parameters in the range,
then right-click one of the selected parameters.

¶ To delete multiple parameters that are not in a range, hold
down the Ctrl key, click on each parameter, then right-click
one of the selected parameters.

3. Choose Delete from the pop-up menu. A message is displayed
for each parameter asking for confirmation.

4. Click the OK button to delete the parameter in the database or
click the Cancel button to cancel the delete operation.

Managing Users in the Database
The users for whom TWS will launch jobs must be defined in the
database. This is required for Windows NT users only.

Creating a User in the Database
You create users in the database using the Properties - NT User
window. To create a new user, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Right-click the TWS controller icon and select New User from
the pop-up menu.

This opens the Properties - NT User window.
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3. In the Properties - NT User window, fill in the text boxes as
follows:

User Name

Specify the Windows NT user name. The name can
contain up to 47 characters.

Note that Windows NT user names are case-sensitive.
Also, the user must be able to log on to the workstation
on which TWS will launch jobs, and must have the right
to Log on as batch.

If the name is not unique in Windows NT, it is
considered to be a local user, a domain user, or a trusted
domain user, in that order.

NT Domain
Specify the Windows NT domain of this user. This field
is optional. If the name is not fully qualified (that is, no
Windows NT domain is entered) or is not unique in
Windows NT, it is considered to be a local user, a
domain user, or a trusted domain user, in that order.

NT Workstation
Specify the name of the TWS workstation on which the
user is allowed to launch jobs. For information about
using the Find button, refer to “Finding Objects in the
Database” on page 125. The default is all workstations.

Figure 56. Properties - NT User window.
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New Password
Specify a new user’s password as defined on the
Windows NT computer.

Confirmation
Specify the user’s password again for confirmation.

4. When you are finished in the Properties - NT User window, do
one of the following:

¶ Click the OK button to close the Properties - NT User
window and save the new user in the database.

¶ Click the Cancel button to close the Properties - NT User
window without saving the user in the database.

Displaying a List of Users in the Database
To display a list of users in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller branch.

2. Expand the branches below TWS until you see the icon for the
user list you want to run. See “Creating a Database List of
Users” on page 121 for information about creating user lists.

3. Select the user list icon.

4. Click the Load List button on the toolbar or right-click the user
list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console.
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The following are descriptions of the column headings.

NT Domain\User
Specifies the Windows NT domain and the name of the
user.

NT Workstation
Specifies the name of the workstation on which the user
will launch jobs.

Displaying a User in the Database
To display a user in the database, follow these steps:

1. Run a list of users that contains the user you want to display. See
“Displaying a List of Users in the Database” on page 227 for
more information.

2. In the list results, double-click on the user you want to display or
right-click the user and choose Open from the pop-up menu.

This opens the user in the Properties - NT User window. For
information about the Properties - NT User window, see
“Creating a User in the Database” on page 225.

Figure 57. Users list window.
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3. Click the OK or the Cancel button to close the Properties - NT
User window.

Modifying a User in the Database
To modify a user in the database, follow these steps:

1. Run a list of users that contains the user you want to modify. See
“Displaying a List of Users in the Database” on page 227 for
more information.

2. In the list results, double-click on the user you want to modify or
right-click the user and choose Open from the pop-up menu.

This opens the user in the Properties - NT User window.

3. Make your changes in the Properties - NT User window. For
information about the Properties - NT User window, see
“Creating a User in the Database” on page 225.

4. When you are finished in the Properties - NT User window, do
one of the following:

¶ Click the OK button to save the user in the database and
close the Properties - NT User window.

¶ Click the Cancel button to close the Properties - NT User
window without saving the user in the database.

Deleting Users in the Database
To delete users in the database, follow these steps:

1. Run a list of users that contains the user you want to delete. See
“Displaying a List of Users in the Database” on page 227 for
more information.

2. In the list results, do one of the following:

¶ To delete one user, right-click the user.

¶ To delete multiple users in a range, hold down the Shift key,
click the first and last users in the range, then right-click one
of the selected users.

¶ To delete multiple users that are not in a range, hold down
the Ctrl key, click on each user, then right-click one of the
selected users.
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3. Choose Delete from the pop-up menu. A message is displayed
for each user asking for confirmation.

4. Click the OK button to delete the user in the database or click
the Cancel button to cancel the delete operation.

Changing User Passwords
To change a user password, follow these steps:

1. From the main console, click the connector in the left pane.

2. Click Selected from the menu.

3. Click Change Password.

4. Click the search button to specify a name in the User Name text
box.

5. Enter the password in the New Password text box.

6. Reenter the password in the Confirmationtext box.

7. Click OK.

Managing Calendars in the Database
A calendar is a list of scheduling dates defined in the TWS database.
Assigning a calendar run cycle to a job stream causes that job stream
to be executed on the days specified in the calendar. Since a
calendar is defined to the TWS database, it can be assigned to
multiple job streams.

You can create as many calendars as required to meet your
scheduling needs. For example, you can define a calendar named
PAYDAYS that contains a list of pay dates, a calendar named
MONTHEND that contains a list of month ending dates, and a
calendar named HOLIDAYS that contains a list of your company’s
holidays.

The Holidays Calendar
The HOLIDAYS calendar is used to determine non-workdays for
the purpose of defining run cycles for your job streams. You should
create a HOLIDAYS calendar with the dates of your holidays.
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Creating a Calendar in the Database
You create calendars in the database using the Properties - Calendar
window. To create a new calendar, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the
TWS controller branch.

2. Right-click the TWS controller icon and select New Calendar
from the pop-up menu.

This opens the Properties - Calendar window.

3. In the Properties - Calendar window, fill in the text boxes as
follows:

Name Specify the name of the calendar. The name must start
with a letter and can contain alphanumeric characters,
dashes, and underscores. The name can contain up to
eight characters.

Description
Specify a description of the calendar.

4. Click the Define Calendar... button to add dates to the
calendar. This opens the Monthly Yearly Calendar window.

Figure 58. Properties - Calendar window.
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5. Select Monthly or Yearly in the left panel of the window to
view a monthly or yearly calendar. Use the arrow buttons above
and below the calendar to change the month and year.

6. To add a specific date to the calendar, click on the date in the
calendar view.

7. To add a specific day of the month, select Day of Month from
the Select menu. This opens the Day of Month window.

Figure 59. Monthly Yearly Calendar window.

Figure 60. Day of Month window.
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8. To add a day of the month by number, choose the day number
in the Day drop-down list. To add the last day of the month,
check the Last Day of Month option.

9. Select start and end dates for the calendar by selecting the
month and year from the Start and End drop-down lists. The
days you specified are selected for every month in this range.

10. Click the OK button to close the Day of Month window and
select the dates. Click the Cancel button to close the Day of
Month window without selecting the dates.

11. Click the OK button to close the Monthly Yearly Calendar
window and add the dates to the calendar. Click the Cancel
button to close the Day of Month window without adding the
dates to the calendar.

12. When you are finished in the Properties - Calendar window, do
one of the following:

¶ Click the OK button to close the Properties - Calendar
window and save the new calendar in the database.

¶ Click the Cancel button to close the Properties - Calendar
window without saving the calendar in the database.

Displaying a List of Calendars in the Database
To display a list of calendars in the database, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller branch.

2. Expand the branches below TWS until you see the icon for the
calendar list you want to run. See “Creating a Database List of
Calendars” on page 123 for information about creating calendar
lists.

3. Select the calendar list icon.

4. Click the Load List button on the toolbar or right-click the
calendar list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console.
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The following are descriptions of the column headings.

Name Specifies the name of the calendar.

Description
Provides a description of the calendar.

Viewing Calendar Properties in the Database
To display a calendar in the database, follow these steps:

1. Run a list of calendars that contains the calendar you want to
display. See “Displaying a List of Calendars in the Database” on
page 233 for more information.

2. In the list results, double-click on the calendar you want to
display or right-click the calendar and choose Properties from
the pop-up menu.

This opens the calendar in the Properties - Calendar window. For
information about the Properties - Calendar window, see
“Creating a Calendar in the Database” on page 231.

3. Click the OK or the Cancel button to close the Properties -
Calendar window.

Figure 61. Calendars list window.
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Modifying a Calendar in the Database
To modify a calendar in the database, follow these steps:

1. Run a list of calendars that contains the calendar you want to
modify. See “Displaying a List of Calendars in the Database” on
page 233 for more information.

2. In the list results, double-click on the calendar you want to
modify or right-click the calendar and choose Properties from
the pop-up menu.

This opens the calendar in the Properties - Calendar window.

3. Make your changes in the Properties - Calendar window. For
information about the Properties - Calendar window, see
“Creating a Calendar in the Database” on page 231.

4. When you are finished in the Properties - Calendar window, do
one of the following:

¶ Click the OK button to save the calendar in the database and
close the Properties - Calendar window.

¶ Click the Cancel button to close the Properties - Calendar
window without saving the calendar in the database.

Deleting Calendars in the Database
To delete calendars in the database, follow these steps:

1. Run a list of calendars that contains the calendar you want to
delete. See “Displaying a List of Calendars in the Database” on
page 233 for more information.

2. In the list results, do one of the following:

¶ To delete one calendar, right-click the calendar.

¶ To delete multiple calendars in a range, hold down the Shift
key, click the first and last calendars in the range, then
right-click one of the selected calendars.

¶ To delete multiple calendars that are not in a range, hold
down the Ctrl key, click on each calendar, then right-click
one of the selected calendars.

Managing Calendars in the Database

235Tivoli Workload Scheduler User’s Guide

7.
T

W
S

D
atab

ase
Tasks



3. Choose Delete from the pop-up menu. A message is displayed
for each calendar asking for confirmation.

4. Click the OK button to delete the calendar in the database or
click the Cancel button to cancel the delete operation.
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TWS Plan Tasks

Using Plan Lists
Plan lists display objects in the TWS plan. When you create a list,
you give it a name and specify filtering criteria. When you run a list,
it displays a filtered list of objects in the plan. Each list you create is
represented by an icon in the tree view of the Job Scheduling
Console.

You can create groups to organize your lists. After installation there
are a default set of basic plan lists in a group named Default Plan
Lists.

Creating a Group for Plan Lists
To create a group for plan lists, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. From the TWS branch, highlight the group you want to contain
this list.

3. Click the Create a Group of Lists button on the toolbar or
right-click the TWS controller icon and select Create Group...
from the pop-up menu.

To create a group in an existing group, select the group and click
the Create a Group of Lists button on the toolbar or right-click
the existing group icon and select Create Group... from the
pop-up menu.

8
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This displays the Properties - Group of Lists window.

4. In the Properties window, fill in the text box as follows:

Name Specify the name of the list group. The name can contain
up to 40 characters, starting with a letter.

5. Click the OK button to close the window and save the new
group.

Creating a Plan List of Workstations
To create a plan list that displays workstations, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. From the TWS branch, highlight the group you want to contain
this list.

3. Click the List Workstations in Plan button on the toolbar.
Alternatively, you can right-click the TWS controller icon or
group icon and choose Create Plan List > Workstation from
the pop-up menu.

This displays the Properties - Plan Workstation List window.

Figure 62. Properties - Group of Lists window.

Figure 63. Properties - Plan Workstation List window.
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4. Type a name for the list in the Name text box.

5. To have the list results refreshed automatically, click the
Periodic Refresh check box and specify a refresh interval in
seconds in the Period (secs) text box.

6. To filter the list results, specify a workstation name in the
Workstation Name text box and a TWS domain name in the
Domain Name text box. The workstation and domain names can
contain the following wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving the text box blank results in an unfiltered list.

7. When you finish making your entries, do one of the following:

¶ Click the OK button to save the list and close the window.
The list icon is added to the group you selected.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

Creating a Plan List of Domain Status
To create a plan list to display domains, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. From the TWS branch, highlight the group you want to contain
this list.

3. Right-click the TWS controller icon or group icon and choose
Create Plan List > Domain Status from the pop-up menu.

This displays the Properties - Domain Status List window.
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4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and specify a refresh interval in
seconds in the Period (secs) text box.

6. To filter the list results, specify a domain name in the Domain
Name text box. The domain name can contain the following
wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving the text box blank results in an unfiltered list.

7. When you finish making your entries, do one of the following:

¶ Click the OK button to save the list and close the window.
The list icon is added to the group you selected.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

Creating a Plan List of Job Stream Instances
To create a plan list to display job stream instances, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. From the TWS branch, highlight the group you want to contain
this list.

Figure 64. Properties - Domains Status List window.
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3. Click the List Job Stream Instances button on the toolbar.
Alternatively, you can right-click the TWS controller icon or
group icon and choose Create Plan List > Job Stream
Instance... from the pop-up menu.

This displays the General view of a Properties - Job Stream
Instance List window.

4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and specify a refresh interval in
seconds in the Period (secs) text box.

6. To filter the list results, enter criteria as follows:

Job Stream
Specify a job stream name.

Workstation Name
Specify a workstation name.

Start Time
Specify a range for the start date and time of the job
stream instances you want to display.

Figure 65. Properties - Job Stream Instance List: General window.
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From Date
Use the Date and Time text boxes to specify the
beginning of a range of time. Only job streams
that start execution within this range are
displayed.

To Date
Use the Date and Time text boxes to specify the
end of a range of time. Only job streams that
start execution within this range are displayed.

Finish Time
Specify a range for the finish date and time of the job
stream instances you want to display.

From Date
Use the Date and Time text boxes to specify the
beginning of a range of time. Only job streams
that finish execution within this range are
displayed.

To Date
Use the Date and Time text boxes to specify the
end of a range of time. Only job streams that
finish execution within this range are displayed.

Status To use the Job Scheduling Console status to filter job
stream instances, select this option and select the status
type from the drop-down list.

Internal Status
To use TWS internal status to filter job stream instances,
select this option and select the status type from the
drop-down list.

Priority
Use the From and To text boxes to specify a priority
range of job streams to display. Only job streams with
priorities within the range are displayed. Possible priority
values are 0 through 101, where 101 is the highest
priority. Click Hold to select priority 0, High to select
priority 100, or Go to select priority 101.
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7. To filter job stream instances using dependencies, click
Dependencies in the left window of the Properties - Job Stream
Instance List window. This displays the Dependencies window.

8. Use this window to define a list of jobs from the plan based on
dependency types. Only job stream instances with the specified
dependencies are displayed. Note that all the fields in this
window act as filters, so that all fields specified must be valid
for a job stream to be chosen for display.

For example, to display all job streams with a file dependency,
specify an asterisk (*) in the File Dependency / File Name field.

To display all job streams with both a file and a prompt
dependency, specify an asterisk (*) in the File Dependency /
File Name field and in the Prompt Dependency / Prompt
Name field. Note that in this case, only job streams with both a
file and a prompt dependency are displayed. Job Streams with
only prompt dependencies or only file dependencies are not
displayed.

Job/Job Stream Dependency
Specifies the name of a job or job stream dependency.

Workstation
Specify the name of a workstation.

Job Stream
Specify the name of a job stream.

Job Specify the name of a job.

Resource Dependency
Specifies the name of a resource dependency.

Workstation
Specify the name of a workstation.

Name Specify the name of a resource.

File Dependency
Specifies the name of a file dependency.

Workstation
Specify the name of a workstation.
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File Name
Specify the name of a file.

Prompt Dependency
Specifies the name of a prompt dependency.

Name Specify the name of a prompt.

Prompt Number
Specify the number of a prompt.

9. When you finish making your entries, do one of the following:

¶ Click the OK button to save the list and close the window.
The list icon is added to the group you selected.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

Creating a Plan List of Job Instances
To create a plan list to display job instances, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the
TWS controller icon.

2. From the TWS branch, highlight the group you want to contain
this list.

3. Click the List Job Instances icon on the toolbar. Alternatively,
you can right-click the TWS controller icon or group icon and
choose Create Plan List > Job Instance... from the pop-up
menu.

This displays the Properties - Job Instance List window.

Using Plan Lists

244 Version 7.0



4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and specify a refresh interval in
seconds in the Period (secs) text box.

6. To filter the job instances using general criteria, click General
in the left pane. This displays the General window.

Job Name
Specify a job name.

Job Stream
Specify a job stream.

Workstation (Job Stream)
Specify a workstation name.

Login Specify a login name.

Status To use Job Scheduling Console status to filter job
instances, select this option and select the status type
from the drop-down list.

Figure 66. Properties - Job Instance List: General window.
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Internal Status
To use TWS internal status to filter job instances, select
this option and select the status type from the
drop-down list.

Recovery Options
Select a job recovery option using the option buttons.
Valid options are Stop, Continue, Rerun, and None.

Priority
Use the From and To text boxes to specify a priority
range of job instances to display. Only jobs with
priorities within the range are displayed. Possible
priority values are 0 through 101, where 101 is the
highest priority. Click Hold to select priority 0, High to
select priority 100, or Go to select priority 101.

7. To filter the job instances using time restrictions, click Time
Restrictions in the left pane. This brings up the Time
Restrictions window.

Start Time
Specify a range for the start date and time of the job
instance.

From Date
Use the Date and Time text boxes to specify
the beginning of a range of time. Only job
instances that start execution within this range
are displayed.

To Date
Use the Date and Time text boxes to specify
the end of a range of time. Only job instances
that start execution within this range are
displayed.

Finish Time
Specify a range for the finish date and time of a job
instance.

From Date
Use the Date and Time text boxes to specify
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the beginning of a range of time. Only job
instances that finish execution within this range
are displayed.

To Date
Use the Date and Time text boxes to specify
the end of a range of time. Only job instances
that finish execution within this range are
displayed.

8. To filter the job instances using dependencies, click
Dependencies in the left window of the window. This displays
the Dependencies window.

9. Use this window to define a list of jobs from the plan based on
dependency types. Note that all the fields in this window act as
filters, so that all fields specified must be valid for a job
instance to be chosen for display.

For example, to display all jobs with a file dependency, specify
an asterisk (*) in the File Dependency / File Name field.

To display all jobs with both a file and a prompt dependency,
specify an asterisk (*) in the File Dependency / File Name
field and in the Prompt Dependency / Prompt Name field.
Note that in this case, only jobs with both a file and a prompt
dependency are displayed. Jobs with only prompt dependencies
or only file dependencies are not displayed.

Job/Job Stream Dependency
Specifies the name of a job or job stream dependency.

Workstation
Specify the name of a workstation.

Job Stream
Specify the name of a job stream.

Job Specify the name of a job.

Resource Dependency
Specifies the name of a resource dependency.

Workstation
Specify the name of a workstation.
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Name Specify the name of a resource.

File Dependency
Specifies the name of a file dependency.

Workstation
Specify the name of a workstation.

File Name
Specify the name of a file.

Prompt Dependency
Specifies the name of a prompt dependency.

Name Specify the name of a prompt.

Prompt Number
Specify the number of a prompt.

10. When you finish making your entries, do one of the following:

¶ Click the OK button to save the list and close the window.
The list icon is added to the group you selected.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

Creating a Plan List of Resources
To create a plan list to display resources, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. From the TWS branch, highlight the group you want to contain
this list.

3. Click the List Resources in Plan button on the toolbar.
Alternatively, you can right-click the TWS controller icon or
group icon and choose Create Plan List > Resource... from the
pop-up menu.

This displays the Properties - Plan Resource List window.
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4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and specify a refresh interval in
seconds in the Period (secs) text box.

6. To filter the list results, specify a resource name in the Resource
Name text box and a workstation name in the Workstation
Name text box. The resource name and workstation name can
contain the following wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving the text box blank results in an unfiltered list.

7. When you finish making your entries, do one of the following:

¶ Click the OK button to save the list and close the window.
The list icon is added to the group you selected.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

Creating a Plan List of Prompts
To create a plan list to display prompts, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

Figure 67. Properties - Plan Resource List window.
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2. From the TWS branch, highlight the group you want to contain
this list.

3. Right-click the TWS controller icon or group icon and choose
Create Plan List > Prompt Status from the pop-up menu.

This displays the Properties - Prompt Status List window.

4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and specify a refresh interval in
seconds in the Period (secs) text box.

6. To filter the list results, specify a prompt name in the Prompt
Name text box. The prompt name can contain the following
wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving the text box blank results in an unfiltered list.

7. To filter the list using prompt status, use the Status check boxes
to select the status values. The status values are:

Asked The prompt has been asked, but not answered.

Figure 68. Properties Prompt Status List window.
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Not Asked
The prompt has not been asked.

Answered Yes
The prompt has been answered with a “yes” response.

Answered No
The prompt has been answered with a “no” response.

If no status values are selected, prompts with all status values are
displayed.

8. When you finish making your entries, do one of the following:

¶ Click the OK button to save the list and close the window.
The list icon is added to the group you selected.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

Creating a Plan List of Files
To create a plan list to display Files, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. From the TWS branch, highlight the group you want to contain
this list.

3. Right-click the TWS controller icon or group icon and choose
Create Plan List > File Status from the pop-up menu.

This displays the Properties - File Status List window.
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4. Type a name for the list in the Name text box.

5. If you want the list results refreshed automatically, click the
Periodic Refresh check box and type a refresh interval in
seconds in the Period (secs) text box.

6. To filter the list results, type a file name in the Filename text
box and a workstation name in the Workstation Name text box.
The file name and workstation name can contain the following
wildcard characters:

* Specifies one or more characters.

? Specifies one character.

Leaving the text box blank results in an unfiltered list.

7. When you finish making your entries, do one of the following:

¶ Click the OK button to save the list and close the window.
The list icon is added to the group you selected.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

Modifying the Properties of a Plan List
To modify the properties of a plan list, do the following:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Select the list icon you want to modify.

Figure 69. Properties - File Status List window.
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3. Right-click the list icon and select Properties from the pop-up
menu.This displays the properties window for the list.

4. Make your modification in the properties window.

5. When you finish making your modifications to the list properties,
do one of the following:

¶ Click the OK button to save the changes and to close the
window.

¶ Click the Apply button to run the list without closing the
window. The list results are displayed in the right panel of
the Job Scheduling Console.

Deleting a Plan List
To delete a plan list, do the following:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Select the list icon you want to delete.

3. Right-click the list icon and select Delete from the pop-up menu.
In the confirmation window, click Yes to delete the list or
Cancel to cancel the delete operation.

Detaching a Plan List Display
Detaching a list frees the right-window of the Job Scheduling
Console to display other objects. You can detach multiple lists to
display several objects simultaneously. In TWS you can have up to
seven detached windows at a time. To detach a plan list display, do
the following:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Select the list icon you want to view in a detached window.

3. Right-click the list icon and select Detach View from the pop-up
menu. This displays the separate window for the list display.
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Finding Objects in the Plan
Search tools are provided in the Job Scheduling Console to help you
find objects in the plan. The availability of a search tool is indicated
by an ellipsis located next to the text box where you type an object
name. In the following example of the Submit Job into Plan window,
the Job Name and Workstation Name text boxes provide search
tools.Clicking the ellipsis button opens a Find window.

To use the Find window, do the following:

Figure 70. Examples of Search Tool Buttons.

Figure 71. Example Find window.
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1. Type search character string in the available text boxes. The
search character string can contain the following wildcard
characters:

* Specifies one or more characters.

? Specifies one character.

Leaving the text box blank results in an unfiltered list.

2. Select other filter criteria using option buttons and check boxes.

3. Click the Start button. The results of the search are listed in the
lower part of the Find window. The Stop button is displayed
while the list is being generated. The Stop button can be used to
stop the search. Any objects that have been found by the system
until the Stop is clicked are then displayed.

4. Select an object in the list and do one of the following:

¶ Double-click the object in the list or click the OK button to
insert the name of the object in the text box on the parent
window and close the Find window.

¶ Click the Apply button to insert the name of the object in
the text box on the parent window. The Find window
remains open to permit you to select other objects from the
list.

Managing Job Instances in the Plan
A job is a unit of work that is part of a job stream processed at a
workstation. A job usually refers to a command or script file. Job
definitions in TWS include all necessary workstation and path
locations, command names, file names, login IDs, user permissions,
priority levels, and recovery options necessary to successfully
execute a command or script file with no manual intervention.

You can execute the following commands against a job instance in
the plan:

Properties
View or modify the properties of a job instance. This
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includes viewing, adding, modifying, or deleting the
dependencies and time restrictions on the job instance.

Dependencies
View, add, modify, or delete the predecessors of a job
instance.

Hold Sets a job instance priority to 0, the internal status to HOLD,
and the Job Schedule Console status to HELD.

Release
Counteracts the Hold command. The Release command
reverts a job instance priority to what it was prior to the
execution of the Hold command.

Rerun Rerun a job instance.

Cancel Job
Cancels the planned execution of a job instance.

Kill Stops a job instance.

Confirm
Forces the status of a job instance to SUCC or ABEND.

Release All Dependencies
Releases all dependencies to this job instance.

Get Job Output
View the STDLIST of a job instance that has completed
running.

Displaying a List of Jobs in the Plan
To display a list of jobs in the plan, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below TWS until you see the icon for the
job instance list you want to run. See “Creating a Plan List of
Job Instances” on page 244 for information about creating job
instance lists.

3. Select the job instance list icon.
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4. Click the Load List button on the toolbar or right-click the job
instance list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console. For descriptions of the job instance list
views refer to the following:

¶ “Timeline View of Job Instances”.

¶ “List View of Job Instances” on page 259.

Timeline View of Job Instances
The Timeline View provides a table and a timeline display of job
instances. Use the borders and the arrows on the borders to adjust
the sizes of the windows. Use the arrows at the top of the timeline
window to move the view in one hour and one day increments.

In the timeline window, the dark blue line represents the window of
time a job instance can start. A black bar at the end of the blue line
represents the deadline time (UNTIL keyword). The actual start time
of the job instance is displayed by a black dot. A light blue bar
within the dark blue line represents the actual duration of the job
instance. The start time, deadline time, and duration time are also
listed in the tabular window.
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The toolbar in the job instance Timeline view contains two special
buttons.

Go to Click this button to move the timeline display to the date
you select on the popup calendar.

Go to First Click this button to move the timeline display to the
start time and day offset of the earliest job instance.

The following are descriptions of the column headings in the table
part of the Timeline view.

Name Displays the name of the job instance.

Status Displays the status of the job instance. For more information
on job or job stream status refer to “Status Description and
Mapping” on page 375.

Started
Displays the actual start date and time of the job instance.

Figure 72. Job Instance List: Timeline View window.
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Runtime
Displays the actual duration of the job instance.

Start at
Displays the date and time of the planned start time for the
job instance.

Duration
Displays the estimated duration time of the job instance.

Deadline
Displays the date and time of the deadline for the job
instance.

List View of Job Instances
The List View provides a tabular display of job instances.

The following are descriptions of the column headings in the List
View.

Job Name
Displays the name of the job instance.

Figure 73. Job Instance List: List View window.
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Job Number
For UNIX and MPE, this displays the process identification
number (PID) of the job instance. For Windows NT, the job
number is an incremental number from the value found in
the file nxtjobno in TWShome.

Workstation (Job)
Displays the name of the workstation on which the job
instance runs.

Job Stream
Displays the name of the job stream instance that owns this
job instance.

Workstation (Job Stream)
Displays the name of the workstation on which the job
stream instance runs.

Status Displays the Job Scheduling Console status of the job
instance. For more information on job or job stream status
refer to “Status Description and Mapping” on page 375.

Internal Status
Displays the TWS Internal status of the job instance. For
more information on job or job stream status refer to “Status
Description and Mapping” on page 375.

Information
Displays additional information about the job instance.

Run Options
Displays the run options of the job instance.

Priority
Displays the priority of the job instance. The priority can be
from 0 to 101. A priority of 0 stops the job instance from
running.

Every Frequency
Displays in hours and minutes of the repeat rate for this job
instance.
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Start Time
Displays the date, time and time zone when this job instance
is scheduled to start running.

Est. Duration
Displays the estimated run time of the job instance.

Actual Time
Displays the actual start time of the job instance.

Elapse Time
Displays the actual duration of the job instance.

Deadline Time
Displays the date, time and time zone after which the job
instance cannot begin running.

Job Stream Dep.
Displays the number of follows job stream dependencies for
each job instance.

Job Dep.
Displays the number of follows job dependencies for each
job instance.

Inet Dep.
The number of internetwork predecessors to this job.

File Dep.
Displays the number of file dependencies for each job
instance.

Prompt Dep.
Displays the number of prompt dependencies for each job
instance.

Resource Dep.
Displays the number of resource dependencies for each job
instance.

Modifying the Properties of a Job Instance
To display the properties of a job instance in the plan, follow these
steps:
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1. Run a list of job streams that contains the job instance you want
to display. See “Creating a Plan List of Job Instances” on
page 244 for more information.

2. In the list results, double-click on the job instance you want to
display or right-click the job instance and choose Properties
from the pop-up menu. This displays the Properties - Job
Instance window. Note that the window title reflects the job
type. The General tab is displayed in the left window of the
Properties - Job Instance window.

The following are descriptions of the text boxes and options in
the General view of the Properties - Job Instance window.

Job Name
Displays the name of the job instance.

Job Number
Displays the number of times this job instance has been
run in the production plan.

Figure 74. Properties - Job Instance: General window.
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Workstation (Job)
Displays the name of the workstation on which the job
instance is launched.

Job Stream
Displays the name of the job stream this job instance
belongs to.

Workstation (Job Stream)
Displays the name of the workstation on which the job
stream instance is launched.

Login Displays the User ID of the person running the job
instance.

Priority
Displays the priority of the job instance. To change the
priority, select a value from the drop-down list or click
Hold to select priority 0, High to select priority 100, or
Go to select priority 101. Possible priority values are 0
through 101, where 101 is the highest priority. A
priority value of zero prevents the job instance from
launching.

Status Displays the Job Scheduling Console status of the job
instance. For more information on job or job stream
status refer to “Status Description and Mapping” on
page 375.

Internal Status
Displays the TWS Internal status of the job instance.
For more information on job or job stream status refer
to “Status Description and Mapping” on page 375.

Information
Displays additional information about the job instance.

Rerun Status
Displays whether this job instance has been rerun.

Is Interactive
Displays whether this job instance is an interactive job.
This information appears only for Windows NT jobs.
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Requires Confirmation
Displays that this job instance will not be executed in
the plan until user intervention is used to submit it.

Actuals
These fields display the actual start time and duration of
the job instance, if it has completed running.

Start Time
Displays the actual start time of the job
instance.

Duration
Displays the actual duration of the job instance.

Recovery Options
These fields display any automatic recovery action to be
taken if the job instance ends with a status of ABEND.

Stop, Continue, or Rerun
Specifies what action to take if this job instance
ends with a status of ABEND (the job instance
ends with an error).

Job Name
Specifies the name of an error recovery job that
will run if the current job instance ends with a
status of ABEND.

Workstation
Specifies the name of the workstation that owns
the recovery job.

Message
Specifies the message text that displays if the
job instance ends with a status of ABEND.

3. To display the task information for a job instance, click Task in
the left window of the Properties - Job Instance window. This
displays the Task view.
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The Task view changes depending on the type of job instance
selected.

The following are descriptions of the text boxes and options in
the Task view of the Properties - Job Instance window.

Task Type
Displays the task type of the job instance.

The following fields change depending on the type of job
instance displayed:

UNIX Script
Displays information about the UNIX script file:

Script Displays the path and filename of the UNIX
script.

UNIX Command
Displays information about the UNIX command:

Figure 75. Properties - Job Instance: Task window.
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Command
Displays the path and filename of the UNIX
command.

NT Script
Displays information about the Windows NT script file:

Script Displays the path and filename of the Windows
NT script.

NT Command
Displays information about the Windows NT command:

Command
Displays the path and filename of the Windows
NT command.

MPE Job File
Displays information about the MPE Job File:

Job File
Displays the filename, group, and account for
this MPE job file.

MPE User Job
Displays information about the MPE User Job:

User Job
Displays the filename, group, and account for
this MPE User Job.

Extended Agent Task
Displays information about the extended agent task:

Task Displays the filename or command for this
extended agent task.

Workstation Class Script
Displays information about the Workstation Class script
file:

Script Displays the path and filename of the
Workstation Class script.
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Workstation Class Command
Displays information about the Workstation Class
command:

Script Displays the path and filename of the
Workstation Class command.

SAP Job
Displays information about the SAP task::

R/3 Job Identity
Use these fields to identify the R/3 job..

Job Name
The R/3 job name.

Job ID
This field is filled in when you submit the job
to the R/3 system.

Disable BDC Wait
Indicates if BDC Wait option for the job is
disabled

Debug Options
Indicates if additional debut information is
included in the job’s stdlist file.

Trace Indicates if a trace file dev_rfc is created in the
TWS home directory.

4. To display time restrictions, click Time Restrictions in the left
window of the Properties - Job Instance window. This
displays the Time Restrictions view.
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The following are descriptions of the text boxes and options in
the Time Restrictions tab of the Properties - Job Instance
window.

Start Specifies the earliest time the job instance will be
launched. The job instance will not be launched before
this time. To change the time, make your selections as
follows:

Specify date and time
Select this option to enable the entry of a start
time.

Date Specify the start date or click the calendar
button and select a date from the drop-down
calendar.

Time Specify a start time in the following format:

hh:mm am|pm

Figure 76. Properties - Job Instance: Time Restrictions window.
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For example, 11:30 am or 4:25 pm.

Deadline
Specifies the latest time the job instance will be
launched. The job instance will not be launched after
this time. To change the time, make your selections as
follows:

Specify date and time
Select this option to enable the entry of a
deadline time.

Date Specify the deadline date or click the calendar
button and select a date from the drop-down
calendar.

Time Specify a deadline time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Time Zone
Select a time zone from the drop-down list. The start
time and deadline time are in this time zone. If a time
zone is not specified for the job instance, all time
values are in the time zone of the workstation on which
the job instance is launched. Note that the time zone
option must be activated in the global options file for
this field to be active.

Repeat Range
Specifies the repeat rate of a job instance. Using the
Repeat Range field with the Start and Deadline times
allows you to run a job instance, for example, every 15
minutes from 1:00 pm to 5:00 pm.

Hours Specify the rate in hours that this job instance
will repeat.

Minutes
Specify the rate in minutes that this job instance
will repeat.
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5. To display file dependencies, click Files in the left window of
the Properties - Job Instance window. This displays the Files
view.

The following are descriptions of the column headings in the
Files view.

Filename
Specifies the path and name of the file.

Workstation
Specifies the workstation on which the file resides.

Release Status
Specifies the status of the file dependency. The possible
values are:

Not Released
The job instance is not released from the file
dependency.

Figure 77. Properties - Job Instance: Files window.
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Released
The job instance is released from the file
dependency.

To release the job instance from the file dependency,
click in the Status column and select Released from the
drop-down menu.

Qualifiers
Specifies the test conditions for the file dependency.

Internal Status
Specifies the internal status of the file dependency. The
possible values are:

Not Checked
The file dependency has not been checked.

Checking
The file dependency is being checked.

Exists The file dependency is satisfied.

Does Not Exist
The file dependency is not satisfied.

6. To add a file dependency for the job instance, do the following:

a. Click the Add Row (+) button. This creates a new row in
the list of file dependencies.

b. Double-click the text box in the Filename column and type
in a file name.

c. Double-click the text box in the Workstation column and
click the Find button (...) to locate and insert the name of
the workstation on which the file exists or will be created.

d. Double-click the text box in the Qualifiers column and
specify the test conditions for the file dependency. On
UNIX, the valid qualifiers are the same as UNIX test
command conditions. For more information, refer to your
UNIX system documentation.

On Windows NT, only the following qualifiers are valid:
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-d %p True if the file exists and is a directory.

-e %p True if the file exists.

-f %p True if the file exists and is a regular file.

-r %p True if the file exists and is readable.

-s %p True if the file exists and its size is greater
than zero.

-w %p True if the file exists and is writable.

On both UNIX and Windows NT, the expression %p inserts
the file name.

Entering notempty is the same as entering -s %p. If no
qualifier is specified, the default is -f %p.

7. To remove a file dependency for the job instance, select the file
row in the list and click the Delete from Table (X) button.

8. To display prompt dependencies, click Prompts in the left
window of the Properties - Job Instance window. This displays
the Prompts view.
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9. To display ad hoc prompt dependencies, select Ad Hoc Prompt
from the drop-down list in the toolbar. To display Predefined
prompt dependencies, select Predefined Prompt from the
drop-down list in the toolbar.

The following are descriptions of the column headings in the
Prompts view.

Name Specifies the name of the prompt. This is used for
Predefined Prompts only.

Message Text
Specifies the text of the prompt message.

Workstation
Specifies the workstation that displays the prompt
message text. This is only available for Ad Hoc
prompts.

Number
Specifies the number of the prompt dependency.

Figure 78. Properties - Job Instance: Prompts window.
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Release Status
Specifies the release status of the prompt dependency.
The possible values are:

Not Released
The job instance is not released from the
prompt dependency.

Released
The job instance is released from the prompt
dependency.

To release the job instance from the prompt dependency,
click in the Status column and select Released from the
drop-down menu.

Internal Status
Specifies the internal status of the prompt dependency.
The possible values are:

Not Asked
The prompt has not been asked.

Asked The has been asked, but no response has been
received.

Answered Yes
The prompt has been answered affirmatively
and the job instance dependency is released.

Answered No
The prompt has been answered negatively and
the job instance dependency is not released.

Reply Specifies the reply to the prompt dependency. To reply
to the prompt, click in this column and select Yes or No
from the drop-down menu.

10. To add a prompt dependency for the job instance, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of prompt dependencies.
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b. For a pre-defined prompt, double-click the text box in the
Name column and click the Find button to locate and insert
the name of a prompt.

c. For an ad hoc prompt, double-click the text box in the
Message Text column and type in the text of the prompt.
The default behavior of a prompt is to display a message
and wait for a reply. If the string begins with a colon (:), the
message is displayed but no reply is necessary. If the string
begins with an exclamation mark (!), the message is not
displayed but it requires a reply. You can include backslash
n (\n) within the text for new lines.

You can include one or more TWS parameters as part or all
of the text string. To use a parameter, place its name
between carets (^).

11. To remove a prompt dependency for the job instance, select the
prompt row in the list and click the Delete from Table (X)
button.

12. To display resource dependencies, click Resources in the left
window of the Properties - Job Instance window. This displays
the Resources view.
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The following are descriptions of the column headings in the
Resources view.

Resource
Specifies the name of the resource.

Workstation
Specifies the workstation on which the resource resides.

Quantity
Specifies the number of units of a resource are needed
by the job instance to satisfy the dependency.

Available
Specifies the number of units of the resource that are
currently available.

Release Status
Specifies the status of the resource dependency. The
possible values are:

Figure 79. Properties - Job Instance: Resources window.
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Not Released
The job instance is not released from the
resource dependency.

Released
The job instance is released from the resource
dependency.

To release the job instance from the resource
dependency, click in the Status column and select
Released from the drop-down menu.

13. To add a resource dependency for the job instance, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of resource dependencies.

b. In the Workstation column, click the Find button to locate
and insert the name of a workstation.

c. Double-click the text box in the Resource column and click
the Find button to locate and insert a resource name.

d. Double-click the text box in the Quantity column and
specify the number of resource units required by the job
instance. The default is one.

14. To delete a resource dependency for the job instance, select the
resource row in the list and click the Delete from Table (X)
button.

15. When you have finished viewing job properties, do one of the
following:

¶ Click the OK button to save the changes you made to the
properties and close the Properties - Job Instance window.

¶ Click the Cancel button to ignore any changes you made to
the properties and close the Properties - Job Instance
window.

¶ Click the Apply button to save the changes you made to
the properties and leave open the Properties - Job Instance
window.
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Displaying Predecessors of a Job Instance
To display the predecessors of a job instance in the plan, follow
these steps:

1. Run a list of jobs that contains the job instance you want to
modify. See “Displaying a List of Jobs in the Plan” on page 256
for more information.

2. In the list results, right-click the job instance you want to display
and select Dependencies... from the pop-up menu.

This displays the Dependencies - Job Instance window.

3. Click Predecessors in the left window. This displays the
Predecessor view in the right window.

The following are descriptions of the column headings in the
Predecessors view.

Job Stream
Specifies the name of a predecessor job stream instance
or the job stream that owns the predecessor job.

Job Specifies the name of a predecessor job instance.

Workstation
Specifies the workstation of the predecessor job or job
stream.

Release Status
Specifies the status of the predecessor dependency. The
possible values are:

Figure 80. Dependencies - Job Instance window.
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Released
The job instance is released from the predecessor
dependency.

Not Released
The job instance is not released from the
predecessor dependency.

To release the job instance from the predecessor
dependency, click in the Status column and select
Released from the drop-down menu.

Internal Status
Specifies the TWS internal status of the predecessor job
or job stream instance. For more information on job or
job stream status refer to “Status Description and
Mapping” on page 375.

4. When you are finished in the Dependencies - Job Instance
window, do one of the following:

¶ Click the OK button to save your changes in the plan and
close the Dependencies - Job Instance window.

¶ Click the Apply button to save your changes in the plan and
leave open the Dependencies - Job Instance window.

Adding Predecessors to a Job Instance
To add a predecessor job or job stream to a job instance, do the
following:

1. Display the predecessors of the job instance. For information, see
“Displaying Predecessors of a Job Stream Instance” on page 307.

2. Click the Add Row (+) button. This creates a new row in the list
of predecessors.

3. To specify a predecessor job instance, double-click the text box
in the Job column and click the Find button to locate and insert
the name of a predecessor job instance.

4. To specify a predecessor job stream instance, double-click the
text box in the Job Stream column and click the Find button to
locate and insert the name of the predecessor job stream instance.
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5. When you are finished in the Dependencies - Job Instance
window, do one of the following:

¶ Click the OK button to save your changes in the plan and
close the Dependencies - Job Instance window.

¶ Click the Apply button to save your changes in the plan and
leave open the Dependencies - Job Instance window.

Deleting Predecessors from a Job Instance
To delete a predecessor job or job stream from a job instance, do the
following:

1. Display the predecessors of the job instance. For information, see
“Displaying Predecessors of a Job Instance” on page 278.

2. Select the predecessor row in the list and click the Delete from
Table (X) button.

3. When you are finished in the Dependencies - Job Instance
window, do one of the following:

¶ Click the OK button to save your changes in the plan and
close the Dependencies - Job Instance window.

¶ Click the Apply button to save your changes in the plan and
leave open the Dependencies - Job Instance window.

Displaying Successors of a Job Instance
To display the successors of a job instance in the plan, follow these
steps:

1. Run a list of job instances that contains the job you want to
display. See “Displaying a List of Jobs in the Plan” on page 256
for more information.

2. In the list results, right-click the job instance you want to display
and select Dependencies... from the pop-up menu.

This displays the Dependencies - Job Instance window.

3. To display successor jobs and job streams, click Successors in
the left window.

For descriptions of the column headings in the Successors view,
refer to “Deleting Predecessors from a Job Instance”.
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4. When you are finished in the Dependencies - Job Instance
window, do one of the following:

¶ Click the OK button to save your changes in the plan and
close the window.

¶ Click the Apply button to save your changes in the plan and
leave the window open.

Changing a Job Instance to Hold
Changing a job instance to Hold sets the priority of the job instance
to 0. Use the Release command to change the priority back to its
original level at the start of day.

To change a job instance to Hold, follow these steps:

1. Run a list of job instances that contains the job instance you
want to modify. See “Displaying a List of Jobs in the Plan” on
page 256 for more information.

2. Select the All Scheduled Jobs List View.

3. Right-click the job instance you want to hold. To select more
than one job instance, do one of the following:

¶ To select a range of job instances in the list, hold down the
shift key and left-click the first and last job instances in the
range. Right-click one of the selected jobs to open the popup
menu.

¶ To select multiple job instances, hold down the control key
and left-click each job instance. Right-click one of the
selected job instances to open the popup menu.

4. Select Hold from the pop-up menu and click the Yes button in
the confirmation message window.

To hold all jobs in a group of job instances, follow these steps:

1. Run the list of job instances.

2. Select the All Scheduled Jobs Timeline View.

3. Right-click the arrow next to the job instance group.
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4. Click Hold All.

Changing a Job Instance to Release
The Releasecommandis used to reverse the Hold command. The
Release command sets the priority of a job back to the original
setting at the start of the processing day. Do not confuse this
command with Release All Dependencies. This command has no
effect on job dependencies.

To change a job instance to Release, follow these steps:

1. Run a list of job instances that contains the job instance you
want to modify. See “Displaying a List of Jobs in the Plan” on
page 256 for more information.

2. Select the All Scheduled Jobs List View.

3. Right-click the job instance you want release. To select more
than one job instance, do one of the following:

¶ To select a range of job instances in the list, hold down the
shift key and left-click on the first and last job instances in
the range. Right-click one of the selected job instances to
open the popup menu.

¶ To select multiple job instances, hold down the control key
and left-click each job instance. Right-click one of the
selected job instances to open the popup menu.

4. Select Release from the pop-up menu and click the Yes button in
the confirmation message window.

To release all jobs in a group of job instances, follow these steps:

1. Run the list of job instances.

2. Select the All Scheduled Jobs Timeline View.

3. Right-click the arrow next to the job instance group.

4. Click Release All.

Canceling a Job Instance
Canceling a job instance in the plan prevents the job from running.
A canceled job instance can be submitted anytime during the
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production cycle using an alias name. For more information, see
“Submitting a Job into the Plan” on page 337.

To cancel a job instance, follow these steps:

1. Run a list of job instances that contains the job instance you
want to modify. See “Displaying a List of Jobs in the Plan” on
page 256 for more information.

2. In the list results, right-click the job instance you want cancel. To
select more than one job instance, do one of the following:

¶ To select a range of job instances in the list, hold down the
shift key and left-click on the first and last job instances in
the range. Right-click one of the selected jobs to open the
popup menu.

¶ To select multiple job instances, hold down the control key
and left-click each job instance. Right-click one of the
selected job instances to open the popup menu.

3. Select Cancel from the pop-up menu and click the Yes button in
the confirmation message window.

Rerunning a Job Instance
Note that you cannot rerun multiple job instances simultaneously.

To rerun a job instance:

1. Run a list of job instances that contains the job instance you
want to rerun. See “Displaying a List of Jobs in the Plan” on
page 256 for more information.

2. In the list results, right-click the job instance you want rerun.

3. Select Rerun from the pop-up menu. This opens the Rerun Job
window.
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4. To rerun the job directly click OK otherwise add any additional
options.

5. The following are descriptions of the fields in the Rerun Job
window.

Step Specify the step from which you would like to rerun this
job. The new job instance will assume the name
specified here.

From Specify the job from which you want the job to run.

Workstation Name
Specify the workstation to run the job.

The following fields are only valid when using the “from”
option:

Start Time
Specify the start date and time for the job.

Specify Date and Time
Select this checkbox to specify a start date and
time for the job.

Date Specify a start date for the job.

Time Specify a start time for the job.

Figure 81. Rerun Job window.
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Time Zone
Specify a time zone for the job. The time zone option
must be enabled for this field to be active.

Priority
Specify the priority of the job. When the job competes
with other jobs for execution, the job with the higher
priority runs first.You can select a priority from 0 to 101.

Hold Sets the priority to 0. This job will not execute
until the priority is raised.

High Sets the priority to 100.

Go Sets the priority to 101.

6. When you are finished in the Rerun Job window, do one of the
following:

¶ Click the OK button to save your changes in the plan and
close the window.

¶ Click the Apply button to save your changes in the plan and
leave the window open.

Killing a Job Instance
Killing a job instance can only be done for UNIX command and
UNIX script jobs. You cannot kill Windows NT job instances.

To kill a UNIX job instance, follow these steps:

1. Run a list of job instances that contains the job instance you
want to kill. See “Displaying a List of Jobs in the Plan” on
page 256 for more information.

2. In the list results, right-click the job instance you want kill. To
select more than one job instance, do one of the following:

¶ To select a range of job instances in the list, hold down the
shift key and left-click on the first and last job instances in
the range. Right-click one of the selected job to open the
popup menu.
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¶ To select multiple job instances, hold down the control key
and left-click each job instance. Right-click one of the
selected job instances to open the popup menu.

3. Select Kill from the pop-up menu and select the Yes button in
the confirmation box. This kills a currently running UNIX job.

Confirming a Job Instance SUCC or ABEND
Confirming a job instance status as SUCC or ABEND allows you to
force the job instance into a state where either its successors can
continue processing or job recovery options are started.

To confirm a job instance status to SUCC or ABEND, follow these
steps:

1. Run a list of job instances that contains the job instance you
want to confirm. See “Displaying a List of Jobs in the Plan” on
page 256 for more information.

2. In the list results, right-click the job instance you want to
confirm. To select more than one job instance, do one of the
following:

¶ To select a range of job instances in the list, hold down the
shift key and left-click on the first and last job instances in
the range. Right-click the selected job instance to open the
popup menu.

¶ To select multiple job instances, hold down the control key
and left-click each job instance. Right-click one of the
selected job instances to open the popup menu.

3. Select Confirm > SUCC or Confirm > ABEND from the
pop-up menu and select the Yes button in the confirmation box.
This forces the status of the selected job instances to SUCC or
ABEND.

Releasing a Job Instance from Dependencies
Releasing a job instance from its dependencies removes
dependencies on the following:

¶ Scheduled start time
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¶ Predecessor jobs and job streams

¶ File dependencies

¶ Prompt dependencies

¶ Resource dependencies

To release a job instance from its dependencies, follow these steps:

1. Run a list of job instances that contains the job instance you
want to release. See “Displaying a List of Jobs in the Plan” on
page 256 for more information.

2. In the list results, right-click the job instance you want release.
To select more than one job instance, do one of the following:

¶ To select a range of job instances in the list, hold down the
shift key and left-click on the first and last job instances in
the range. Right-click the selected job instance to open the
popup menu.

¶ To select multiple job instances, hold down the control key
and left-click each job instance. Right-click one of the
selected job instances to open the popup menu.

3. Select Release All Dependencies from the pop-up menu and
click the Yes button in the confirmation message window. This
permits the job instance to run unless there are other higher
priority jobs waiting to run, or if the job instance priority is
below the fence for the workstation.

Getting the Job Output (STDLIST)
A standard list file (STDLIST) is created for each job instance
launched by TWS. Standard list files contain header and trailer
banners, echoed commands, and errors and warnings. These files can
be used to troubleshoot problems in job execution.

To view the STDLIST for a job instance, follow these steps:

1. Run a list of job instances that contains the job instance you
want to modify. See “Displaying a List of Jobs in the Plan” on
page 256 for more information.
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2. In the list results, right-click the job instance you want to view
the STDLIST for. The STDLIST for a job is blank until the job
has completed.

3. Select Get Job Output from the pop-up menu. The Get Job
Instance Output window is displayed for the job.

Managing Job Stream Instances in the Plan
A job stream is a sequence of jobs, including the resources, prompts,
parameters, and workstations that support them, and scheduling
information. The dependency of one job on the completion of
another determines the sequence of the jobs. The scheduling
information, such as the use of run cycles, calendars, and time
restrictions, determines when and how often the job stream instance
is run.

You can execute the following commands against a job stream
instance in the plan:

Properties
View or modify the properties of a job stream instance. This

Figure 82. Get Job Instance Output window.
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includes viewing, adding, modifying, or deleting the
dependencies and time restrictions on the job stream
instance.

Dependencies
View, add, modify, or delete the predecessors of a job stream
instance.

Hold Sets a job stream instance priority to 0, the internal status to
hold, and the Job Schedule Console status to held.

Release
Counteracts the Hold command. The Release command
reverts a job stream instance priority to the what it was prior
to the execution of the Hold command.

Cancel
Cancels the planned execution of a job stream instance.

Limit View or modify the job limit of a job stream instance. This
is the number of jobs that can run concurrently in the job
stream instance.

Priority
View or modify the priority of a job stream instance.

Release All Dependencies
Releases all dependencies to this job stream instance.

Re-submit
Re-submits the job stream instance under an alias name.

Displaying a List of Job Streams in the Plan
To display a list of job stream instances in the plan, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand TWS
controller icon.

2. Expand the branches below the TWS controller icon until you
see the icon for the job stream instance list you want to run. See
“Creating a Plan List of Workstations” on page 238 for
information about creating job stream instance lists.

3. Select the job stream instance list icon.
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4. Click the Load List button on the toolbar or right-click the job
stream instance list icon and select Load List from the pop-up
menu.

The list results are displayed in the right panel of the Job
Scheduling Console. For descriptions of the job stream instance
list views refer to the following:

¶ “Timeline View of Job Stream Instances”.

¶ “List View of Job Stream Instances” on page 292.

Timeline View of Job Stream Instances
The Timeline View provides a table and timeline display of job
stream instances in the plan. Use the borders and the arrows on the
borders to adjust the sizes of the windows. Use the arrows at the top
of the timeline window to move the view in one hour and one day
increments.

In the timeline window, the dark blue line represents the window of
time a job stream instance can start. A black bar at the end of the
blue line represents the deadline time (UNTIL keyword). The actual
start time of the job stream instance is displayed by a black dot. A
light blue bar within the dark blue line represents the actual duration
of the job stream. The start time, deadline time, and duration time
are also listed in the tabular window.
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The toolbar in the job stream instance Timeline view contains two
special buttons.

Go to Click this button to move the timeline display to the date
you select on the popup calendar.

Go to First Click this button to move the timeline display to the
start time and day offset of the earliest job stream instance.

The following are descriptions of the column headings in the tabular
part of the Timeline view.

Name Displays the name of the job stream instance.

Status Displays the status of the job stream instance. For more
information on job or job stream instance status refer to
“Status Description and Mapping” on page 375.

Started
Displays the actual start date and time of the job stream
instance.

Runtime
Displays the actual duration of the job stream instance.

Figure 83. Job Stream Instances: Timeline View window.
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Start at
Displays the date and time of the planned start time for the
job stream instance.

Duration
Displays the estimated duration time of the job stream
instance.

Deadline
Displays the date and time of the deadline for the job stream
instance.

List View of Job Stream Instances
The List View provides a table display of job stream instances.

The following are descriptions of the column headings in the List
View.

Job Stream
Specifies the name of the job stream instance.

Workstation
Specifies the name of the workstation on which the job
stream instance runs.

Figure 84. Job Stream Instances: List View window.
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Status Specifies the Job Scheduling Console status of the job
stream instance. For more information on job or job stream
instance status refer to “Status Description and Mapping” on
page 375.

Internal Status
Specifies the TWS Internal status of the job stream instance.
For more information on job or job stream status refer to
“Status Description and Mapping” on page 375.

Information
Specifies additional information about the job stream
instance.

Priority
Specifies the priority of the job stream instance.

Num Jobs
Specifies the total number of jobs in the job stream instance.

OK Jobs
Specifies the number of jobs that have completed
successfully in the job stream instance.

Limit Specifies the job limit of the job stream instance.

Original Job Stream
For job stream instances that were submitted with an alias
name, this specifies the original name of the job stream
instance.

Scheduled Start
Specifies the date and time the job stream instance is
scheduled to start running.

Actual Start
Specifies the date and time the job stream instance started
running.

Est. Duration
Specifies the expected duration time of the job stream
instance.

Actual Duration
Specifies the actual duration time of the job stream instance.
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Deadline Time
Specifies the date and time of the job stream instance
deadline.

Job Stream Dep.
Specifies the number of predecessor job streams for the job
stream instance. An icon indicates the lowest status of the
predecessors.

Job Dep.
Specifies the number of predecessor jobs of the job stream
instance. An icon indicates the lowest status of the
predecessors.

Inet Dep.
The number of internetwork predecessors to this job stream.

File Dep.
Specifies the number of file dependencies of the job stream
instance. An icon indicates the lowest status of the
dependencies.

Prompt Dep.
Specifies the number of prompt dependencies of the job
stream instance. An icon indicates the lowest status of the
dependencies.

Resource Dep.
Specifies the number of resource dependencies of the job
stream instance. An icon indicates the lowest status of the
dependencies.

Displaying and Changing the Properties of a Job
Stream Instance

To display the properties of a job stream instance in the plan, follow
these steps:

1. Run a list of job stream instances that contains the job stream
you want to display.

2. In the list results, double-click on the job stream instance you
want to display or right-click the job stream instance and
choose Properties from the pop-up menu.
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This displays the Properties - Job Stream Instance window,
General view.

3.

The following are descriptions of the text boxes and options in
the General view of the Properties - Job Stream Instance
window.

Name Specifies the name of the job stream instance.

Original Name
Specifies the original name of a job stream instance that
was submitted with an alias name.

Workstation Name
Specifies the name of the workstation on which the job
stream instance is launched.

Workstation Class Name
Specifies the name of the workstation class on which
the job stream instance is launched.

Figure 85. Properties - Job Stream Instance: General window.
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Priority
Specifies the priority of the job stream instance. To
change the priority, select a value from the drop-down
list or click Hold to select priority 0, High to select
priority 100, or Go to select priority 101. Possible
priority values are 0 through 101, where 101 is the
highest priority. A priority value of zero prevents the
job stream instance from launching.

Limit Specifies the number of jobs that can be running at the
same time in the schedule. To change the job limit,
select a value from the drop-down list. Possible values
are 0 through 1024. If you specify a job limit of 0, no
jobs within the job stream instance are launched.

Status Specifies the status of the job stream instance. For more
information on job or job stream status refer to “Status
Description and Mapping” on page 375.

Internal Status
Specifies the TWS internal status of the job stream
instance. For more information on job or job stream
status refer to “Status Description and Mapping” on
page 375.

Information
Specifies additional information about the job stream
instance.

Production Date
Specifies the current date of the production cycle.

Carry Forward
Indicates this job stream instance is carried forward to
the next processing day if it does not complete before
the end of the current production day.

Job Information
Specifies information about the job instances in the job
stream instance.

Number Of Jobs
Specifies the total number of job instances.
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Number of Jobs Not Run
Specifies the number of job instances that have
not run.

Number Of Jobs Abended
Specifies the number of job instances that have
abended.

Number of Successful Jobs
Specifies the number of job instances that have
run successfully.

Number Of Executing Jobs
Specifies the number of job instances that are
running.

Number of Failed Jobs
Specifies the number of job instances that have
failed to run.

Time Information
Specifies information about the timing of the job stream
instance.

Start Time
Specifies the time and day the job stream
instance started running.

Runtime
Specifies the duration of the job stream
instance.

Est. Duration
Specifies the estimated duration of the job
stream instance.

4. To display time restrictions, click Time Restrictions in the left
window of the Properties - Job Stream Instance window. This
displays the Time Restrictions view.
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The following are descriptions of the text boxes and options in
the Timeline view of the Properties - Job Stream Instance
window.

Start Specifies the earliest time the job stream instance will
be launched. The job stream instance will not be
launched before this time. To change the time, make
your selections as follows:

Specify date and time
Select this option to enable the entry of a start
time.

Date Specify the start date or click the calendar
button and select a date from the drop-down
calendar.

Time Specify a start time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Figure 86. Properties - Job Stream Instance: Time Restrictions window.
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Deadline
Specifies the latest time the job stream instance will be
launched. The job stream instance will not be launched
after this time. To change the time, make your
selections as follows:

Specify date and time
Select this option to enable the entry of a
deadline time.

Date Specify the deadline date or click the calendar
button and select a date from the drop-down
calendar.

Time Specify a deadline time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Time Zone
Select a time zone from the drop-down list. The start
time and deadline time are in this time zone. If a time
zone is not specified for the job stream instance, all
time values are in the time zone of the workstation on
which the job instance is launched. Note that the time
zone option must be activated in the global options file
for this field to be active.

5. To display file dependencies, click Files in the left window of
the Properties - Job Stream Instance window. This displays the
Files view.
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The following are descriptions of the column headings in the
Files view.

Filename
Specifies the name of the file.

Workstation
Specifies the workstation on which the file resides.

Release Status
Specifies the status of the file dependency. The possible
values are:

Not Released
The job stream instance is not released from the
file dependency.

Released
The job stream instance is released from the file
dependency.

Figure 87. Properties - Job Stream Instance: Files window.
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To release the job instance from the file dependency,
click in the Status column and select Released from the
drop-down menu.

Qualifiers
Specifies the test conditions for the file dependency.

Internal Status
Specifies the internal status of the file dependency. The
possible values are:

Not Checked
The file dependency has not been checked.

Checking
The file dependency is being checked.

Exists The file dependency is satisfied.

Does Not Exist
The file dependency is not satisfied.

6. To add a file dependency for the job stream instance, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of file dependencies.

b. Double-click the text box in the Filename column and type
in a file name.

c. Double-click the text box in the Workstation column and
click the Find button to locate and insert the name of the
workstation on which the file exists or will be created.

d. Double-click the text box in the Qualifiers column and
specify the test conditions for the file dependency. On
UNIX, the valid qualifiers are the same as UNIX test
command conditions. For more information, refer to your
UNIX system documentation.

On Windows NT, only the following qualifiers are valid:

-d %p True if the file exists and is a directory.

-e %p True if the file exists.

Managing Job Stream Instances in the Plan

301Tivoli Workload Scheduler User’s Guide

8.
T

W
S

P
lan

Tasks



-f %p True if the file exists and is a regular file.

-r %p True if the file exists and is readable.

-s %p True if the file exists and it’s size is greater
than zero.

-w %p True if the file exists and is writable.

On both UNIX and Windows NT, the expression %p,
inserts the file name.

Entering notempty is the same as entering -s %p. If no
qualifier is specified, the default is -f %p.

7. To remove a file dependency for the job stream instance, select
the file row in the list and click the Delete from Table (X)
button.

8. To display prompt dependencies, click Prompts in the left
window of the Properties - Job Stream Instance window. This
displays the Prompts view.

Figure 88. Properties - Job Stream Instance: Prompts window.
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9. Select the type of Prompt you want to display, ad hoc or
Predefined. To display ad hoc prompt dependencies, select Ad
Hoc Prompt from the drop-down list in the toolbar. To display
Predefined prompt dependencies, select Predefined Prompt
from the drop-down list in the toolbar.

The following are descriptions of the column headings in the
Prompts view.

Name Specifies the name of the prompt. This column is for
Predefined prompts only.

Message Text
Specifies the text of the prompt message.

Workstation
Specifies the workstation that will display the prompt
message. This is for Ad Hoc prompts only.

Number
Specifies the number of the prompt dependency.

Status Specifies the status of the prompt dependency. The
possible values are:

Not Released
The job stream instance is not released from the
prompt dependency.

Released
The job stream instance is released from the
prompt dependency.

To release the job instance from the prompt dependency,
click in the Status column and select Released from the
drop-down menu.

Internal Status
Specifies the internal status of the prompt dependency.
The possible values are:

Not Asked
The prompt has not been asked.
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Asked The has been asked, but no response has been
received.

Answered Yes
The prompt has been answered affirmatively
and the job stream instance dependency is
released.

Answered No
The prompt has been answered negatively and
the job stream instance dependency is not
released.

Reply Specifies the reply to the prompt dependency. To reply
to the prompt, click in this column and select Yes or No
from the drop-down menu.

10. To add a prompt dependency for the job stream instance, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of prompt dependencies.

b. For a pre-defined prompt, double-click the text box in the
Name column and click the Find button to locate and insert
the name of a prompt.

c. For an ad hoc prompt, double-click the text box in the
Message Text column and type in the text of the prompt.
The default behavior of a prompt is to display a message
and wait for a reply. If the string begins with a colon (:), the
message is displayed but no reply is necessary. If the string
begins with an exclamation mark (!), the message is not
displayed but it requires a reply. You can include backslash
n (\n) within the text for new lines.

You can include one or more TWS parameters as part or all
of the text string. To use a parameter, place its name
between carets (^).

11. To remove a prompt dependency for the job stream instance,
select the prompt row in the list and click the Delete from
Table (X) button.
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12. To display resource dependencies, click Resources in the left
window of the Properties - Job Stream Instance window. This
displays the Resources view.

The following are descriptions of the column headings in the
Resources view.

Resource
Specifies the name of the resource.

Workstation
Specifies the workstation on which the resource resides.

Quantity
Specifies the number of units of the resource that are
needed by the job stream instance to satisfy the
dependency.

Available
Specifies the number of units of the resource that are
currently available.

Figure 89. Properties - Job Stream Instance: Resources window.
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Release Status
Specifies the status of the resource dependency. The
possible values are:

Not Released
The job stream instance is not released from the
resource dependency.

Released
The job stream instance is released from the
resource dependency.

To release the job instance from the resource
dependency, click in the Status column and select
Released from the drop-down menu.

13. To add a resource dependency for the job stream instance, do
the following:

a. Click the Add Row (+) button. This creates a new row in
the list of resource dependencies.

b. In the Workstation column, click the Find button to locate
and insert the name of a workstation.

c. Double-click the text box in the Resource column and click
the Find button to locate and insert a resource name.

d. Double-click the text box in the Quantity column and
specify the number of resource units required by the job
stream instance. The default is one.

14. To delete a resource dependency for the job stream instance,
select the resource row in the list and click the Delete from
Table (X) button.

15. When you have finished viewing job stream instance properties,
do one of the following:

¶ Click the OK button to save the changes you made to the
properties and close the Properties - Job Stream Instance
window.
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¶ Click the Apply button to save the changes you made to
the properties and leave open the Properties - Job Stream
Instance window.

Displaying Predecessors of a Job Stream Instance
To display the predecessors of a job stream instance in the plan,
follow these steps:

1. Run a list of job stream instances that contains the job stream
instance you want to modify.

2. In the list results, right-click the job stream instance you want to
display and select Dependencies... from the pop-up menu.

This displays the Dependencies - Job Stream Instance window.

3. Click Predecessors in the left window. This displays the
Predecessor view in the right window.

The following are descriptions of the column headings in the
Predecessors view.

Job Stream
Specifies the name of a predecessor job stream instance.

Job Specifies the name of a predecessor job instance.

Workstation
Specifies the workstation of the predecessor job or job
stream instance.

Figure 90. Dependencies - Job Stream Instance: Predecessor window.
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Release Status
Specifies the status of the predecessor dependency. The
possible values are:

Released
The job stream instance is released from the
predecessor dependency.

Not Released
The job stream instance is not released from the
predecessor dependency.

To release the job stream instance from the predecessor
dependency, click in the Release Status column and
select Released from the drop-down menu.

Internal Status
Specifies the TWS internal status of the predecessor job
or job stream instance. For more information on job or
job stream status refer to “Status Description and
Mapping” on page 375.

4. When you are finished in the Dependencies - Job Stream
Instance window, do one of the following:

¶ Click the OK button to save your changes in the plan and
close the Dependencies - Job Stream Instance window.

¶ Click the Apply button to save your changes in the plan and
leave open the Dependencies - Job Stream Instance window.

Adding Predecessors to a Job Stream Instance
To add a predecessor job or job stream to a job stream instance, do
the following:

1. Display the predecessors of the job stream instance. For
information, see “Displaying Predecessors of a Job Stream
Instance” on page 307.

2. Click the Add Row (+) button. This creates a new row in the list
of predecessors.
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3. To specify a predecessor job stream instance, double-click the
text box in the Job Stream column and click the Find button to
locate and insert the name of the predecessor job stream instance.

4. To specify a predecessor job instance, double-click the text box
in the Job column and click the Find button to locate and insert
the name of a predecessor job instance.

5. When you are finished in the Dependencies - Job Stream
Instance window, do one of the following:

¶ Click the OK button to save your changes in the plan and
close the Dependencies - Job Stream Instance window.

¶ Click the Apply button to save your changes in the plan and
leave open the Dependencies - Job Stream Instance window.

Deleting Predecessors from a Job Stream Instance
To delete a predecessor job or job stream from a job stream instance,
do the following:

1. Display the predecessors of the job stream instance. For
information, see “Displaying Predecessors of a Job Stream
Instance” on page 307.

2. Select the predecessor row in the list and click the Delete from
Table (X) button.

3. When you are finished in the Dependencies - Job Stream
Instance window, do one of the following:

¶ Click the OK button to save your changes in the plan and
close the Dependencies - Job Stream Instance window.

¶ Click the Apply button to save your changes in the plan and
leave open the Dependencies - Job Stream Instance window.

Displaying Successors of a Job Stream Instance
To display the successors of a job stream instance in the plan, follow
these steps:

1. Run a list of job stream instances that contains the job stream
you want to modify.
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2. In the list results, right-click the job stream instance you want to
display and select Dependencies... from the pop-up menu.

This displays the Dependencies - Job Stream Instance window.

3. To display successor jobs and job streams, click Successors in
the left window.

For descriptions of the column headings in the Successors view,
refer to “Displaying Predecessors of a Job Stream Instance” on
page 307.

4. When you are finished in the Dependencies - Job Stream
Instance window, do one of the following:

¶ Click the OK button to save your changes in the plan and
close the Dependencies - Job Stream Instance window.

¶ Click the Apply button to save your changes in the plan and
leave open the Dependencies - Job Stream Instance window.

Changing a Job Stream Instance to Hold
Changing a job stream instance to Hold sets the priority of the job
instance to zero. Use the Release command to change the priority
back to its original level at the start of the processing day.

To change a job stream instance to Hold, follow these steps:

1. Run a list of job stream instances that contains the job stream
instance you want to modify. See “Displaying a List of Job
Streams in the Plan” on page 289 for more information.

2. Select the All Scheduled Job Streams List View.

3. Right-click the job stream instance you want to hold. To select
more than one job stream instance, do one of the following:

¶ To select a range of job stream instances in the list, hold
down the shift key and left-click on the first and last job
stream instances in the range. Right-click one of the selected
job stream instances to open the popup menu.
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¶ To select multiple job stream instances, hold down the
control key and left-click each job stream instance.
Right-click one of the selected job stream instances to open
the popup menu.

4. Select Hold from the pop-up menu and click the Yes button in
the confirmation message window.

Releasing a Job Stream Instance
The Releasecommandis used to counteract the Hold command. The
Release command sets the priority back to the original setting at the
start of the processing day. Do not confuse this command with the
Release All Dependenciescommand. This command has no effect on
job stream instance dependencies.

To change a job stream instance to Release, follow these steps:

1. Run a list of job stream instances that contains the job stream
instance you want to modify. See “Displaying a List of Job
Streams in the Plan” on page 289 for more information.

2. Select the All Scheduled Job Streams List View.

3. In the list results, right-click the job stream instance you want to
release. To select more than one job stream instance, do one of
the following:

¶ To select a range of job stream instances in the list, hold
down the shift key and left-click on the first and last job
stream instances in the range. Right-click one of the selected
job stream instance to open the popup menu.

¶ To select multiple job stream instances, hold down the
control key and left-click each job stream instance.
Right-click one of the selected job stream instances to open
the popup menu.

4. Select Release from the pop-up menu and click the Yes button in
the confirmation message window.

Canceling a Job Stream Instance
Canceling a job stream instance in the plan prevents the job stream
instance from running. A canceled job stream instance can be
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re-submitted using an alias name. For more information, see
“Re-Submitting a Job Stream Instance” on page 316.

To cancel a job stream instance, follow these steps:

1. Run a list of job stream instances that contains the job stream
instance you want to modify. See “Displaying a List of Job
Streams in the Plan” on page 289 for more information.

2. In the list results, right-click the job stream instance you want
cancel. To select more than one job stream instance, do one of
the following:

¶ To select a range of job stream instances in the list, hold
down the shift key and left-click on the first and last job
stream instances in the range. Right-click one of the selected
job stream instance to open the popup menu.

¶ To select multiple job stream instances, hold down the
control key and left-click each job stream instance.
Right-click one of the selected job stream instances to open
the popup menu.

3. Select Cancel from the pop-up menu and click the Yes button in
the confirmation message window.

Changing the Job Limit of a Job Stream Instance
To change the job limit of a job stream instance in the plan, follow
these steps:

1. Run a list of job stream instances that contains the job stream
instance you want to modify. See “Displaying a List of Job
Streams in the Plan” on page 289 for more information.

2. In the list results, right-click the job stream instance you want
modify. To select more than one job stream instance, do one of
the following:

¶ To select a range of job stream instances in the list, hold
down the shift key and left-click on the first and last job
stream instances in the range. Right-click one of the selected
job stream to open the popup menu.
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¶ To select multiple job stream instances, hold down the
control key and left-click each job stream instance.
Right-click one of the selected job stream instances to open
the popup menu.

3. Select Limit... from the pop-up menu.

This displays the Change Limit - Job Stream Instance window.

4. Specify a new job limit in the New Limit field.

5. When you are finished in the Change Limit - Job Stream
Instance window, do one of the following:

¶ Click the OK button to save the new job limit in the plan
and close the window.

¶ Click the Cancel button to close the window without saving
the new job limit.

Changing the Priority of a Job Stream Instance
To change the priority of a job stream instance in the plan, follow
these steps:

1. Run a list of job stream instances that contains the job stream
instance you want to modify. See “Displaying a List of Job
Streams in the Plan” on page 289 for more information.

2. In the list results, right-click the job stream instance you want
modify or, to select more than one job stream instance, do one of
the following:

¶ To select a range of job stream instances in the list, hold
down the shift key and left-click on the first and last job
stream instances in the range. Right-click one of the selected
job stream instance to open the popup menu.

Figure 91. Change Limit - Job Stream Instance window.
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¶ To select multiple job stream instances, hold down the
control key and left-click each job stream instance.
Right-click one of the selected job stream instances to open
the popup menu.

3. Select Priority... from the pop-up menu.

This displays the Change Priority - Job Stream Instance window.

4. Select a new priority value from the drop-down list or click one
of the following buttons:

Hold Sets the priority to 0.

High Sets the priority to 100.

Go Sets the priority to 101.

Default
If a single job stream instance is selected, this sets the
priority to the original value of the job stream instance at
the start of processing day. If multiple job stream
instances are selected, the priority of each job stream
instance is set back to what it was at start of processing
day.

5. When you are finished in the Change Priority - Job Stream
Instance window, do one of the following:

¶ Click the OK button to save the new priority in the plan and
close the window.

¶ Click the Cancel button to close the window without saving
the new priority.

Figure 92. Change Priority - Job Stream Instance window.

Managing Job Stream Instances in the Plan

314 Version 7.0



Releasing a Job Stream Instance from Dependencies
Releasing a job stream instance from its dependencies removes
dependencies on the following objects:

¶ Scheduled start time

¶ Predecessor jobs and job streams

¶ Resources

¶ Files

¶ Prompts

To release a job stream instance from its dependencies, follow these
steps:

1. Run a list of job stream instances that contains the job stream
instance you want to release. See “Displaying a List of Job
Streams in the Plan” on page 289 for more information.

2. In the list results, right-click the job stream instance you want
release. To select more than one job stream instance, do one of
the following:

¶ To select a range of job stream instances in the list, hold
down the shift key and left-click on the first and last job
stream instances in the range. Right-click one of the selected
job stream to open the popup menu.

¶ To select multiple job stream instances, hold down the
control key and left-click each job stream instance.
Right-click one of the selected job stream instances to open
the popup menu.

3. Select Release All Dependencies from the pop-up menu and
click the Yes button in the confirmation message window.

This permits the job stream to run unless there are other
prerequisites. For more information, see to the following:

¶ “Displaying and Changing the Properties of a Job Stream
Instance” on page 294.

¶ “Changing the Job Limit of a Job Stream Instance” on page 312.
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¶ “Changing the Priority of a Job Stream Instance” on page 313.

Re-Submitting a Job Stream Instance
When you re-submit a job stream instance, a new job stream
instance is created in the plan. The new job stream instance is given
an alias name. To re-submit a job stream instance in the plan, follow
these steps:

1. Run a list of job stream instances that contains the job stream
instance you want to re-submit. See “Displaying a List of Job
Streams in the Plan” on page 289 for more information.

2. In the list results, right-click the job stream instance you want
re-submit.

3. Select Re-Submit from the pop-up menu. This displays the
Re-Submit Job Stream Instance window.

4. Specify an alias name for the re-submitted job stream instance in
the Alias text box. If you do not specify an alias name, a name
is generated by TWS. For unexpanded mode, TWS starts with
the first two characters of the original job stream instance name
followed by six random numbers. For expanded mode, TWS
starts with the first six characters of the original job stream
instance name followed by ten random numbers.

5. When you are finished in the Re-Submit Job Stream Instance
window, do one of the following:

¶ Click the OK button to re-submit the job stream instance and
close the window.

¶ Click the Cancel button to close the window without
re-submitting the job stream instance.

Figure 93. Re-Submit Job Stream Instance window.
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6. To change the properties of the re-submitted job stream, click the
Properties... button. For information about job stream instance
properties, refer to “Displaying and Changing the Properties of a
Job Stream Instance” on page 294.

7. To change the predecessors for the re-submitted job stream, refer
to “Adding Predecessors to a Job Stream Instance” on page 308
and “Deleting Predecessors from a Job Stream Instance” on
page 309.

Managing Workstations in the Plan
The plan contains a list of all workstation that are going to be used
in that days processing. You can perform the following actions on a
workstation in the plan:

¶ Display a list of workstation in the plan. This list contains a
number of fields with information about the workstation status.

¶ Changing the job limit of a workstation instance

¶ Changing the job fence of a workstation instance

¶ Starting, stopping, linking, unlinking a workstation

Displaying a List of Workstations in the Plan
To display a list of workstations in the plan, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the Default Plan lists group.

3. Select the Status of All Workstation icon.

4. Click the Load List button on the toolbar or right-click the
workstation list icon and select Load List from the pop-up
menu.

The list results are displayed in the right panel of the Job
Scheduling Console.
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The following are descriptions of the column headings in the
workstation display.

Name Displays the workstation instance name.

Jobman Running
Displays whether or not the jobman process on the
workstation is running.

Link Status
Displays the current link status of the workstation. A
workstation can be either LINKED or UNLINKED.

Limit Displays the total number of jobs that can be run
concurrently on this workstation.

Fence Displays the job fence for this workstation. The job fence
is the priority a job must exceed to execute on this
workstation. Setting the fence to 40, for example,
prevents jobs with priorities of 40 or less from being
launched. Valid values are from 0 to 101.

Figure 94. Workstation Status list window.
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Node Specifies the type of workstation and the type operating
system of the workstation in the following format:

os_wkstat

where os is one of the following:

WNT Windows NT.

UNX UNIX.

MPV MPE/V.

MPX MPE/IX.

Other Other workstation OS.

and where wkstat is one of the following:

FTA Fault-tolerant agent

Master
Master

Manager
Domain manager

S-Agent
Standard agent

X-Agent
Extended agent

Time Zone
Displays the time zone of the workstation.

Node Port
Displays the port address of the workstation.

CPU Type
Displays the TWS workstation type. Valid values are
MASTER, FTA, SAGENT or XAGENT.

Host Displays the TWS physical workstation that is hosting
this workstation definition. This is only valid for
Extended Agents and Network agents.
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Run Displays the run number of the production plan of the
workstation. This is used synchronize the workstations in
a TWS network.

Start Time
Displays the date and time the batchman process was
started on the workstation.

Jobman Init
Displays whether or not the jobman process on the
workstation has completed its startup initialization. The
value can be either YES or NO.

Method
Displays the method name, if this workstation is an
extended agent or network agent workstation.

Domain
Displays the name of the TWS domain of the
workstation.

Version
Displays the version of TWS installed on this
workstation.

Node Information
Displays operating system information about the
workstation.

Node Name
Displays the node name of the workstation.

Displaying a Workstation Instance
To display a workstation instance in the plan, follow these steps:

1. Run a list of workstations that contains the workstation you want
to display. See “Displaying a List of Workstations in the Plan” on
page 317 for more information.

2. In the list results, double-click on the workstation you want to
display or right-click the workstation and choose Properties
from the pop-up menu.

Managing Workstations in the Plan

320 Version 7.0



This displays the Properties - Workstation in Plan window.

For descriptions of the field values see “Displaying a List of
Workstations in the Plan” on page 317.

3. In the Properties - Workstation in Plan window, you can change
the Limit and Fence values by entering new values from in the
fields. For more information see “Changing the Job Limit of a
Workstation in the Plan” and “Changing the Job Fence of a
Workstation in the Plan” on page 322.

4. Click the OK button to save your changes and close the
Properties - Workstation in Plan window or click the Cancel
button to close the Properties - Workstation in Plan window
without saving your changes.

Changing the Job Limit of a Workstation in the Plan
To change the job limit of a workstation instance in the plan, follow
these steps:

1. Run a list of workstations in the plan that contains the
workstation you want to modify.

Figure 95. Properties - Workstation in Plan window.
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2. In the list results, right-click the workstation you want to modify
or, to select more than one workstation, do one of the following:

¶ To select a range of workstations in the list, hold down the
shift key and left-click on the first and last workstations in
the range. Right-click one of the selected workstations to
open the popup menu.

¶ To select multiple workstations, hold down the control key
and left-click each workstation. Right-click one of the
selected workstations to open the popup menu.

3. Select Limit... from the pop-up menu.

This displays the Change Limit - Workstation window.

4. Specify a new job limit in the New Limit field.

5. When you are finished, do one of the following:

¶ Click the OK button to save the new job limit in the plan
and close the window.

¶ Click the Cancel button to close the window without saving
the new job limit.

Changing the Job Fence of a Workstation in the Plan
To change the job fence of a workstation instance in the plan, follow
these steps:

1. Run a list of workstation instances that contains the workstation
you want to modify.

2. In the list results, right-click the workstation you want to modify,
or, to select more than one workstation, do one of the following:

Figure 96. Change Limit - Workstation window.
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¶ To select a range of workstations in the list, hold down the
shift key and left-click on the first and last workstations in
the range. Right-click one of the selected workstations to
open the popup menu.

¶ To select multiple workstations, hold down the control key
and left-click each workstation. Right-click one of the
selected workstations to open the popup menu.

3. Select Fence... from the pop-up menu.

This displays the Change Fence - Workstation window.

4. Specify a new job fence or click one of the following buttons:

Hold None
Sets the fence to 0.

Hold All
Sets the fence to 101.

5. When you are finished in the Change Fence - Workstation
window, do one of the following:

¶ Click the OK button to save the new job fence in the plan
and close the window.

¶ Click the Cancel button to close the window without saving
the new job fence.

Starting a Workstation Instance
To start TWS running on a workstation instance, follow these steps:

Note: To start all of the workstations in a domain, refer to “Starting
the Workstations in a Domain” on page 325.

Figure 97. Change Fence - Workstation window.
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1. Run a list of workstation instances that contains the workstation
you want to start.

2. In the list results, right-click the workstation you want to start.

3. Select Start from the pop-up menu.

Stopping a Workstation Instance
To stop TWS running on a workstation instance, follow these steps:

Note: To stop all of the workstations in a domain, refer to
“Stopping the Workstations in a Domain” on page 326.

1. Run a list of workstation instances that contains the workstation
you want to stop.

2. In the list results, right-click the workstation you want to stop.

3. Select Stop from the pop-up menu.

Linking a Workstation Instance
To link a workstation instance, follow these steps:

Note: To link all of the workstations in a domain, refer to “Linking
the Workstations in a Domain” on page 326.

1. Run a list of workstation instances that contains the workstation
you want to link.

2. In the list results, right-click the workstation you want to link.

3. Select Link from the pop-up menu.

Unlinking a Workstation Instance
To unlink a workstation instance, follow these steps:

Note: To unlink all of the workstations in a domain, refer to
“Unlinking the Workstations in a Domain” on page 326.

1. Run a list of workstation instances that contains the workstation
you want to link.

2. In the list results, right-click the workstation you want to unlink.

3. Select Unlink from the pop-up menu.
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Managing Domains in the Plan
You can perform the following actions on a domains in the plan:

¶ Display a list of domains in the plan. This list contains a number
of fields with information about the domain status.

¶ Starting, stopping, linking, unlinking all the workstation in a
domain.

¶ Change the domain manager workstation in a domain.

Displaying a List of Domains in the Plan
To display a list of domains in the plan, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the Default Plan Lists group.

3. Select a Status of All Domains list icon.

4. Click the Load List button on the toolbar or right-click the
domain list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console. The following are descriptions of the
column headings in the domain display.

Name Specifies the name of the domain.

Domain Manager
Specifies the name of the domain manager workstation.

Domain Parent
Specifies the name of the parent domain.

Starting the Workstations in a Domain
To start TWS running on all of the workstations in a domain, follow
these steps:

Note: To start individual workstations, refer to “Starting a
Workstation Instance” on page 323.
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1. Run a list of domains that contains the domain you want to start.
See “Displaying a List of Domains in the Plan” on page 325 for
more information.

2. In the list results, right-click the domain you want to start.

3. Select Start Workstations from the pop-up menu.

Stopping the Workstations in a Domain
To stop TWS running on all of the workstations in a domain, follow
these steps:

Note: To stop individual workstations, refer to “Stopping a
Workstation Instance” on page 324.

1. Run a list of domains that contains the domain you want to stop.
See “Displaying a List of Domains in the Plan” on page 325 for
more information.

2. In the list results, right-click the domain you want to stop.

3. Select Stop Workstations from the pop-up menu.

Linking the Workstations in a Domain
To link all of the workstations in a domain, follow these steps:

Note: To link individual workstations, refer to “Linking a
Workstation Instance” on page 324.

1. Run a list of domains that contains the domain you want to link.
See “Displaying a List of Domains in the Plan” on page 325 for
more information.

2. In the list results, right-click the domain you want to link.

3. Select Link Workstations from the pop-up menu.

Unlinking the Workstations in a Domain
To unlink all of the workstations in a domain, follow these steps:

Note: To unlink individual workstations, refer to “Unlinking a
Workstation Instance” on page 324.
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1. Run a list of domains that contains the domain you want to
unlink. See “Displaying a List of Domains in the Plan” on
page 325 for more information.

2. In the list results, right-click the domain you want to unlink.

3. Select Unlink Workstations from the pop-up menu.

Switching the Domain Manager in a Domain
When switching domain managers to a backup domain manager,
make sure the new domain manager is a fault-tolerant agent with
Full Status and Resolve Dependencies selected.

To switch the domain manager to a different workstation in a
domain, follow these steps:

1. Run a list of domains that contains the domain you want to
switch. See “Displaying a List of Domains in the Plan” on
page 325 for more information.

2. In the list results, right-click the domain you want to switch.

3. Select Switch Manager... from the pop-up menu. This displays
the Select Domain Manager window.

4. Click the Find button and use the Find window to select the
name of the new domain manager workstation. The new domain
manager must be a member of the domain and it must be a
fault-tolerant agent with Full Status and Resolve Dependencies
selected.

5. When you are finished in the Select Domain Manager window,
do one of the following:

¶ Click the OK button to switch to the new domain manager
and close the window.

Figure 98. Switch Manager - Domain window.
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¶ Click the Cancel button to close the window without
switching the domain manager.

Managing File Dependencies in the Plan
A file dependency is when a job or job stream needs to verify the
existence of one or more files before it can begin execution.

Displaying File Dependencies Status
To display a list of file dependencies in the plan, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the Default Plan Lists group.

3. Select a Status of All Files list icon.

4. Expand the branches below TWS until you see the icon for the
file list you want to run. See “Creating a Plan List of Files” on
page 251 for information about creating file lists.

5. Select the file list icon.

6. Click the Load List button on the toolbar or right-click the file
list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console.
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The following are descriptions of the column headings in the file
display.

Full Path Name
Specifies the path and name of the file.

Workstation
Specifies the name of the workstation that owns the file.

Qualifiers
Displays any qualifiers used with this file dependency.

Status Specifies the status of the file as one of the following:

Not Checked
Not yet checked or the file was available and
used to satisfy a job or job stream dependency.

Checking
File availability is being checked.

Exists The file exists and is available.

Does Not Exist
The file does not exist or is not available.

Figure 99. Status of All Files list window.
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Managing Prompt Dependencies in the Plan
A prompt dependency is when a job or job stream needs to wait for
an affirmative response to a prompt before it can begin execution.

Displaying Prompt Dependencies Status
To display a list of prompt dependencies in the plan, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the Default Plan Lists group.

3. Select the Status of All Prompts list icon.

4. Click the Load List button on the toolbar or right-click the
prompt list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console. The following are descriptions of the
column headings in the prompt display.

Name Specifies the name of a predefined prompt or the number
of an ad hoc prompt.

Workstation
Specifies the name of the workstation.

Dependency
Specifies the jobs or job stream names that are dependent
on this prompt.

Release Status
Specifies the status of the prompt as one of the
following:

ASKED
The prompt has been issued, but no response has
been received.

NOT ASKED
The prompt has not been issued.

YES The prompt has been issued and a YES response
has been received.
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NO The prompt has been issued and a NO response
has been received.

Number
Specifies the internal ID of the prompt.

Type Specifies the prompt type as one of the following:

Ad Hoc
The prompt is locally defined in a job or job
stream.

Predefined
The prompt has a name and is defined in the
database.

Recovery
The prompt is locally defined in a job as a
recovery option.

Message Text
Specifies the text of the prompt.

Replying to a Prompt Dependency
To reply to a prompt dependency, follow these steps:

1. Run a list of prompt dependencies that contains the prompt you
want to modify. See “Displaying Prompt Dependencies Status”
on page 330 for more information.

2. In the list results, right-click the prompt dependency you want to
reply to or, to select more than one prompt dependency, do one
of the following:

¶ To select multiple prompt dependencies from the list, hold
down the shift key and left-click on the first and last prompt
dependencies in the range. Right-click one of the selected
prompt dependencies to open the popup menu.

¶ To select multiple prompt dependencies, hold down the
control key and left-click each prompt dependency.
Right-click one of the selected prompt dependencies to open
the popup menu.

3. Select Reply > Yes or Reply > No from the pop-up menu.
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Managing Resource Dependencies in the Plan
Resources represent any type of resources on your system such as
tape drives, communication lines, databases, or printers, that are
needed to run a job. Resources can be physical or logical. After
defining a resource in the TWS database, it can be used as a
dependency for jobs and job streams that run on the workstation or
workstation class for which the resource is defined.

Displaying Resource Dependencies Status
To display a list of resource dependencies in the plan, follow these
steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

2. Expand the branches below TWS until you see the icon for the
resource list you want to run. See “Creating a Plan List of
Resources” on page 248 for information about creating resource
lists.

3. Select the resource list icon.

4. Click the Load List button on the toolbar or right-click the
resource list icon and select Load List from the pop-up menu.

The list results are displayed in the right panel of the Job
Scheduling Console. The following are descriptions of the
column headings in the resource display.

Name Displays the name of the resource.

Workstation
Displays the name of the workstation.

Status Displays the status of the resource as one of the
following:

Available
The resource has units available.

Not Available
The resource has no units available.
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Unknown
The status of the resource is unknown.

Quantity Defined
Displays the total number of units defined for the
resource.

Quantity Available
Displays the number resource units that are not in use.

In Use
Displays the number of resource units that are currently
in use.

Holders
Displays the names of job and job stream instances that
require units of the resource and the number of units
required.

Displaying the Properties of a Resource Dependency
To display a resource dependency in the plan, follow these steps:

1. Run a list of resource dependencies that contains the resource
you want to modify. See “Displaying Resource Dependencies
Status” on page 332 for more information.

2. In the list results, double-click on the resource you want to
display or right-click the resource and choose Properties from
the pop-up menu.

This displays the Properties - Resource in Plan window.
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For descriptions of the field values see “Displaying Resource
Dependencies Status” on page 332.

3. In the Properties - Resource in Plan window, you can change the
total number of defined units of the resource. To do this, specify
a new value in the Quantity Defined text box.

4. Click the OK button to save your changes and close the
Properties - Resource Instance window or click the Cancel
button to close the window without saving your changes.

Changing the Number of Units of a Resource
Dependency

To change the total number of defined units of a resource
dependency, follow these steps:

1. Run a list of resource dependencies that contains the resource
you want to modify. See “Displaying Resource Dependencies
Status” on page 332 for more information.

2. In the list results, right-click the resource you want to modify.

3. Select Change Units... from the pop-up menu.

This displays the Change Units - Resource in Plan window.

Figure 100. Properties - Resource in Plan window.
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4. Specify a new value in the Quantity Defined text box.

5. When you are finished in the Change Units - Resource in Plan
window, do one of the following:

¶ Click the OK button to save the new units in the plan and
close the window.

¶ Click the Cancel button to close the window without saving
the new units.

Submitting Jobs and Job Streams Into the Plan
This sections provides information for submitting jobs and job
streams into the plan for impromptu processing. You can submit jobs
and job streams that have been previously defined to the database
into the plan for impromptu processing. If the job or job stream is
already in the plan and you would like to schedule it again, you can
submit it with an alias.

You can also submit ad hoc jobs to the plan. These are jobs that
have not been defined in the database. These jobs are created and
submitted into the plan, but are never saved in the database.

Submitting a Job Stream Into the Plan
To submit a job stream that already exists in the database into the
plan, follow these steps:

1. In the tree view of the Job Scheduling Console, expand the TWS
controller icon.

Figure 101. Change Units - Resource in Plan window.
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2. right-click the TWS controller icon and select Submit > Job
Stream from the pop-up menu. This displays the Submit Job
Stream into Plan window.

3. In the Submit Job Stream into Plan window, fill in the text boxes
as follows:

Job Stream
Click the ellipsis button to open a Find Job Stream
window. This field is filled out automatically when you
select a job stream using the Find Job Stream window.

Workstation name
This field is filled out automatically when you select a
job stream using the Find Job Stream window.

Alias Specify an alias name for the submitted job stream
instance. An alias name is needed only if the plan
contains a job stream instance of the same name. If an
alias name is necessary, and you do not specify an alias,
a name is generated by TWS that starts with the first two
characters of the original job stream name followed by
six random characters.

4. To modify the properties of the submitted job stream, click the
Properties... button. For information about job stream properties,
see “Displaying and Changing the Properties of a Job Stream
Instance” on page 294.

5. When you are finished in the Submit Job Stream into Plan
window, do one of the following:

Figure 102. Submit Job Stream into Plan window.
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¶ Click the OK button to submit the job stream and close the
window.

¶ Click the Cancel button to close the window without
submitting the job stream.

Submitting a Job into the Plan
To submit a job that is defined in the database into a job stream
instance, you can use the job stream instance popup menu or the
TWS controller popup menu.

To submit a job that is defined in the database into a job stream
instance, follow these steps:

1. In the Job Scheduling view, right-click the TWS controller icon
or right-click over a job stream instance in a list, to display the
Submit commands.

2. Select Submit > Job from the pop-up menu. This displays the
Submit Job into Plan window.

3. In the Submit Job into Plan window, use the Find buttons to fill
in these fields:

Job Specifies the job to submit.

Name Specify the job name that you want to submit to

Figure 103. Submit Job into Plan window.
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the plan. Use the Find button (...) to search for
and select a job to submit into the plan.

Workstation
This field displays the name of the workstation
on which the job instance runs. This field is
filled automatically when you select a job using
the Find button.

Into Specifies the job stream into which the job is submitted.

Job Stream
Use the Find button (...) to search for the job
stream name. If no job stream is entered, a
default job stream JOBS is used.

Workstation
This field is filled automatically when you
select a job using the Find button. This field
displays the name of the workstation on which
the job stream instance runs.

Alias Specify an alias name for the submitted job. An alias
name is needed only if the job stream into which the
job is submitted contains another job of the same name.
An error message will display if you submit a job to a
job stream instance that already has a job instance of
the same name.

4. Click Properties to view or modify the properties of this
submitted job. When you click the properties button, the
General tab is displayed of the Properties - Job Instance
window.
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The following are descriptions of the text boxes and options in
the General view of the Properties - Job Instance window.

Job Displays information about the submitted job.

Name Displays the name of the submitted job.

Workstation
Displays the name of the workstation of the job.

Into Displays information about the job stream into which
the job is submitted.

Job Stream
Displays the name of the job stream into which
the job is submitted.

Workstation
Displays the name of the workstation of the job
stream.

Task Type
Displays the task type of the submitted job.

Figure 104. Properties - Job Instance: General window.
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Alias Displays the alias name of the submitted job, if defined.

Priority
Specifies the priority of the submitted job. To change
the priority, specify a value into the field or click Hold
to select priority 0, High to select priority 100, Go to
select priority 101, or Default to select the default
priority of the submitted job. Possible priority values
are 0 through 101, where 101 is the highest priority. A
priority value of zero prevents the job stream from
launching.

Recovery Options
Displays information about the recovery options of the
submitted job.

Action
Displays the recovery action for the submitted
job. It can be Stop, Continue, or Rerun.

Message
Specify the text of a recovery prompt. The text
can contain up to 64 characters. The default
behavior of a prompt is to display a message
and wait for a reply. If the string begins with a
colon (:), the message is displayed but no reply
is necessary. If the string begins with an
exclamation mark (!), the message is not
displayed but it requires a reply.

Job

Displays the name of a recovery job to run if
the parent job abends. To change the name,
click the Find button and select a job from a
list. Recovery jobs are run only once for each
abended instance of the parent job.

Workstation
Displays the name of the workstation on which
the recovery job runs. The name is entered
automatically when you select a recovery job.
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Not all jobs are eligible to have recovery jobs
run on a different workstation. Follow these
guidelines:

¶ If either workstation is an extended agent, it
must be hosted by a domain manager or a
fault-tolerant agent that runs in Full Status
mode.

¶ The recovery job’s workstation must be in
the same domain as the parent job’s
workstation.

¶ If the recovery job’s workstation is a
fault-tolerant agent, it must run in Full
Status mode.

Requires Confirmation
Check this box to indicate that job completion must be
confirmed by the operator.

5. To display task information, click Task in the left window of
the Properties - Job Instance window. This displays the Task
view.
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6. The Task view is different for each type of job and operating
system. These fields display the task type, the path, and the
command or script file referenced by the job. These fields are
read only.

7. To display time restrictions, click Time Restrictions in the left
window of the Properties - Job Instance window. This displays
the Time Restrictions view.

Figure 105. Properties - Job Instance: Task window.
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The following are descriptions of the text boxes and options in
the Time Restrictions view of the Properties - Job Instance
window.

Start Specifies the earliest time the job will be launched. The
job will not be launched before this time. To change the
time, make your selections as follows:

Specify date and time
Select this option to enable the entry of a start
time.

Date Specify a start date or click the calendar button
and select a date from the drop-down calendar.

Time Specify a start time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Deadline
Specifies the latest time the job will be launched. The

Figure 106. Properties - Job Instance: Time Restrictions window.
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job will not be launched after this time. To change the
time, make your selections as follows:

Specify date and time
Select this option to enable the entry of a
deadline time.

Date Specify the deadline date or click the calendar
button and select a date from the drop-down
calendar.

Time Specify a deadline time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Time Zone
If the Time Zone option is enabled, specify the time
zone in which the job runs. The start time and deadline
time are in this time zone. For more information about
the time zone feature, refer to “Time Zones” on
page 21.

Repeat Range
Specifies the repetition rate of the job. The job is
launched multiple times at this rate. Make your
selections as follows:

Hours Specify the hours. The value can be 00 to 23.

Minutes
Specify the minutes. The value can be 00 to 59.

8. To view or modify file dependencies, click Files in the left
window of the Properties - Job Instance window. This displays
the Files view.
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The following are descriptions of the column headings in the
Files view.

Filename
Specifies the path and name of the file.

Workstation
Specifies the workstation on which the file resides.

Qualifiers
Specifies the test conditions for the file dependency.

Release Status
Specifies the status of the file dependency. This field is
read only for submitted jobs. The possible values are:

Not Released
The job stream instance is not released from the
file dependency.

Figure 107. Properties - Job Instance: Files window.
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Released
The job stream instance is released from the file
dependency.

Internal Status
Specifies the internal status of the file dependency. The
possible values are:

Not Checked
The file dependency has not been checked.

Checking
The file dependency is being checked.

Exists The file dependency is satisfied.

Does Not Exist
The file dependency is not satisfied.

9. To add a file dependency for the job, do the following:

a. Click the Add Row (+) button. This creates a new row in
the list of file dependencies.

b. Double-click the text box in the Filename column and type
in a file name.

c. Double-click the text box in the Workstation column and
click the Find button to locate and insert the name of the
workstation on which the file exists or will be created.

d. Double-click the text box in the Qualifiers column and
specify the test conditions for the file dependency. On
UNIX, the valid qualifiers are the same as UNIX test
command conditions. For more information, refer to your
UNIX system documentation.

On Windows NT, only the following qualifiers are valid:

-d %p True if the file exists and is a directory.

-e %p True if the file exists.

-f %p True if the file exists and is a regular file.

-r %p True if the file exists and is readable.
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-s %p True if the file exists and it’s size is greater
than zero.

-w %p True if the file exists and is writable.

On both UNIX and Windows NT, the expression %p,
inserts the file name.

Entering notempty is the same as entering -s %p. If no
qualifier is specified, the default is -f %p.

10. To remove a file dependency for the job, select the file row in
the list and click the Delete from Table (X) button.

11. To display prompt dependencies, click Prompts in the left
window of the Properties - Job Instance window. This displays
the Prompts view.

12. To display ad hoc prompt dependencies, select Ad Hoc Prompt
from the drop-down list in the toolbar.

Figure 108. Properties - Job Instance: Prompts window.
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The following are descriptions of the column headings in the
Prompts view.

Message Text
Specifies the text of the prompt message.

Workstation
Specifies the workstation that displays the prompt
message text.

Number
Specifies the internal TWS ID number of the prompt
dependency.

Release Status
Specifies the status of the prompt dependency.This field
is read only for submitted jobs. The possible values are:

Not Released
The job instance is not released from the
prompt dependency.

Released
The job instance is released from the prompt
dependency.

Internal Status
Specifies the internal status of the prompt dependency.
The possible values are:

Not Asked
The prompt has not been asked.

Asked The has been asked, but no response has been
received.

Yes The prompt has been answered affirmatively
and the job dependency is released.

No The prompt has been answered negatively and
the job dependency is not released.

Reply Displays the reply to the prompt dependency.

13. To display pre-defined prompt dependencies, select Predefined
Prompt from the drop-down list in the toolbar.
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The following are descriptions of the column headings in the
Prompts view.

Name Specifies the name of the prompt.

Message Text
Specifies the text of the prompt message.

Number
Specifies the internal TWS ID number of the prompt
dependency.

Release Status
Specifies the status of the prompt dependency. This
field is read only for submitted jobs. The possible
values are:

Not Released
The job instance is not released from the
prompt dependency.

Released
The job instance is released from the prompt
dependency.

Internal Status
Specifies the internal status of the prompt dependency.
The possible values are:

Not Asked
The prompt has not been asked.

Asked The has been asked, but no response has been
received.

Yes The prompt has been answered affirmatively
and the job dependency is released.

No The prompt has been answered negatively and
the job dependency is not released.

Reply Specifies the reply to the prompt dependency. To reply
to the prompt, click in this column and select Yes or No
from the drop-down menu.
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14. To add a prompt dependency for the job instance, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of prompt dependencies.

b. For a pre-defined prompt, double-click the text box in the
Name column and click the Find button to locate and insert
the name of a prompt.

c. For an ad hoc prompt, double-click the text box in the
Message Text column and type in the text of the prompt.
The default behavior of a prompt is to display a message
and wait for a reply. If the string begins with a colon (:), the
message is displayed but no reply is necessary. If the string
begins with an exclamation mark (!), the message is not
displayed but it requires a reply. You can include backslash
n (\n) within the text for new lines.

You can include one or more TWS parameters as part or all
of the text string. To use a parameter, place its name
between carets (^).

15. To remove a prompt dependency for the job, select the prompt
row in the list and click the Delete from Table (X) button.

16. To display resource dependencies, click Resources in the left
panel of the Properties - Job Instance window. This displays the
Resources view.
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The following are descriptions of the column headings in the
Resources view.

Resource
Specifies the name of the resource.

Workstation
Specifies the workstation on which the resource resides.

Quantity
Specifies the number of units of the resource that are
needed by the job to satisfy the dependency.

Available
Specifies the number of units of the resource that are
currently available.

Release Status
Specifies the status of the resource dependency. This
field is read only for submitted jobs. The possible
values are:

Figure 109. Properties - Job Instance: Resources window.
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Not Released
The job instance is not released from the
resource dependency.

Released
The job instance is released from the resource
dependency.

17. To add a resource dependency for the job instance, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of resource dependencies.

b. Double-click the text box in the Workstation column and
click the Find button to locate and insert the name of a
workstation.

c. Double-click the text box in the Name column and click the
Find button to locate and insert a resource name.

d. Double-click the text box in the Quantity column and
specify the number of resource units required by the job
instance. The default is one.

18. To delete a resource dependency for the job instance, select the
resource row in the list and click the Delete from Table (X)
button.

19. To display predecessor jobs and job streams, click Predecessors
in the left panel of the Properties - Job Instance window. This
displays the Predecessors view.
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The following are descriptions of the column headings in the
Predecessors view.

Job Stream
Specifies the name of the predecessor job stream.

Job Specifies the name of job in the predecessor job stream.

Workstation
Specifies the name of the predecessor job stream’s
workstation.

Release Status
Specifies the status of the predecessor job or job stream.

Internal Status
Specifies the TWS internal status of the predecessor job
or job stream. For more information on job or job
stream status refer to “Status Description and Mapping”
on page 375.

20. To add a predecessor for the job instance, do the following:

Figure 110. Properties - Job Instance: Predecessors window.
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a. Click the Add Row (+) button. This creates a new row in
the list of predecessors.

b. To specify a predecessor job stream, double-click the text
box in the Job Stream column and click the Find button to
locate and insert the name of a job stream.

c. To specify a predecessor job, double-click the text box in
the Job column and click the Find button to locate and
insert a resource name.

21. To delete a predecessor for the job instance, select the
predecessor row in the list and click the Delete from Table (X)
button.

22. When you are finished in the Properties - Job Instance window,
do one of the following:

¶ Click the OK button to submit the job and close the
window.

¶ Click the Cancel button to close the window without
submitting the job.

Submitting an Ad Hoc Job into the Plan
To submit an ad hoc job (a job that is not defined in the database)
into a job stream instance, you can use the TWS controller pop-up
menu.

To submit a job that is defined in the database into a job stream
instance, you can use the job stream instance popup menu or the
TWS controller popup menu.

To submit an ad hoc job into a job stream instance, follow these
steps:

1. In the Job Scheduling view, right-click the TWS controller icon
or right-click over a job stream instance in a list, to display the
Submit commands.

2. Select Submit > Ad Hoc from the pop-up menu. This displays
the Submit Ad Hoc Job into Plan window.
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3. In the Submit Ad Hoc Job into Plan window, fill in the text
boxes as follows:

Task Type
Select the task type of the ad hoc job.

4. Click OK to specify the properties of this submitted ad hoc job.
When you click the OK button, the General tab is displayed of
the Properties - Job Instance window.

Figure 111. Submit Ad Hoc Job into Plan window.

Figure 112. Properties - Job Instance: General window.
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The following are descriptions of the text boxes and options in
the General view of the Properties - Job Instance window.

Job Displays information about the ad hoc job.

Alias Specify an Alias name for the ad hoc job, if
necessary.

Workstation
Specify the name of the workstation of the ad
hoc job.

Into Displays information about the job stream into which
the ad hoc job is submitted.

Job Stream
Specify the name of the job stream for the ad
hoc job. The workstation for this job stream
instance is only displayed when the Submit >
Ad Hoc command was invoked from the Job
Stream Instance list. For JOBS job stream, the
Properties - Job Instance window job instance
will be submitted into the JOBS job stream on
the workstation for the job specified in the field
above.

Task Type
Displays the task type of the submitted ad hoc job.

Login Displays the UNIX or Windows NT User ID that
launches the ad hoc job.

Priority
Specifies the priority of the submitted job. To change
the priority, specify a value into the field or click Hold
to select priority 0, High to select priority 100, Go to
select priority 101, or Default to select the default
priority of the submitted ad hoc job. Possible priority
values are 0 through 101, where 101 is the highest
priority. A priority value of zero prevents the ad hoc job
from launching.
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Is Interactive
Specify whether this is an interactive job or not.
Interactive jobs are for Windows NT only.

Recovery Options
Displays information about the recovery options of the
submitted ad hoc job.

Action
Displays the recovery action for the submitted
ad hoc job. It can be Stop, Continue, or
Rerun.

Message
Specify the text of a recovery prompt. The text
can contain up to 64 characters. The default
behavior of a prompt is to display a message
and wait for a reply. If the string begins with a
colon (:), the message is displayed but no reply
is necessary. If the string begins with an
exclamation mark (!), the message is not
displayed but it requires a reply.

Job

Displays the name of a recovery job to run if
the parent job abends. To change the name,
click the Find button and select a job from a
list. Recovery jobs are run only once for each
abended instance of the parent ad hoc job.

Workstation
Displays the name of the workstation on which
the recovery job runs. The name is entered
automatically when you select a recovery job.

Not all jobs are eligible to have recovery jobs
run on a different workstation. Follow these
guidelines:
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¶ If either workstation is an extended agent, it
must be hosted by a domain manager or a
fault-tolerant agent that runs in Full Status
mode.

¶ The recovery job’s workstation must be in
the same domain as the parent job’s
workstation.

¶ If the recovery job’s workstation is a
fault-tolerant agent, it must run in Full
Status mode.

Requires Confirmation
Check this box to indicate that ad hoc job completion
must be confirmed by the operator.

5. To display task information, click Task in the left window of
the Properties - Job Instance window. This displays the Task
view.

6. The Task view is different for each task type.

Figure 113. Properties - Job Instance: Task window.
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For task types Unix Script and NT Script, fill in the text box
as follows:

Script

Specifies the name of the file the ad hoc job executes.
Specify the file name and any options and arguments.
For non-expanded databases, the text box can contain
up to 255 characters. For expanded databases, it can
contain up to 4095 characters.

For Windows NT ad hoc jobs, include the file
extensions. Universal Naming Convention (UNC) names
are permitted. Do not specify files on mapped drives.

If spaces or special characters are included, other than
slashes (/) and backslashes (\), the entire string must be
enclosed in quotes (″).

If the file name contains spaces, specify the name in
another file that does not have spaces in its name and
use the second file’s name in this text box.

To include a parameter in the Script text box, do the
following:

¶ Place the cursor in the Script text box where you
want to insert the parameter and click the Add
Parameter button.

¶ This displays the Find Parameters window.

¶ Specify a parameter name in the Find text box. The
name can contain wildcard characters.

¶ Click the Start button to display a list of parameter
names.

¶ Select a parameter name in the list click the OK
button.

A parameter can be used for all or part of the text box
and multiple parameters are permitted.
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For task types Unix Command and NT Command, fill in the
text box as follows:

Command

Specifies the name of the command the ad hoc job
executes. Specify the command name and any options
and arguments. For non-expanded databases, the text
box can contain up to 255 characters. For expanded
databases, it can contain up to 4095 characters.
Commands are executed directly and the jobmanrc
standard configuration script is not executed.

To include a parameter in the Command text box, do
the following:

¶ Place the cursor in the Command text box where
you want to insert the parameter and click the Add
Parameter button.

¶ This displays the Find Parameters window.

¶ Specify a parameter name in the Find text box. The
name can contain wildcard characters.

¶ Click the Start button to display a list of parameter
names.

¶ Select a parameter name in the list click the OK
button.

A parameter can be used for all or part of the text box
and multiple parameters are permitted.

For task type MPE Job File, fill in the text box as follows:

Job File

Specifies the name of the MPE file the ad hoc job
executes. For example, JFILE4.JCL.CORP.

For task type MPE User Job, fill in the text box as follows:

User Job
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Specifies the name from the JOB card of the MPE job.
For example, $userjob=UJOB5.

For task type Extended Agent Task,fill in the text box as
follows:

Extended Agent Task
Displays information about the extended agent task.

Task Enter the XAgent script path or filename or the
XAgent command for this job.

Add Parameter...
Click this button to add a predefined parameter
to the task specification.

For task type SAP Job, refer to the Tivoli Workload Scheduler
Extended Agent for SAP/R3 User’s Guide for information about
defining the task.

7. To display time restrictions, click Time Restrictions in the left
panel of the Properties - Job Instance window. This displays the
Time Restrictions view.
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The following are descriptions of the text boxes and options in
the Time Restrictions view of the Properties - Job Instance
window.

Start Specifies the earliest time the ad hoc job will be
launched. The ad hoc job will not be launched before
this time. To change the time, make your selections as
follows:

Specify date and time
Select this option to enable the entry of a start
time.

Date Specify the start date or click the calendar
button and select a date from the drop-down
calendar.

Time Specify a start time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Figure 114. Properties - Job Instance: Time Restrictions window.
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Deadline
Specifies the latest time the ad hoc job will be
launched. The ad hoc job will not be launched after this
time. To change the time, make your selections as
follows:

Specify date and time
Select this option to enable the entry of a
deadline time.

Date Specify the deadline date or click the calendar
button and select a date from the drop-down
calendar.

Time Specify a deadline time in the following format:

hh:mm am|pm

For example, 11:30 am or 4:25 pm.

Time Zone
If the Time Zone option is enabled, specify the time
zone in which the ad hoc job runs. The start time and
deadline time are in this time zone. For more
information about the time zone feature, refer to “Time
Zones” on page 21.

Repeat Range
Specifies the repetition rate of the ad hoc job. The ad
hoc job is launched multiple times at this rate. Make
your selections as follows:

Hours Specify the hours. The value can be 00 to 23.

Minutes
Specify the minutes. The value can be 00 to 59.

8. To view or modify file dependencies, click Files in the left
panel of the Properties - Job Instance window. This displays the
Files view.
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The following are descriptions of the column headings in the
Files view.

Filename
Specifies the path and name of the file.

Workstation
Specifies the workstation on which the file resides.

Qualifiers
Specifies the test conditions for the file dependency.

Release Status
Specifies the status of the file dependency. This field is
read only for submitted job instances. The possible
values are:

Not Released
The ad hoc job is not released from the file
dependency.

Figure 115. Properties - Job Instance: Files window.

Submitting Jobs and Job Streams Into the Plan

364 Version 7.0



Released
The ad hoc job is released from the file
dependency.

Internal Status
Specifies the internal status of the file dependency. The
possible values are:

Not Checked
The file dependency has not been checked.

Checking
The file dependency is being checked.

Exists The file dependency is satisfied.

Does Not Exist
The file dependency is not satisfied.

9. To add a file dependency for the ad hoc job, do the following:

a. Click the Add Row (+) button. This creates a new row in
the list of file dependencies.

b. Double-click the text box in the Filename column and type
in a file name.

c. Double-click the text box in the Workstation column and
click the Find button to locate and insert the name of the
workstation on which the file exists or will be created.

d. Double-click the text box in the Qualifiers column and
specify the test conditions for the file dependency. On
UNIX, the valid qualifiers are the same as UNIX test
command conditions. For more information, refer to your
UNIX system documentation.

On Windows NT, only the following qualifiers are valid:

-d %p True if the file exists and is a directory.

-e %p True if the file exists.

-f %p True if the file exists and is a regular file.

-r %p True if the file exists and is readable.

Submitting Jobs and Job Streams Into the Plan
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-s %p True if the file exists and it’s size is greater
than zero.

-w %p True if the file exists and is writable.

On both UNIX and Windows NT, the expression %p,
inserts the file name.

Entering notempty is the same as entering -s %p. If no
qualifier is specified, the default is -f %p.

10. To remove a file dependency for the ad hoc job, select the file
row in the list and click the Delete from Table (X) button.

11. To display prompt dependencies, click Prompts in the left panel
of the Properties - Job Instance window. This displays the
Prompts view.

12. To display ad hoc prompt dependencies, select Ad Hoc Prompt
from the drop-down list in the toolbar.

Figure 116. Properties - Job Instance: Prompts window.
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The following are descriptions of the column headings in the
Prompts view.

Message Text
Specifies the text of the prompt message.

Workstation
Specifies the workstation that displays the prompt
message text.

Number
Specifies the internal TWS ID number of the prompt
dependency.

Release Status
Specifies the status of the prompt dependency. This
field is read only for submitted job instances. The
possible values are:

Not Released
The ad hoc job instance is not released from the
prompt dependency.

Released
The ad hoc job instance is released from the
prompt dependency.

Internal Status
Specifies the internal status of the prompt dependency.
The possible values are:

Not Asked
The prompt has not been asked.

Asked The has been asked, but no response has been
received.

Yes The prompt has been answered affirmatively
and the ad hoc job dependency is released.

No The prompt has been answered negatively and
the ad hoc job dependency is not released.

Reply Specifies the reply to the prompt dependency. This field
is read only for submitted job instances.

Submitting Jobs and Job Streams Into the Plan
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13. To display pre-defined prompt dependencies, select Predefined
Prompt from the drop-down list in the toolbar.

The following are descriptions of the column headings in the
Prompts view.

Name Specifies the name of the prompt.

Message Text
Specifies the text of the prompt message.

Number
Specifies the internal TWS ID number of the prompt
dependency.

Release Status
Specifies the status of the prompt dependency. This
field is read only for submitted job instances. The
possible values are:

Not Released
The ad hoc job instance is not released from the
prompt dependency.

Released
The ad hoc job instance is released from the
prompt dependency.

Internal Status
Specifies the internal status of the prompt dependency.
The possible values are:

Not Asked
The prompt has not been asked.

Asked The has been asked, but no response has been
received.

Yes The prompt has been answered affirmatively
and the job dependency is released.

No The prompt has been answered negatively and
the job dependency is not released.

Reply Specifies the reply to the prompt dependency. This field
is read only for submitted job instances.

Submitting Jobs and Job Streams Into the Plan
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14. To add a prompt dependency for the ad hoc job instance, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of prompt dependencies.

b. For a pre-defined prompt, double-click the text box in the
Name column and click the Find button to locate and insert
the name of a prompt.

c. For an ad hoc prompt, double-click the text box in the
Message Text column and type in the text of the prompt.
The default behavior of a prompt is to display a message
and wait for a reply. If the string begins with a colon (:), the
message is displayed but no reply is necessary. If the string
begins with an exclamation mark (!), the message is not
displayed but it requires a reply. You can include backslash
n (\n) within the text for new lines.

You can include one or more TWS parameters as part or all
of the text string. To use a parameter, place its name
between carets (^).

15. To remove a prompt dependency for the ad hoc job, select the
prompt row in the list and click the Delete from Table (X)
button.

16. To display resource dependencies, click Resources in the left
panel of the Properties - Job Instance window. This displays the
Resources view.

Submitting Jobs and Job Streams Into the Plan
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The following are descriptions of the column headings in the
Resources view.

Resource
Specifies the name of the resource.

Workstation
Specifies the workstation on which the resource resides.

Quantity
Specifies the number of units of the resource that are
needed by the ad hoc job to satisfy the dependency.

Available
Specifies the number of units of the resource that are
currently available.

Release Status
Specifies the status of the resource dependency. This
field is read only for submitted job instances. The
possible values are:

Figure 117. Properties - Job Instance: Resources window.
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Not Released
The job instance is not released from the
resource dependency.

Released
The job instance is released from the resource
dependency.

17. To add a resource dependency for the ad hoc job instance, do
the following:

a. Click the Add Row (+) button. This creates a new row in
the list of resource dependencies.

b. Double-click the text box in the Workstation column and
click the Find button to locate and insert the name of a
workstation.

c. Double-click the text box in the Name column and click the
Find button to locate and insert a resource name.

d. Double-click the text box in the Quantity column and
specify the number of resource units required by the ad hoc
job instance. The default is one.

18. To delete a resource dependency for the ad hoc job instance,
select the resource row in the list and click the Delete from
Table (X) button.

19. To display predecessor jobs and job streams, click Predecessors
in the left panel of the Properties - Job Instance window. This
displays the Predecessors view.

Submitting Jobs and Job Streams Into the Plan
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The following are descriptions of the column headings in the
Predecessors view.

Job Stream
Specifies the name of the predecessor job stream.

Job Specifies the name of job in the predecessor job stream.

Workstation
Specifies the name of the predecessor job stream’s
workstation.

Release Status
Specifies the status of the predecessor job or job stream.

Internal Status
Specifies the TWS internal status of the predecessor job
or job stream. For more information on job or job
stream status refer to “Status Description and Mapping”
on page 375.

Figure 118. Properties - Job Instance: Predecessors window.
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20. To add a predecessor for the ad hoc job instance, do the
following:

a. Click the Add Row (+) button. This creates a new row in
the list of predecessors.

b. To specify a predecessor job stream, double-click the text
box in the Job Stream column and click the Find button to
locate and insert the name of a job stream.

c. To specify a predecessor job, double-click the text box in
the Job column and click the Find button to locate and
insert a resource name.

21. To delete a predecessor for the ad hoc job instance, select the
predecessor row in the list and click the Delete from Table (X)
button.

22. When you are finished in the Properties - Job Instance window,
do one of the following:

¶ Click the OK button to submit the ad hoc job and close the
window.

¶ Click the Cancel button to close the window without
submitting the ad hoc job.

Submitting Jobs and Job Streams Into the Plan
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Status Description and Mapping

This appendix provides information on job and job stream status,
both Job Scheduling Console status and Internal TWS.

Status Overview
There are two types of status in TWS 7.0:

JS Console status
Job Scheduling Console status is a subset of internal status
and is common for both TWS and OPC.

Internal Status
Internal status refers to the TWS internal or engine status for
the job or job stream. The internal status messages are
unique to TWS.

Job Status
This section describes the job status for both Job Scheduling Console
and TWS Internal status.

JS Console Job Status
Below are listed possible job states and descriptions:

WAITING
The job stream instance is waiting for its dependencies to be
resolved.

A

375Tivoli Workload Scheduler User’s Guide

A
.

S
tatu

s
D

escrip
tio

n
an

d
M

ap
p

in
g



READY
The dependencies of the job stream instance have been
resolved and the job stream instance is ready to run.

RUNNING
The job stream instance is executing.

SUCCESSFUL
The job stream instance completed successfully.

ERROR
The job stream instance has stopped execution with an error.

CANCELED
The job stream instance was canceled.

HELD
The job stream instance was interrupted.

UNDECIDED
The job stream status is currently being checked.

BLOCKED
The job stream instance was blocked due to unfulfilled
dependencies.

TWS Internal Job Status
Below are listed possible job states and descriptions:

ABEND
The job terminated with a non-zero exit code.

ABENP
An abend confirmation was received, but the job is not
completed.

ADD The job is being submitted.

DONE
The job completed in an unknown state.

ERROR
For internetwork dependencies only, an error occurred while
checking for the remote status.

Job Status
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EXEC
The job is executing.

EXTRN
For internetwork dependencies only, the status is unknown.
An error occurred, a rerun action was just performed on the
job in the external job stream, or the remote job or job
stream does not exist.

FAIL Unable to launch the job.

FENCE
The job’s priority is below the fence.

HOLD
The job is awaiting dependency resolution.

INTRO
The job is introduced for launching by the system.

PEND The job completed, and is awaiting confirmation.

READY
The job is ready to launch, and all dependencies are
resolved.

SCHED
The job’s at time has not arrived.

SUCC The job completed with an exit code of zero.

SUCCP
A SUCC confirmation was received, but the job is not
completed.

SUSP The job was suspended by a breakjob command. (MPE
only)

WAIT The job is in the wait state. (Extended agent and MPE only)

WAITD
The job is in the wait state, and is deferred. (MPE only)

Job Status
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Job Stream Status
This section describes the job stream status for both Job Scheduling
Console and TWS Internal status.

JS Console Job Stream Status
Below are listed possible job stream states and descriptions:

WAITING
The job stream instance is waiting for its dependencies to be
resolved.

READY
The dependencies of the job stream instance have been
resolved and the job stream instance is ready to run.

RUNNING
The job stream instance is executing.

SUCCESSFUL
The job stream instance completed successfully.

ERROR
The job stream instance has stopped execution with an error.

CANCELED
The job stream instance was canceled.

HELD
The job stream instance was interrupted.

UNDECIDED
The job stream status is currently being checked.

BLOCKED
The job stream instance was blocked due to unfulfilled
dependencies.

TWS Internal Job Stream Status
Below are listed possible job stream states and descriptions:

READY
The dependencies for the job stream have been met but the
time restrictions for the job stream have not.

Job Stream Status
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HOLD
The job stream instance is awaiting dependency resolution.

CANCEL PEND
The job stream instance is pending cancelation. Cancelation
is deferred until all of the dependencies, including an at
time, are resolved.

EXEC
The job stream instance is executing.

STUCK
Job stream instance execution was interrupted. No jobs are
launched without operator intervention.

ABEND
The job stream instance terminated with a non-zero exit
code.

SUCC The job stream instance completed successfully.

CANCEL
The job stream instance was canceled.

ADD The job stream instance was added with operator
intervention.

EXTRN
The job stream instance is in a remote TWS network and its
status is unknown. An error occurred, a Rerun action was
performed on the EXTERNAL job stream, or the INET job
or job stream does not exist.

ERROR
This is for Internetwork job streams and specifies that an
error occurred while checking for the remote status.

Status Mapping
This section provides a table of how Job Scheduling Console status
map to TWS Internal status for jobs and job streams.

Job Stream Status
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Job Status Mapping
The following table describes how Job Scheduling Console status
correlate to TWS Internal status for jobs.

JS Console Status TWS Internal Status

Waiting ADD, PEND, WAIT, WAITD, INTRO, HOLD

Ready READY

Running EXEC, SUCCP, ABENP

Successful SUCC

Error ABEND, FAIL

Canceled Status of the job when it was canceled.
Canceled flag is set.

Held Priority = 0, WAITING, READY

Undecided ERROR, EXTRN

Blocked SUSP

Job Stream Status Mapping
The following table describes how Job Scheduling Console status
correlate to TWS Internal status for job streams.

JS Console Status TWS Internal Status

Waiting ADD, PEND, WAIT, WAITD, INTRO, HOLD

Ready READY

Running EXEC

Successful SUCC

Error ABEND, FAIL

Canceled CANCEL, HOLD, CANCEL P

Held HOLD

Undecided EXTRN, ERROR

Blocked STUCK

Status Mapping
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TWS Networks

A TWS network consists of one or more TWS domains arranged
hierarchically. A TWS domain is a logical grouping of computers,
consisting of a domain manager and a number of agents.

D1 (Master Domain)

D2 - Dn

DM

FTA SA FTA XA

DM

FTA FTA SA XA

D1

D2 D3

D4 D5 D6

D7 D8 D9 D10

Subordinate DMs

Subordinate DMs

Parent DM

Definitions
Backup Domain Manager

A fault-tolerant agent capable of assuming the
responsibilities of its domain manager.

B
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Domain
A named group of TWS workstations consisting of one or
more agents and a domain manager. All domains have a
parent.

Domain Manager (DM)
The management hub in a domain. All communications in
and from the agents in a domain is routed through the
domain manager. See also Master Domain Manager.

Extended Agent (xa)
An agent workstation that launches jobs only under the
direction of its host. Extended agents can be used to
interface TWS with non-TWS systems and applications

Fault-tolerant Agent (fta)
An agent workstation capable of resolving local
dependencies and launching its jobs in the absence of a
domain manager.

Host (x-host)
The scheduling function required by extended agents It can
be performed by any TWS workstation, except another
extended agent.

Master Domain Manager
The domain manager in the topmost domain of a TWS
network. It contains the centralized master files used to
document scheduling objects. It creates the Production
Control file at the start of each day and performs all logging
and reporting for the network. See also Domain Manager.

Master Domain
The topmost domain in a Maestro network.

Parent Domain
The domain directly above the current domain. All domains,
except the master domain, have a parent domain. All
communications to/from a domain is rooted through the
parent domain manager.

Definitions
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Standard Agent (sa)
An agent cpu that launches jobs only under the direction of
its domain manager.

TWS for MPE
TWS networks can contain a mix of MPE (Hewlett-Packard
proprietary operating system), Windows NT, UNIX, and other
computers and agents. For more information, see the Maestro for
MPE User’s Guide.

Network Communications
In a TWS network, agents communicate with their domain managers,
and domain managers communicate with their parent domain
managers. There are basically two types of communications that take
place: 1) start-of-day initialization, and 2) scheduling events in the
form of change-of-state messages during the processing day.

Before the start of each new day. the master domain manager creates
a production control file called Symphony. Then, TWS is restarted in
the network, and the master domain manager sends a copy of the
new Symphony file to each of its automatically-linked agents and
subordinate domain managers. The domain managers, in turn, send
copies to their automatically-linked agents and subordinate domain
managers. Agents and domain managers that are not set up to link
automatically are initialized with a copy of Symphony as soon as a
link operation is executed in TWS.

Once the network is started, scheduling messages, like job starts and
completions, are passed from the agents to their domain managers,
through parent domain managers to the master domain manager. The
master domain manager then broadcasts the messages throughout the
hierarchical tree to update the Symphony files of all domain
managers and all fault-tolerant agents running in full status mode.

Network Links
Links provide bidirectional communications between TWS
workstations in a network. Links are controlled by the AUTO Link
flag, and the Console Manager Link and Unlink commands. When a

Definitions
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link is open, messages are passed between two workstations. When a
link is closed, the sending workstation stores messages in a local
pobox file and sends them to the destination workstation when the
link is reopened.

Note: Extended agents do not have links. They communicate with
their domain managers via their hosts.

To have a workstation link opened automatically, turn on the AUTO
Link flag in the workstation’s definition. The link is first opened
when TWS is started on the Master Domain workstation. If the
subdomain manager and workstations are not initialized and their
AUTO Link flag is on, the master domain manager attempts to link
to its subordinates and begin the initialization processes. If the
AUTO Link flag is turned off, the workstation is only initialized by
executing a Link command from the master domain manager. After
the workstation is initialized, it automatically starts and issues a link
back to its domain manager.

If you stop a workstation, the paths from it to other workstations are
closed. However, the paths from the other workstations to it remain
open until either:

¶ the stopped workstation is restarted and a Link command is
issued

¶ the other workstations’ Mailman processes time out

To be certain that interworkstation communication is properly
restored, you can issue a Link command after restarting a
workstation.

Network Operation
The Batchman process on each domain manager and fault-tolerant
agent workstation operates autonomously, scanning its Symphony
files to resolve dependencies and launch jobs. Batchman launches
jobs via the Jobman process. On a standard agent, the Jobman
process responds to launch requests from the domain manager’s
Batchman.

Network Communications
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The master domain manager is continuously informed of job
launches and completions and is responsible for broadcasting the
information to domain managers and fault-tolerant agents so they can
resolve any interworkstation dependencies.

The degree of synchronization among the Symphony files depends
on the setting of Full Status and Resolve Dependencies modes in a
workstation’s definition. Assuming that these modes are turned on, a
fault-tolerant agent’s Symphony file contains the same information as
the master domain manager’s (see “Managing Workstations in the
Database” on page 191).

Symphony

Batchman

Jobmon

job job jobjobjob

Jobmon

Fault-Tolerant
Agent

Master/Domain
Manager

Standard
Agent

Symphony

Batchman

Jobmon

job

Network Processes
Netman is started by the StartUp script. The order of process
creation is Netman, Mailman, Batchman, and Jobman. On standard
agent workstations, Batchman does not execute. All processes,
except Jobman, run as the TWS user. Jobman runs as root.

As network activity begins, Netman receives requests from remote
Mailman processes. Upon receiving a request, Netman spawns a
Writer process and passes the connection off to it. Writer receives
the message and passes it to the local Mailman. The Writer
processes (there may be more than one on a domain manager) are
started by link requests and are stopped by unlink requests (or when
the communicating Mailman terminates).

Network Operation
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Domain managers, including the master domain manager, can
communicate with a large number of agents and subordinate domain
managers. For improved efficiency, you can define Mailman servers
on a domain manager to distribute the communications load (see
“Managing Workstations in the Database” on page 191).

Batchman

Jobmon

Fault-Tolerant
Agent

Master/Domain
Manager

Extended
Agent

Jobmon

Batchman

Mailman Mailman

Writer Writer

Netman

StartUpStartUp

Netman

method

Non-Maestro
system or
application

Extended Agents
An extended agent (xa or x-agent) serves as an interface to an
external, non-TWS system or application. It is defined as a TWS
workstation with an access method and a host. The access method
communicates with the external system or application to launch and
monitor jobs and test Opens file dependencies. The host is another

Network Operation
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TWS workstation (except another xa) that resolves dependencies and
issues job launch requests via the method.

Jobs are defined for an x-agent in the same manner as for other
TWS workstations, except that job attributes are dictated by the
external system or application.

Extended agent software is available for several systems and
applications. The UNIX xa’s, included with TWS, are described in
the following section. Please contact your Tivoli Systems sales
representative for information about other extended agents. For
information on defining TWS workstations, see “Managing
Workstations in the Database” on page 191. For information on
writing access methods, see the Tivoli Workload Scheduler Reference
Guide.

UNIX Extended Agents
TWS includes access methods for two types of UNIX extended
agents. The Local UNIX method allows a single UNI computer to
operate as two TWS workstations, both of which can execute
TWS-scheduled jobs. The Remote UNIX access method allows you
to designate a remote UNIX computer to run TWS-scheduled jobs
without having TWS installed on it.

Information about a job’s execution is sent to TWS from an
extended agent via the job’s stdlist file. A Method Options file can
specify alternate logons to launch jobs and check Opens file
dependencies. For more information, see the Tivoli Workload
Scheduler Reference Guide.

Local UNIX Access Method
The Local UNIX method can be used to define multiple TWS
workstations on one computer: the host workstation and one or more
extended agents. When TWS sends a job to a local UNIX xa, the
access method, unixlocl, is invoked by the host to execute the job.
The method starts by executing the standard configuration script on
the host workstation (TWShome/jobmanrc). If the job’s logon user is
permitted to use a local configuration script and the script exists as
$HOME/.jobmanrc, the local configuration script is also executed.

Extended Agents
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The job itself is then executed either by the standard or the local
configuration script. If neither configuration script exists, the method
starts the job.

The launching of the configuration scripts, jobmanrc and .jobmanrc
is configurable in the method script. The method executes the
configuration scripts by default, if they exist. To disable this feature,
you must comment out a set of lines in the method script. For more
information, examine the script file TWShome/methods/unixlocl on
the x-agent’s host.

Remote UNIX Access Method
The Remote UNIX access method can be used to designate a
non-TWS computer to run TWS-scheduled jobs. When TWS sends a
job to a remote UNIX extended agent, the access method, unixrsh,
creates a /tmp/maestro directory on the non-TWS computer. It then
transfers a wrapper script to the directory and executes it. The
wrapper then executes the scheduled job. The wrapper is created
only once, unless it is deleted, moved, or is outdated.

To execute jobs via the x-agent, the job logon users must be given
appropriate access on the non-TWS UNIX computer. To do this, a
.rhost, /etc/host.equiv, or equivalent file should be set up on
the computer. If Opens file dependencies are to be checked, root
access must also be permitted. Contact your system administrator for
help. For more information about the access method, examine the
script file Maestrohome/methods/unixrsh on an x-agent’s host.

Managing Production for Extended Agents
In general, jobs that run on x-agents behave like other TWS jobs.
TWS tracks a job’s status and records output in the job’s stdlist
files. These files are stored on the x-agent’s HOST workstation. For
more information on managing jobs, see “TWS Plan Tasks” on
page 237.

Failure Launching Jobs on an X-Agent
If the access method is not located in the proper directory on the
x-agent’s host or the method cannot be accessed by TWS, jobs will
fail to launch or a file dependency will not be checked. For a job,
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the TWS job’s logon or the logon specified in the Method Options
file must have read and execute permissions for the access method.
When checking a file to satisfy an Opens dependency, root is used
as the login unless another login is specified in the Method Options
file. For more information on Method Options, see the Tivoli
Workload Scheduler Reference Guide

Netman Configuration File
The Netman configuration file exists on all TWS workstations. If
Netman is installed in TWS’ home directory (the default), the name
of the file is Maestrohome/Netconf. If Netman is installed in a
separate directory, the name of the file is netmanhome/Netconf. It
defines the services provided by Netman. The NetConf file supplied
by Tivoli includes comments describing each service. The services
are:

2001 Start a Writer process to handle incoming messages from a
remote Mailman.

2002 Start the Mailman process. Mailman, in turn, starts the rest
of TWS’ process tree (Batchman, Jobman).

2003 Stop TWS’ process to handle incoming messages from a
remote Mailman.

2004 Find and return a stdlist file to the requesting Conman
process.

2005 Switch the domain manager in a domain.

2501 Check the status of a remote job.

2502 Start the Console Manager–a service requested by the client
side of the Remote Console. See the Tivoli Remote Console
User’s Guide for more information.

The Mailman service (2002) can include a parameter that determines
the size of TWS’s internal Symphony table. The table should
contain enough space for all the records in the Symphony file, plus
additional space for work submitted after TWS has started its
production run. The syntax for the NetConf entry is:

Extended Agents
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2002 son bin/mailman [-parm value]

In the -parm option, value can be one of the following:

-number
The Symphony table is built with space for exactly this
many records. For example, -parm 6000 builds a table with
space for exactly 6000 records. The maximum permitted is
65,535 records. Setting the parameter to -1 ensures the
maximum size is used.

number
The Symphony table is built with space for all records in the
Symphony file, plus this many additional records.

If yo receive a message indicating that there are too many jobs
scheduled for Batchman to handle, it may be necessary to increase
the size of the Symphony table. Before doing so, contact your Tivoli
support representative for help in determining an appropriate size.

Network IP Address Validation
When a TCP/IP connection is established, Netman reads the
requester’s nodename and IP address from the socket. The IP address
and nodename are used to search the Symphony file for a known
TWS workstation with one of the following possible results:

¶ If an IP address match is found the validation is considered
successful.

¶ If a nodename match is found, the validation is considered
successful.

¶ If no match is found in Symphony or the IP address returned by
gethostbyname() does not match the one read from the socket,
the validation is considered unsuccessful.

The Local Option, nm ipvalidate, determines the action to be
taken if IP validation is unsuccessful. If the option is set to full,
unsuccessful validation causes TWS to close the connection and
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generate an error message. If the option is set to none, TWS permits
all connections, but generates a warning message for unsuccessful
validation checks.

System Configuration (UNIX only)
IP validation depends on the system call gethostbyname() to look
up all the valid addresses for a host. The behavior of this routine
varies, depending on the system configuration. When
gethostbyname() uses the file /etc/hosts, it returns the first
matching entry. If the connection is initiated on an address that
appears after the first matching entry, IP validation fails, To resolve
the problem, place the entry used to initiate the connection before
any other matching entries in the /etc/hosts file. If
gethostbyname() uses the ″named″ name server or the Network
Information Service server and gethostbyname() fails, contact your
system administrator for assistance.

Error/Warning Messages
Following is a list of the messages for IP validation. If the Local
Option nm ipvalidate is set to none, the errors appear as warnings.

¶ TWS workstation name is not found in the Symphony file
Ip address validation failed for request:
Service num for program on cpu(os_type).
Connection received from IP address:
c_ipaddr. MAESTRO CPU cpu not found in
Symphony file.

¶ Call to gethostbyname()fails:
IP address validation failed for request:
Service num for program on cpu(os_type).
Connection received from IP address:
c_ipaddr. gethostbyname() failed, unable to
retrieve IP address of connecting node: node.

¶ IP Addresses returned by gethostbyname()do not match the IP
address of connection workstation:
IP address validation failed for request:
Service num for program on cpu(os_type).
Connection received from IP address:
c_ipaddr. System known IP addresses for node
name node: k_ipaddr.

Network IP Address Validation
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¶ The IP address specified in the workstation definition for the
TWS workstation specified in service request packet does not
match the IP address of connecting workstation:
IP address validation failed for request:
Service num for program on cpu(os_type).
Connection received from IP address:
c_ipaddr. TWS known IP addresses for cpu
k_ipaddr.

¶ Regardless of the state of nm ipvalidate, the following
information message is displayed when IP validation cannot be
performed because the Symphony file does not exist or an error
occurs when reading it:
IP address validation not performed for
request: Service num for program on
cpu(os_type). Connection received from IP
address: c_ipaddr. Cannot open or read
Symphony file. Service request accepted.

Where:

num service number (2001-writer, 2002-mailman...)

program
program requesting service

cpu TWS workstation name of connecting workstation

os_type
operating system of connecting workstation

node node name or IP address of connecting workstation

c_ipaddr
IP address of connecting workstation

k_ipaddr
known IP address for connecting workstation

IP validation is always successful in the absence of a Symphony
file. In a TWS domain manager to an agent is normally successful
because a Symphony file does not yet exist. However, if the agent
has a Symphony file from a previous TWS run, the initial link
request may fail if the Symphony file does not include the name of
the domain manager.

Network IP Address Validation
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Network Recovery
Several types of problems may make it necessary to follow network
recovery procedures. These include:

¶ Initialization problems that prevent agents and domain managers
from starting properly at the start of a new day

¶ Network link problems that prevent agents from communicating
with their domain managers

¶ Loss of a domain manager, which requires a switch to a backup

Note: In all cases, a problem with a domain manager affects all of
its agents and subordinate domain managers.

Initialization Problems
Initialization problems can occur when TWS is started for a new
day. This can be caused by having TWS processes running on an
agent or domain manager from the previous day or a previous TWS
run. To initialize the agent or domain manager in this situation, do
the following:

1. For a domain manager, log into the parent domain manager or
the master domain manager. For an agent, log into the agent
domain manager, the parent domain manager, or the master
domain manager.

2. Run the Console Manager and execute a Stop command for the
affected agent.

3. Execute a Link command for the affected agent. This initializes
and starts the agent.

If these actions fail to work, check to see if netman is running on
the affected agent. If not, issue the startup command locally and then
issue a LINK command from its domain manager. If there are severe
network problems, a fault-tolerant agent or subordinate domain
manager can be run as a stand-alone system. To do this, stop the
agent or domain manager and copy the file TWShome\Sinfonia from
the master domain manager. Rename the copied file
TWShome\Symphony and start the agent or domain manager. Any
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interworkstation dependencies must be resolved locally using
appropriate Console Manager commands: Delete Dependency and
Release, for example.

Network Link Problems
TWS has a high degree of fault tolerance in the event of a
communications problem. Each fault-tolerant agent has its own copy
of the Symphony file, containing the day’s processing. When link
failures occur, they continue processing using their own copies of
Symphony. Any interworkstation dependencies, however, must be
resolved locally using appropriate Console Manager commands:
Delete Dependency and Release, for example.

While a link is down, any messages destined for a
noncommunicating workstations are stored by the sending
workstations in the TWShome\pobox directory, in files named
workstationname.msg.When the links are restored, the
workstations begin sending their stored messages. If the links to a
domain manager will be down for an extended period of time, it
may be necessary to switch to a standby.

Notes
¶ The Console Manager Submit Job and Submit Schedule

commands cannot be used on an agent that cannot communicate
with its domain manager.

¶ If the link to a standard agent workstation is lost, there is no
temporary recovery option available, because standard agents are
hosted by their domain managers. In networks with a large
number of standard agents, you can choose to switch to a
standby.

Setting Up a Standby Domain Manager
Being prepared for network problems makes recovery easier. In
particular, you should perform the following actions:

¶ Designate a fault-tolerant agent in the domain to be a standby
domain manager.
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¶ Make certain that the Full Status and Resolve Dependencies
modes are selected in the standby’s workstation definition.

¶ Ensure the domain managers (including the Master DM) have
full status and resolve dependency turned on. This is important if
you need to resort to long-term recovery, where the backup
master generates a Symphony file (runs Jnextday). If those
records are not enabled, the former master domain manager
shows up as a regular fault-tolerant agent after the first
occurrence of Jnextday. During normal operations, the Jnextday
job automatically turns on the full status and resolve dependency
flags for the master domain manager, if they are not already
turned on. When the new master runs Jnextday, it does not
recognize the former master domain manager as a backup master
unless those flags are enabled. The former master does not have
an accurate Symphony file when the time comes to switch back.
Treat the all domain manager’s workstation definitions as if they
were backup domain manager definitions to the new domain
managers. This ensures true fault tolerance.

For a Standby Master Domain Manager
It may be necessary to transfer files between the master domain
manager and its standby. For this reason, the computers must have
compatible operating systems. Do not combine UNIX with Windows
NT computers, and in UNIX, do not combine big-endian with
little-endian computers.

On a daily basis, following start-of-day processing on the master
domain manager, make copies of the Maestrohome\mozart and
TWShome\..\unison\network directories, and the
TWShome\Sinfonia file. The copies can then be moved to the
standby master domain manager, if necessary.

Note: For a UNIX master domain manager, if the
Maestrohome/mozart and ../unison/network directories on
the current master domain manager are reasonably static, they
can be copied to the standby beforehand. During normal
operation, they are hidden when you mount the current master
domain manager’s directories on the standby. If it becomes

Network Recovery

395Tivoli Workload Scheduler User’s Guide

B
.

T
W

S
N

etw
o

rks



necessary to switch to the standby, simply unmounting the
current master domain manager’s directories will make the
standby’s copies accessible.

A Note About Network Security
Network security is enforced using IP address validation. As a
consequence. workstation linking (AUTO Link option or Link
command) may fail if an agent has an old Symphony file that does
not contain the new domain manager. If a connection fails, remove
the old Symphony file on the agent and retry the connection.

Losing a Domain Manager
Loss of a domain manager can occur as the result of network linking
problems or the failure of the domain manager computer itself.
Running without a domain manager has the following effects:

¶ Agents and subordinate domain managers cannot resolve
interworkstation dependencies, because activity records
broadcasted by the master domain manager are not being
received.

¶ Standard agents that are hosted by the failed domain manager
cannot perform any processing, since they depend on the domain
manager for all scheduling and job launching.

If the problem is expected to be of short duration, you can handle it
as described in “Network Link Problems” on page 394. If you are
uncertain about the duration, or if you want to restore normal agent
operation, you must switch to a standby, as described in the
following sections.

Switching a Domain Manager
Use this procedure when you have a short-term loss of the master
domain manager.

1. Run the JS Console.

2. Select the TWS master connector.

3. Select Default Plan List.

4. Click Status of All Domains.
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5. Click refresh.

6. Select Switch Manager...

7. Specify the name of the backup domain manager you want to
use.

8. Click OK.

Domain managers remain switched until you execute another switch
manager operation. To return to the original domain manager, repeat
this procedure. For a switched master domain manager you must do
this before the next day turnover, unless you do not expect the
master domain manager to be available for the next day turnover
(final schedule and Jnextday job). In this case, use the procedure in
the following section.

Extended Loss of Master Domain Manager
Use the following procedure to switch to the standby if the original
master is not expected to return to service before the next new day
turnover (final schedule and Jnextday job). For UNIX, use forward
slashes in pathnames.

1. Use the Console Manager’s Stop function to stop TWS on the
master domain manager and its standby.

2. On UNIX, unmount the master’s directories if they are mounted
on any of the agents or domain managers.

3. Create a method for the standby to access the TWS file system
for UNIX. You can use either of the following:

¶ Copy the maestrohome/mozart and
maestrohome/../unison/network directories to the standby.
Note that you must do this before the event of a total system
failure on the original master.

¶ Set up a mountable file system. You may want to make this
file system external to the master and standby, in case the
original master experiences total system failure. On the
system that contains the maestro directories
maestrohome/mozart and
maestrohome/../unison/network, make sure the directories
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can be mounted via an entry in the etc/exports file. Mount
the file systems on the standby.

4. On the standby, edit the file maestrohome\mozart\globalopts
and change the Global Option master to the workstation name of
the standby.

5. On the standby, use Composer to modify any important job
streams that run on the master domain manager, such as the final
schedule. For each of these, change the workstation name to the
name of the standby.

6. If necessary, on agents and domain managers, mount the
directories from the standby domain manager.

7. Use the Console Manager Switch Manager function to switch to
the backup master. See “Switching a Domain Manager” on
page 396.
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Glossary

A

Access method
An executable used by extended agents to connect and control job execution on
other operating systems (for example, MVS) and applications (for example, Oracle
Applications, Peoplesoft, and Baan). The access method must be specified in the
workstation definition for the extended agent.

B

Batchman
A process started at the beginning of each TWS processing day to launch jobs in
accordance with the information in the Symphony file.

C

Calendar
An object defined in the Tivoli Workload Scheduler database that contains a list of
scheduling dates. Because it is a unique object defined in the database, it can be
assigned to multiple job streams. Assigning a calendar to a job stream causes that
job stream to be executed on the days specified in the calendar. Note that a calendar
can be used as an inclusionary or exclusionary run cycle.

Conman
A legacy command-line application for managing the production environment.
Conman (console manager) performs the following tasks: start and stop production
processes, alter and display schedules and jobs in the plan, and control workstation
linking in a network.

Composer
A legacy command-line application for managing the definitions of your scheduling
objects in the database.

D

Database
A database that contains all the definitions you have created for scheduling objects
(for example, jobs, job streams, resources, workstations, etc). In addition, the
database holds other important information such as statistics of job and job stream
execution, information on the user ID who created an object, and an object’s last
modified date. In contrast, the plan contains only those jobs and job streams
(including dependent objects) that are scheduled for execution in today’s production.
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Deadline
The last moment in time that a job or job stream can begin execution. This
corresponds to the Until time in legacy Maestro.

Dependency
A prerequisite that must be satisfied before the execution of a job or job stream can
proceed. The maximum number of dependencies permitted for a job or job stream is
40. The four types of dependencies used by Tivoli Workload Scheduler are follows
dependencies, resource dependencies, file dependencies, and prompt dependencies.

Domain
A named group of TWS workstations consisting of one or more agents and a
domain manager acting as the management hub. All domains have a parent domain
except for the master domain.

Domain Manager
The management hub in a Tivoli Workload Scheduler domain. All communications
to and from the agents in the domain are routed through the domain manager.

Duration
The time you expect the job to take to complete. In the Timeline view of jobs in the
database, the duration is represented by a light blue bar at the center of the activity
bar or by a light blue diamond.

E

Earliest start time
The time before which the job or job stream cannot start. The earliest start time is
an estimate based on previous experiences running the job or job stream. However,
the job or job stream can start after the time you specify as long as all other
dependencies are satisfied. In the timeline, the start time is represented by the
beginning (left edge) of the navy blue activity bar. For job instances, the start time
that OPC calculates is represented by a light blue bar. See also “Actual start time”
and “Planned start time”.

Exclusionary run cycle
A run cycle that specifies the days a job stream cannot be run. Exclusionary run
cycles take precedent over inclusionary run cycles.

Expanded database
A database that allows longer names for database objects such as jobs, job streams,
workstations, domains, and users. Expanded databases are configured using the
dbexpand command or as an option during installation. Do not expand your
database before understanding the implications and impact of this command.
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Extended agent
An agent used to integrate Tivoli Workload Scheduler’s job control features with
other operating systems (for example, MVS) and applications (for example, Oracle
Applications, Peoplesoft, and Baan). Extended agents use scripts called access
methods to communicate with external systems.

External job
A job from one job stream that is a predecessor for a job in another job stream. An
external job is represented by a place holder icon in the Graph view of the job
stream.

F

Fault-tolerant agent
An agent workstation in the Tivoli Workload Scheduler network capable of
resolving local dependencies and launching its jobs in the absence of a domain
manager.

Fence
The job fence is a master control over job execution on a workstation. The job
fence is a priority level that a job or job stream’s priority must exceed before it can
execute. For example, setting the fence to 40 prevents jobs with priorities of 40 or
less from being launched.

Final Job Stream
The last job stream that is executed in a production day. It contains a job that runs
the script file Jnextday.

Follows dependency
A dependency where a job or job stream cannot begin execution until other jobs or
job streams have completed successfully.

G

Global options
Options that apply to all the workstations of a TWS network. They are defined in
the globalopts file on the master domain manager. See also “Local options”.

H

Host
A Workload Scheduler workstation required by extended agents. It can be any TWS
workstation except another extended agent.
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I

Inclusionary Run Cycle
A run cycle that specifies the days a job stream is scheduled to run. Exclusionary
run cycles take precedent over inclusionary run cycles.

Interactive jobs
A job that runs interactively on a Windows NT desktop.

Internal status
Reflects the current status of jobs and job streams in the TWS engine. Internal
status is unique to TWS. See also Status.

Internetwork (INET) dependencies
A dependency between jobs or job streams in separate Tivoli Workload Scheduler
networks. See also “Network agent”.

Internetwork (INET) job / job stream
A job or job stream from a remote Tivoli Workload Scheduler network that is a
predecessor to a job or job stream in the local network. An Internetwork job is
represented by a place holder icon in the Graph view of the job stream. See also
“Network agent”.

J

Jnextday job
A job scheduled to run at the end of each day in order to fully automate pre- and
post-production processing. A sample jnextday job is provided as
TWShome\Jnextday. Jnextday does the following: sets up the next day’s processing
(contained in the Symphony file), prints reports, carries forward unfinished job
streams, and stops and restarts TWS.

Job
A unit of work that is processed at a workstation. The job definition consists of a
unique job name in the TWS database along with other information necessary to run
the job. When you add a job to a job stream, you can define its dependencies and
its time restrictions such as the estimated start time and deadline.

Job Instance
A job scheduled for a specific run date in the plan. See also “Job”.

Job status
See “Status”.
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Job Stream
A list of jobs that execute as a unit (such as a weekly backup application), along
with times, priorities and other dependencies that determine the exact order of job
execution.

Job stream instance
A job stream that is scheduled for a specific run date in the plan. See also “Job
stream”.

L

Limit
A job limit that provides a means of allocating a specific number of job slots into
which Tivoli Workload Scheduler is allowed to launch jobs. A job limit can be set
for each job stream, and for each workstation. For example, setting the workstation
job limit to 25 permits TWS to have no more than 25 jobs executing concurrently
on the workstation.

List
A list that displays job scheduling objects. You must create separate lists for each
job scheduling object. For each job scheduling object, there are two types of lists:
one of definitions in the database and another of instances in the plan.

Local options
Options that apply only to the workstation on which they are defined. They are
defined in the localopts file on each workstation of a Tivoli Workload Scheduler
network. See also “Global options”.

M

Master Domain Manager
The workstation that maintains the files used to document the scheduling objects in
a Tivoli Workload Scheduler network. It creates the plan at the start of each day,
and performs all logging and reporting for the network.

N

Network agent
A type of extended agent used to create dependencies between jobs and job streams
on separate Tivoli Workload Scheduler networks. See also “Internetwork (INET)
dependency”.
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P

Parameter
A parameter used to substitute values into your jobs and job streams. When using a
parameter in a job script, the value is substituted at run time. In this case, the
parameter must be defined on the workstation where it will be used. Parameters
cannot be used when scripting extended agent jobs.

Plan
A procedure containing all job scheduling activity planned for a period of one day.
In TWS, the plan is created every 24 hours and consists of all the jobs, job streams,
and dependency objects that are scheduled to execute for that day. All job streams
for which you have created run cycles are automatically scheduled and included in
the plan. As the production cycle progresses, the jobs and job streams in the plan
are executed according to their time restrictions and other dependencies. Any jobs or
job streams that do not execute successfully are rolled over into the next day’s plan.

Planned Start Time
The time that TWS estimates a job instance will start. This estimate is based on
start times of previous executions.

Predecessor
A job that must complete successfully before successor jobs can begin execution.

Priority
A time preference in the TWS queuing system for running jobs and job streams in
the plan. You can assign a priority level for each job and job stream from 0 to 101.
A priority of 0 will not execute.

Prompt
An object that can be used as a dependency for jobs and job streams. A Prompt
must be answered affirmatively for the dependent job or job stream to launch. There
are two types of prompts: predefined and ad hoc. An ad hoc prompt is defined
within the properties of a job or job stream and is unique to that job or job stream.
A predefined prompt is defined in the TWS database and can be used by any job or
job stream.

R

Resource
An object representing either physical or logical resources on your system. Once
defined in Tivoli Workload Scheduler database, resources can be used as
dependencies for jobs and job streams. For example, you can define a resource
named ″tapes″ with a unit value of two. Then, define jobs that require two available
tape drives as a dependency. Jobs with this dependency cannot run concurrently
because each time a job is run the “tapes” resource is in use.
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Run cycle
A cycle that specifies the days that a job stream is scheduled to run. In TWS there
are three types of run cycles you can specify for a job stream: a Simple run cycle, a
Weekly run cycle, or a Calendar run cycle (commonly called a calendar). Note that
each type of run cycle can be inclusionary or exclusionary. That is, each run cycle
can define the days a job stream is included in the production cycle, or the days a
job stream is excluded from the production cycle. When you define multiple run
cycles to a job stream, and inclusionary and exclusionary run cycles specify the
same days, the exclusionary run cycles take precedent.

S

Simple Run Cycle
A specific set of user-defined days a job stream is executed. A simple run cycle is
defined for a specific job stream and cannot be used by multiple job streams. For
more information see Run Cycle.

Status
Reflects the current job or job stream status within the Job Scheduling Console. The
Job Scheduling Console status is common to TWS and OPC. See also Internal
status.

stdlist file
A standard list file created for each job launched by Tivoli Workload Scheduler.
Standard list files contain header and trailer banners, echoed commands, errors, and
warnings. These files can be used to troubleshoot problems in job execution.

Successor
A job that cannot start until all of the predecessor jobs on which it is dependent are
completed successfully.

Symphony file
A file containing the scheduling information needed by the Production Control
process (batchman) to execute the plan. The file is built and loaded during the
pre-production phase. During the production phase, it is continually updated to
indicate the current status of production processing: work completed, work in
progress, work to be done. To manage production processing, the contents of the
Symphony file (plan) can be displayed and altered with the Job Scheduling console.

T

Time restrictions
Can be specified for both jobs and job streams. A time can be specified for
execution to begin, or a time can be specified after which execution will not be
attempted. By specifying both, you can define a window within which a job or job
stream will execute. For jobs, you can also specify a repetition rate. For example,
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you can have Tivoli Workload Scheduler launch the same job every 30 minutes
between the hours of 8:30 a.m. and 1:30 p.m.

Tivoli Management Framework (TMF)
The base software that is required to run the applications in the Tivoli product suite.
This software infrastructure enables the integration of systems management
applications from Tivoli Systems Inc. and the Tivoli Partners. The Tivoli
Management Framework includes the following: vObject request broker (oserv)
vDistributed object database vBasic administration functions vBasic application
services vBasic desktop services such as the graphical user interface In a Tivoli
environment, the Tivoli Management Framework is installed on every client and
server. However, the TMR server is the only server that holds the full object
database.

Tivoli Management Region (TMR)
In a Tivoli environment, a Tivoli server and the set of clients that it serves. An
organization can have more than one TMR. A TMR addresses the physical
connectivity of resources whereas a policy region addresses the logical organization
of resources.

Tree view
The view on the left side of the Job Scheduling Console that displays the TWS or
OPC server, groups of default lists, and groups of user created lists.

U

User
For Windows NT only, the user name specified in a job definition’s “Logon” field
must have a matching user definition. The definitions furnish the user passwords
required by Tivoli Workload Scheduler to launch jobs.

Utility commands
A set of command-line executables for managing Tivoli Workload Scheduler.

W

Weekly Run Cycle
A run cycle that specifies the days of the week that a job stream is executed. For
example, a job stream can be specified to execute every Monday, Wednesday, and
Friday using a weekly run cycle. A weekly run cycle is defined for a specific job
stream and cannot be used by multiple job streams. For more information see Run
Cycle.

Wildcards
The wildcards for Tivoli Workload Scheduler are: ? Replaces one alpha character. %
Replaces one numeric character. * Replaces zero or more alphanumeric characters.
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Wildcards are generally used to refine a search for one or more objects in the
database. For example, if you want to display all workstations, you can enter the
asterisk (*) wildcard. To get a listing of workstations site1 through site8, you can
enter site%.

Workstation
Usually an individual computer on which jobs and job streams are executed. They
are defined in the Tivoli Workload Scheduler database as a unique object. A
workstation definition is required for every computer that executes jobs or job
streams in the Workload Scheduler network.

Workstation class
A group of workstations. Any number of workstations can be placed in a class. Job
streams and jobs can be assigned to execute on a workstation class. This makes
replication of a job or job stream across many workstations easy.

X

X-agent
See “Extended agent”.
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job instance 261, 263
job stream instance 313

character restrictions, double bit 20
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commands 9
compiler command 10
confirming a job instance 286
console, usage notes 19
console command 49
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expanded or non expanded 20
expanded version 36
external dependencies

adding to a job stream 157
deleting 159

410 Version 7.0



external job
adding to a job stream 158, 172

external job stream
adding to a job stream 157, 171

F
fault tolerant agent (FTA) 3
fence 4
file dependency

adding to a job 165
adding to a job stream 154
overview 5
status 328

finding objects in the database 125
finding objects in the plan 254
follows dependency 5, 173
full status 195

G
getting the stdlist 287
global options

file example 38
file template 38
for MPE agents 40
overview 7
setting 33
syntax 33

global refresh rate 19
globalopts file

auditing feature 25
time zone feature 24

graph view, job stream editor 142

H
history option 36
holding a job instance 281
holding a job stream instance 310
holidays calendar 230
host 197

I
ignore 196
internetwork dependency

adding to a job 169
adding to a job stream 158

is interactive 129

J
jm job table size option 43
jm look option 43
jm nice option 43
jm no root option 43
jm read option 43
job confirmation 5
job definition

adding to a job stream 159
creating 127
database list 136
deleting 141
login field 130
modify 141
properties 160
view details 138
view properties 138

job fence
overview 4

job fence, changing 322
job instance

adding predecessors 279
cancelling 282
commands 255
confirm 286
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job instance (continued)
deleting predecessors 280
displaying successors 280
hold command 255
holding 281
job output (STDLIST) 287
killing 285
modifying 261
predecessors 278
release all dependencies 286
release command 255
releasing 282
rerun 283
submitting into the plan 337

job instance properties
files 270
prompts 273
resources 276
time restrictions 267

job limit
overview 4

job limit, changing for a workstation 321
job properties

files 165
general 161
prompts 167
resource 165
time restrictions 162

job recovery 6
job scheduling console

database 2
features 16
overview 17
plan 2
usage notes 19

job status 375
job status, TWS internal 376
job status mapping 380
job stream 2

adding run cycles 175
creating 148
database list 114, 187
deleting 191
external dependency 157
modifying 188
properties 148, 188

job stream 2 (continued)
saving 186
submit into plan 335

job stream editor
buttons 143
graph view 142
run cycle view 146
timeline view 144
using 142

job stream instance
cancelling 311
commands 288
hold 288
holding 310
job limit 312
list view 292
modifying 294
plan list 289
priority 313
release 288
release all dependencies 288, 315
releasing 311
resubmit 288
resubmitting 316
timeline view 290

job stream instance properties
files 299
general 295
predecessors 307
prompt 302
resource 304
time restrictions 297

job stream properties
files 154
general 149
prompts 155
resources 153
time restrictions 151

job stream status 378
job stream status, TWS internal 378
job stream status mapping 380
jobinfo command 11
jobman process 12
jobmon process 12
jobstdl command 11
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killing a job instance 285

L
limit 4
linking a workstation 324
linking workstations, domain 326
list

deleting database 124
detaching 125
modifying database 124

list view
job instance 259
job stream instance 292

listing domains in the plan 239
listing file dependencies in the plan 251
listing job instances in the plan 244, 256
listing job streams in the database 187
listing job streams in the plan 240
listing jobs in the database 116
listing parameters in the database 120, 223
listing prompts in the database 119, 218
listing prompts in the plan 249
listing resources in the database 117, 213
listing resources in the plan 248
listing users in the database 121
listing workstation classes in the database 112,

205
listing workstations in the database 110
listing workstations in the plan 238, 317
local options

file example 46
file template 46
overview 7
setting 41
syntax 41

logman command 10

M
maestro command 11
mailman process 12
makecal command 11
makesec 51
managing security 51
merge stdlists option 44
message level 49
method 197
mm read option 44
mm response option 44
mm retry link option 44
mm sound off option 44
mm unlink option 44
modifying a domain 210
modifying a job definition 141
modifying a job instance 261
modifying a job stream 188
modifying a list 124
modifying a parameter 224
modifying a prompt 220
modifying a resource 215
modifying a run cycle 180
modifying a user 229
modifying a workstation 200
modifying a workstation class 206
modifying file dependencies

job instance 270
job stream instance 299

modifying prompt dependencies
job instance 273
job stream instance 302

modifying resource dependencies
job instance 276
job stream instance 304

modifying time restrictions
job instance 267
job stream instance 297

morestdl 11
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netman local options 47
netman process 12
networking 8
new features 15
nm ipvalidate option 44
nm mortal 45
nm port option 45
nm read option 45
nm retry option 45

O
order of columns 19
order of objects, security file 64
order of users, security file 64
output list file 287

P
parameter

creating 222
database list 120, 223
deleting 225
modifying 224
overview 6
properties 224

plan 2
plan audit level 37
plan list 18

deleting 253
detaching 253
modifying 252

plan lists 237
plan management 8
priority 4
process messages 48
process prompts 48
production processes 12
prompt

creating 217

prompt (continued)
deleting 220
dependency 5
job stream dependency 155
listing 119, 218
modifying 220
properties 219
replying 331
status 330

R
rebuild command 11
recovery options

job 131
refreshing the connectors 25
release all dependencies

job instance 286
job stream instance 315

releasing a job instance 282
releasing a job stream instance 311
repeat range 164, 185
replicating jobs 7
replying to a prompt 331
report commands 10
reports 10
requires confirmation 162
rerunning a job instance 283
resolve dependencies 196
resource

adding to a job 165
changing units 334
creating 212
database list 117, 213
deleting 215
dependency 5
job stream dependency 153
modifying 215
overview 6
properties 214
status 332
viewing plan properties 333

resubmit a job stream instance 316

414 Version 7.0



run cycle
adding to a job stream 175
calendar 179
deleting 181
modifying 180
simple 176
weekly 178

run cycle view, job stream editor 146

S
sample log entries, auditing 31
sample security file 66
saving a job stream 186
schedulr command 10
security

creating the security file 51
dumpsec 51
file syntax 52
makesec 51
managing 51
order of objects 64
order of user definitions 64
overview 7, 51
sample file 66
template file 51
UNIX superuser 65
user definitions 52
variables 64

server ID 196
setting priority

job instance 261
job stream instance 288

setting the global options 33
setting the local options 41
simple run cycle 176
specifying job properties 160
specifying job stream properties 148
stageman command 10
standard agent (SA) 4
start of day 37
start time 37
starting a workstation 323
starting workstations, domain 325

status
workstation 320

status, descriptions 375
status, mapping 375
stdlist 255, 287
stdlist width option 45
stopping a workstation 324
stopping workstations, domain 326
submitting a job into the plan 337
submitting a job stream into the plan 335
submitting an adhoc job into the plan 354
switch manager command 327
switching domain managers 327
syntax, security file 52
syslog 48
syslog local option 45

T
tcp port 193
template file, security 51
terminology, changes 15
thiscpu option 45
time restrictions 4

job 184
job stream 182

time zone 194
enable option 37

timeline view
adjusting 144
black bar 144
dark blue lines 144
job instance 257
job stream instance 290
light blue bar 144

TWS
features 1
job scheduling console 16
overview 1
user interfaces 9
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UNIX superuser, security 65
unlinking a workstation 324
unlinking workstations, domain 326
usage notes 19
user

creating 225
deleting 229
listing 121, 227
modifying 229
name 226

user definitions, security 51
user interfaces 9
using database lists 109
using plan lists 237
utility commands 11

V
variables, security file 64
viewing auditing level 20
viewing batchman status 20
viewing calendars in the database 123, 233
viewing connector version 20
viewing database mode 20
viewing domain status 325
viewing domains in the database 113, 209
viewing job stream properties 188
viewing job streams in the database 114, 187
viewing objects in the database 109
viewing parameter properties 224
viewing parameters in the database 120
viewing prompt properties 219
viewing prompt status 330
viewing prompts in the database 119
viewing resource properties 214
viewing resource properties in the plan 333
viewing resource status 332
viewing resources in the database 117
viewing the properties of a domain 210
viewing the properties of a workstation

class 206
viewing the status of a workstation 320

viewing time zone, enabled or disabled 20
viewing TWS properties 20
viewing users in the database 121, 227
viewing workstation classes in the database 112
viewing workstation properties 200
viewing workstations in the database 110

W
weekly run cycle 178
wmaeutil 18
wmaeutil command 10, 25, 91
workstation

creating 192, 202
deleting 201
linking 324
listing 110, 198
modifying 200
overview 3
properties 200, 320
starting 323
stopping 324
types of 3
unlinking 324

workstation class 7
creating 203
database list 112
deleting 207
listing 205
modifying 206
properties 206

workstation type 194
wr read option 46
wr unlink option 46
writer process 12, 13
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